Copyright and Trademark Information

This document, like the software described therein, is provided as a license and may only be used or reproduced in accordance with the licensing agreement. The contents of this document, as well as the associated software, is subject to change without prior notice. Nero AG rejects any responsibility for the correctness of the contents of this document and rejects any claims that transcend the clauses of the guarantee agreement.

This document and all of its contents are protected by copyright and are the property of Nero AG. All rights reserved. In addition, this document contains material that is protected by internationally valid copyright. This document may not be reproduced, transmitted, or transcribed in whole or in part without the express written permission of Nero AG.

Please keep in mind that existing graphics, pictures, videos, music titles or other materials that you may wish to insert or transcribe into projects may be protected by copyright. The unauthorized use of this type of material in your projects may violate the rights of the owner of the copyright. Make sure that you obtain all necessary authorizations from the owner of the copyright.

Unless you own the copyright, have permission from the copyright owner or your actions fall under the "fair use" provisions of copyright law, you may be violating national or international copyright laws. The transcribing, duplication, modification or publication of copyright-protected material may lead to claims for damages and the enforcement of other legal measures against you. If you are unsure of your rights, you should contact your legal advisor.

Some Nero Multimedia Suite applications require technologies developed by third-party manufacturers and may be included in Nero Multimedia Suite as demo versions. These applications can be activated online free of charge or by sending an activation fax to have unlimited use of the version. Nero will only transmit the data necessary for activation of the technology licensed from third parties. For unlimited use of Nero Multimedia Suite, it is therefore necessary to have an Internet connection or a fax machine.

Copyright © 2010 Nero AG and its licensors. All rights reserved.

Nero, Nero BackItUp, Nero BackItUp & Burn, Nero Burning ROM, Nero Digital, Nero DMA Manager, Nero Essentials, Nero Express, Nero ImageDrive, Nero LiquidTV, Nero MediaHome, Nero MediaHub, Nero MoveIt, Nero Music2Go, Nero PhotoDesigner, Nero PhotoSnap, Nero Recode, Nero RescueAgent, Nero Simply Enjoy, Nero SmartDetect, Nero SmoothPlay, Nero StartSmart, Nero Surround, Nero Vision, Nero Vision Xtra, Burn-At-Once, InCD, LayerMagic, Liquid Media, the SecurDisc logo, and UltraBuffer are common law trademarks or registered trademarks of Nero AG.

Adobe, Acrobat, Acrobat Reader and Premiere are trademarks or registered trademarks of Adobe Systems, Incorporated. AMD Athlon, AMD Opteron, AMD Sempron, AMD Turion, ATI Catalyst and ATI Radeon are trademarks or registered trademarks of Advanced Micro Devices, Inc. ATSC is a trademark of the Advanced Television Committee. ICQ is a registered trademark of AOL, LLC. Apple, Apple TV, iTunes, iTunes Store, iPod, iPod touch, iPhone, iPhoto, FireWire, and Mac are trademarks or registered trademarks of Apple, Inc. ARM is a registered trademark of ARM Ltd. AudibleReady is a registered trademark of Audible, Inc. BenQ is a trademark of the BenQ Corporation. Blu-ray Disc is a trademark of Blu-ray Disc Association. CyberLink is a registered trademark of CyberLink Corp. DLNA is a registered trademark of Digital Living Network Alliance. DivX and DivX Certified are registered trademarks of DivX, Inc. Dolby, Pro Logic and the double-D symbol are trademarks or registered trademarks of Dolby Laboratories, Inc. DTS and DTS Digital Surround are registered trademarks of DTS, Inc. DVB is a registered trademark of the DVB Project. Freescale is a trademark of Freescale Semiconductor, Inc. Google and YouTube are trademarks of Google, Inc. WinTV is a registered trademark of Hauppauge Computer Works, Inc. Intel, Intel XScale, Pentium and Core are trademarks or registered trademarks of Intel Corporation. Linux is a registered trademark of Linus Torvalds. Memorex is a registered trademark of Memorex Products, Inc. ActiveX, ActiveSync, DirectX, DirectShow, Internet Explorer, Microsoft, HDI, MSN, Outlook, Windows, Windows Mobile, Windows NT, Windows Server, Windows Vista, Windows Media, Xbox, Xbox 360, Silverlight and the Silverlight logo, the Windows Vista start button and the Windows logo are trademarks or registered trademarks of Microsoft Corporation. MySpace is a trademark of MySpace, Inc. NVIDIA, GeForce and ForceWare are trademarks or registered trademarks of NVIDIA Corporation. Nokia is a registered trademark of Nokia Corporation. CompactFlash is a registered trademark of SanDisk Corporation. Sony, Memory Stick, PlayStation, PLAYSTATION and PSP are trademarks or registered trademarks of Sony Corporation. HDV is a trademark of Sony Corporation and Victor Company of Japan, Limited (JVC). UPnP is a registered trademark of the UPnP Implementers Corporation. Labelflash is a registered trademark of Yamaha Corporation.

The trademarks mentioned here are named for information purposes only. All trade names and trademarks are the property of their respective owners.

Nero AG, Im Stoeckmaedle 18, D-76307 Karlsbad, Germany
<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Start Successfully</td>
<td>6</td>
</tr>
<tr>
<td>1.1</td>
<td>About the Manual</td>
<td>6</td>
</tr>
<tr>
<td>1.2</td>
<td>About This Application</td>
<td>6</td>
</tr>
<tr>
<td>1.3</td>
<td>Versions of Nero Vision</td>
<td>7</td>
</tr>
<tr>
<td>1.4</td>
<td>Starting the Program</td>
<td>7</td>
</tr>
<tr>
<td>2</td>
<td>Project Creation and Management</td>
<td>9</td>
</tr>
<tr>
<td>2.1</td>
<td>Working with Nero Vision</td>
<td>9</td>
</tr>
<tr>
<td>2.2</td>
<td>Extended Area</td>
<td>12</td>
</tr>
<tr>
<td>2.2.1</td>
<td>Buttons</td>
<td>13</td>
</tr>
<tr>
<td>2.2.2</td>
<td>Creating Covers and Labels</td>
<td>14</td>
</tr>
<tr>
<td>2.3</td>
<td>Content Screen</td>
<td>14</td>
</tr>
<tr>
<td>2.4</td>
<td>Creating and Editing a Disc Project</td>
<td>17</td>
</tr>
<tr>
<td>2.4.1</td>
<td>Creating Chapters Manually</td>
<td>20</td>
</tr>
<tr>
<td>2.4.2</td>
<td>Creating Chapters Automatically</td>
<td>20</td>
</tr>
<tr>
<td>2.4.3</td>
<td>Editing Chapters</td>
<td>21</td>
</tr>
<tr>
<td>2.5</td>
<td>Saving a Project</td>
<td>22</td>
</tr>
<tr>
<td>2.6</td>
<td>Opening a Project</td>
<td>22</td>
</tr>
<tr>
<td>2.7</td>
<td>Opening a Disc Image</td>
<td>22</td>
</tr>
<tr>
<td>3</td>
<td>Capturing Videos from Cameras and Other External Capture Devices</td>
<td>23</td>
</tr>
<tr>
<td>3.1</td>
<td>Capturing</td>
<td>23</td>
</tr>
<tr>
<td>3.2</td>
<td>DV/HDV Cameras, Digital and Analog Videos</td>
<td>23</td>
</tr>
<tr>
<td>3.3</td>
<td>Capture Video Screen</td>
<td>24</td>
</tr>
<tr>
<td>3.3.1</td>
<td>Preview Scan Window</td>
<td>26</td>
</tr>
<tr>
<td>3.3.2</td>
<td>Video Device Properties Window</td>
<td>27</td>
</tr>
<tr>
<td>3.3.3</td>
<td>Audio Device Properties Window</td>
<td>27</td>
</tr>
<tr>
<td>3.4</td>
<td>Setting a TV Card</td>
<td>27</td>
</tr>
<tr>
<td>3.5</td>
<td>Capturing Video to Hard Drive</td>
<td>30</td>
</tr>
<tr>
<td>3.5.1</td>
<td>Pre-Scanning Video Captures</td>
<td>32</td>
</tr>
<tr>
<td>3.6</td>
<td>Capturing to Disc On-the-Fly</td>
<td>33</td>
</tr>
<tr>
<td>3.7</td>
<td>Importing from the Web</td>
<td>34</td>
</tr>
<tr>
<td>4</td>
<td>Editing Videos</td>
<td>37</td>
</tr>
<tr>
<td>4.1</td>
<td>Video Editing Screen</td>
<td>37</td>
</tr>
<tr>
<td>4.1.1</td>
<td>Preview Area</td>
<td>39</td>
</tr>
<tr>
<td>4.1.2</td>
<td>Media Area</td>
<td>40</td>
</tr>
<tr>
<td>4.1.3</td>
<td>Effect Palette</td>
<td>41</td>
</tr>
<tr>
<td>4.1.4</td>
<td>Properties Palette</td>
<td>41</td>
</tr>
<tr>
<td>4.1.5</td>
<td>General Handling on Timeline Tab</td>
<td>44</td>
</tr>
<tr>
<td>4.1.6</td>
<td>Track Handling in Timeline</td>
<td>48</td>
</tr>
<tr>
<td>4.1.7</td>
<td>Clip Handling in Timeline</td>
<td>49</td>
</tr>
<tr>
<td>4.1.8</td>
<td>Storyboard Tab</td>
<td>51</td>
</tr>
<tr>
<td>Section</td>
<td>Description</td>
<td>Page</td>
</tr>
<tr>
<td>---------</td>
<td>--------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>4.1.9</td>
<td>Nero Picture in Picture (PiP) Effects</td>
<td>52</td>
</tr>
<tr>
<td>4.1.10</td>
<td>Movie Wizard</td>
<td>55</td>
</tr>
<tr>
<td>4.1.11</td>
<td>Ad Spotter Window</td>
<td>57</td>
</tr>
<tr>
<td>4.1.12</td>
<td>Music Grabber Window</td>
<td>59</td>
</tr>
<tr>
<td>4.1.13</td>
<td>Movie Options Window</td>
<td>61</td>
</tr>
<tr>
<td>4.1.14</td>
<td>Preview and Trim Window</td>
<td>62</td>
</tr>
<tr>
<td>4.2</td>
<td>Making Movie</td>
<td>64</td>
</tr>
<tr>
<td>4.2.1</td>
<td>Detecting Commercials</td>
<td>66</td>
</tr>
<tr>
<td>4.2.2</td>
<td>Searching for Music Clips</td>
<td>67</td>
</tr>
<tr>
<td>4.2.3</td>
<td>Detecting Video Scenes</td>
<td>67</td>
</tr>
<tr>
<td>4.2.4</td>
<td>Moving and Positioning Files</td>
<td>68</td>
</tr>
<tr>
<td>4.2.5</td>
<td>Cutting and Trimming Audio and Video Clips</td>
<td>69</td>
</tr>
<tr>
<td>4.2.6</td>
<td>Fitting the Display Duration of Pictures</td>
<td>70</td>
</tr>
<tr>
<td>4.2.7</td>
<td>Inserting Nero Picture in Picture Templates</td>
<td>71</td>
</tr>
<tr>
<td>4.2.8</td>
<td>Choosing a Movie Template</td>
<td>72</td>
</tr>
<tr>
<td>4.2.9</td>
<td>Inserting Transitions</td>
<td>73</td>
</tr>
<tr>
<td>4.2.10</td>
<td>Editing Transitions</td>
<td>74</td>
</tr>
<tr>
<td>4.2.11</td>
<td>Adding an Effect</td>
<td>75</td>
</tr>
<tr>
<td>4.2.12</td>
<td>Editing Effects</td>
<td>76</td>
</tr>
<tr>
<td>4.2.13</td>
<td>Adding a Text Effect</td>
<td>77</td>
</tr>
<tr>
<td>4.2.14</td>
<td>Recording a Narration File</td>
<td>78</td>
</tr>
<tr>
<td>4.2.15</td>
<td>Creating Chapters in Timeline</td>
<td>78</td>
</tr>
<tr>
<td>4.1.10</td>
<td>Export Video Screen</td>
<td>80</td>
</tr>
<tr>
<td>5</td>
<td>Exporting Videos</td>
<td>80</td>
</tr>
<tr>
<td>5.1</td>
<td>Export Video Screen</td>
<td>80</td>
</tr>
<tr>
<td>5.2</td>
<td>Exporting Video to File</td>
<td>82</td>
</tr>
<tr>
<td>5.3</td>
<td>Exporting Video to Camera</td>
<td>83</td>
</tr>
<tr>
<td>5.4</td>
<td>Exporting Video and Send as E-Mail</td>
<td>84</td>
</tr>
<tr>
<td>5.5</td>
<td>Exporting Audio to File</td>
<td>85</td>
</tr>
<tr>
<td>5.6</td>
<td>Exporting to Web</td>
<td>86</td>
</tr>
<tr>
<td>6</td>
<td>Menu</td>
<td>88</td>
</tr>
<tr>
<td>6.1</td>
<td>Levels</td>
<td>88</td>
</tr>
<tr>
<td>6.2</td>
<td>Edit Menu Screen</td>
<td>88</td>
</tr>
<tr>
<td>6.2.1</td>
<td>Templates Tab</td>
<td>90</td>
</tr>
<tr>
<td>6.2.2</td>
<td>Customize Tab</td>
<td>91</td>
</tr>
<tr>
<td>6.2.3</td>
<td>Save Template as Window</td>
<td>107</td>
</tr>
<tr>
<td>6.3</td>
<td>Creating Menu</td>
<td>107</td>
</tr>
<tr>
<td>7</td>
<td>Preview</td>
<td>109</td>
</tr>
<tr>
<td>7.1</td>
<td>Preview Screen</td>
<td>109</td>
</tr>
<tr>
<td>7.2</td>
<td>Showing a Preview</td>
<td>110</td>
</tr>
<tr>
<td>8</td>
<td>Burn Options</td>
<td>111</td>
</tr>
<tr>
<td>8.1</td>
<td>Burn Options Screen</td>
<td>111</td>
</tr>
<tr>
<td>8.2</td>
<td>Burning a Disc</td>
<td>114</td>
</tr>
<tr>
<td>8.3</td>
<td>Burning an Image File</td>
<td>115</td>
</tr>
<tr>
<td>8.4</td>
<td>Writing to Hard Drive Folders</td>
<td>116</td>
</tr>
</tbody>
</table>
1 Start Successfully

1.1 About the Manual

This manual is intended for all users who want to learn how to use Nero Vision. It is process-based and explains how to achieve a specific objective on a step-by-step basis.

To make best use of this documentation, please note the following conventions:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="icon.png" alt="Warning" /></td>
<td>Indicates warnings, preconditions or instructions that have to be precisely followed.</td>
</tr>
<tr>
<td><img src="icon.png" alt="Information" /></td>
<td>Indicates additional information or advice.</td>
</tr>
<tr>
<td><img src="icon.png" alt="Start" /></td>
<td>The number at the beginning of a line indicates a prompt for action. Carry out these actions in the order specified.</td>
</tr>
<tr>
<td><img src="icon.png" alt="Result" /></td>
<td>Indicates an intermediate result.</td>
</tr>
<tr>
<td><img src="icon.png" alt="Result" /></td>
<td>Indicates a result.</td>
</tr>
<tr>
<td><img src="icon.png" alt="OK" /></td>
<td>Indicates text passages or buttons that appear in the program interface. They are shown in boldface.</td>
</tr>
<tr>
<td><img src="icon.png" alt="References" /></td>
<td>Indicates references to other chapters. They are executed as links and are shown in red and underlined.</td>
</tr>
<tr>
<td><img src="icon.png" alt="Keyboard Shortcuts" /></td>
<td>Indicates keyboard shortcuts for entering commands.</td>
</tr>
</tbody>
</table>

1.2 About This Application

Nero Vision is a program for capturing, editing, and burning films or slide shows with an extremely user-friendly interface. Nero Vision can be used to play your videos from DV video cameras or other external video devices on your PC and to burn them as DVD-Video, DVD-VFR (video mode)/+VR, Video CD (VCD), Super Video CD (SVCD), miniDVD, AVCHD or BD-AV or to save them to a hard drive folder. With the many features offered in this powerful multimedia software, you will have numerous options for creating and collecting your memories.

Nero Vision opens a complete new creative dimension for compositing and for individual correction methods. It allows you to shorten videos quickly and easily, add effects to videos, produce chapters with the help of automatic scene detection, manually define chapter marks, produce your own menus from pre-defined menu templates with animated buttons, add background pictures and text, use the preview screen over the handy virtual remote control to view your project, and much more.

Using your DV video camera, a FireWire card, and the appropriate hardware, you can import your own videos from your camera. If you have a DirectShow compatible video capture card you can use Nero Vision to capture videos directly from the video capture card. If you do not have the required video hardware, you can edit video files from your PC or download them from the Internet.
1.3 Versions of Nero Vision

Nero Vision is available in a Nero Vision full version and different Nero Vision Essentials versions.

The Nero Vision full version is included in Nero Vision Xtra, in Nero Video Premium HD, in the Nero Multimedia Suite, and in the Nero Multimedia Suite Platinum HD.

The Nero Creative CollectionPack 1 is additionally part of Nero Video Premium HD and the Nero Multimedia Suite Platinum HD. It includes the following add-ons:

- The **Nero PiP EffectPack 1** which allows you to easily create multiple overlays with a set of 50 professional Picture in Picture (PiP) layouts for simplified multi-track editing.
- The **Nero Video TransitionPack 1** including 50 professional gradient mask effects for extravagant and smooth transitions.
- The **Nero Movie ThemePack 3** including 10 high quality movie themes (Seasonal, Romantic, Kids, Home Cinema).
- The **Nero Movie ThemePack 4** including 16 soccer movie themes.

Essentials or OEM software may differ from the full version in a more or less broad functional range. Thereby, the feature limitations of your single essentials version compared to the full range depends on the co-contractor’s choice.

The following features are not available in Nero Vision Essentials:

- The number of supported transitions, video filters, text and audio effects is limited.
- Key frame handling is limited.
- The number of movie theme templates is limited.
- The number of menu templates is limited.
- Editing menu in **Advanced Editing** is not available.
- The number of supported video and audio codecs is limited.

1.4 Starting the Program

To start Nero Vision, proceed as follows:

1. If you use Nero Multimedia Suite Platinum HD or Nero Multimedia Suite and have Nero StartSmart available:
   1. Click the Nero StartSmart desktop icon.
      → The Nero StartSmart window is opened.
   2. Click the button.
      → The list of Nero applications is displayed.
   3. Select the Nero Vision entry in the selection list.
      → The Nero Vision window is opened.
2. If you use Nero Vision Xtra or Nero Video Premium HD:
   1. Click the Nero Vision desktop icon.
      ➔ The Nero Vision window is opened.
      ➔ You have started Nero Vision.
2 Project Creation and Management

2.1 Working with Nero Vision

The user interface for Nero Vision consists of a main window and an expandable area. Basically, working with Nero Vision consists of the selection of a task from the Start screen. You then complete the task by navigating through the different steps that are displayed in a separate screen for each individual step.

If you have installed a DVD-RW/+RW burner and insert a DVD-RW or DVD+RW disc, you can use Nero Vision to create editable DVD disc formats and DVD-Video: DVD-VFR (video mode) and DVD+VR.

In comparison to DVD-Video, the advantage of these disc formats is that the content can be changed later on. This means that you can edit the movies, insert new passages, delete scenes that you do not want to see, or overwrite the disc. However, a disadvantage is that you cannot create individual menus. The DVD-VFR (video mode) and DVD+VR disc formats are compatible with DVD-Video and can be played on nearly any commercial DVD player.

Clicking the Help button in the lower left corner of the main window opens a drop-down menu that offers the option of accessing online help as well as viewing the versions number and other registration data.

To go to the next or previous screen, click the Next or Back button in the navigation bar. If necessary, you will be prompted to save the project, as the changes you have made will otherwise be lost.

A project consists essentially of four steps:

- Selecting a task.

Select what you would like to do by moving the cursor over the menu item. As you move your cursor over an item, an explanatory text will appear next to it.
This manual contains a chapter for each task that describes all of the steps required for its completion.

- Completing a task

Depending on the task, you will have to go through various steps until you reach the end. Each individual step consists of a new screen. To help you to know where you are and what you need to do, each screen comes with a name and a brief description. In addition, each screen furthermore contains tooltips, detailed information, and explanations for the various buttons, icons, and menus.

Both **Undo** and **Redo** buttons are available on screens in which you can perform different actions. These buttons allow you to quickly undo or redo the last performed action. In this way, you can try out a number of features in Nero Vision risk free without having to discard the entire project if you do not like the change.
For each screen, the manual contains a chapter in which all areas are described in detail.

- **Burning**

  Burning marks the end of a project. For this you should define the burning parameters and click the **Burn** button. Depending on the type of project you are working on and the burner connected to the system, a number of different entries are available for selection.
After burning

Once you have finished burning you can decide what you would like to do next: launch the media player and view your project or create covers and labels for the disc using Nero CoverDesigner. Of course, you can also save the project or start a new one.

See also
- Extended Area → 12
- Content Screen → 14
- Creating and Editing a Disc Project → 17
- Saving a Project → 22
- Burn Options Screen → 111
- Creating Covers and Labels → 14

2.2 Extended Area

The user interface for Nero Vision consists of a main window and an expandable area. Clicking the More button displays an extended area.

The user interface for Nero Vision displays the options required at the time, depending on the screen you are in. This makes the interface easy to use.
The extended area is closed again in normal mode when you switch to the next screen. In so-called "sticky mode," the extended area will be displayed until it is closed once more by clicking the More button again. The icon in the extended dialog box displays its current mode. Click this icon to change the mode.

- The extended area is in normal mode.
- The extended area is in sticky mode.

See also

- Buttons → 13

### 2.2.1 Buttons

The following buttons are available in the extended area:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure</td>
<td>Opens the configuration of Nero Vision.</td>
</tr>
<tr>
<td>Recording Format Options</td>
<td>Edits the default options when creating a video. The Recording Format Options window is opened. As long as no disc format has been selected the video options for all supported formats are shown. After selecting a disc format, only the tab for the current disc format is displayed.</td>
</tr>
<tr>
<td>Erase Disc</td>
<td>Erases rewritable discs. The Erase Rewritable Disc window is opened; the erasing method is adjustable. Before a disc can be erased, the burner must contain a rewritable disc.</td>
</tr>
<tr>
<td>Disc Info</td>
<td>Shows information about the inserted disc (e.g. type of disc, available storage capacity, number of sessions, and tracks). The Disc Info window is opened. Insert the disc that you want to know more about and select the drive in which it is located.</td>
</tr>
<tr>
<td>Finalize Disc</td>
<td>Finalizes the DVD-VFR (video mode) or DVD+VR disc. The Disc Finalization window is opened.</td>
</tr>
<tr>
<td>Make Covers and Labels</td>
<td>Starts Nero CoverDesigner. Nero CoverDesigner is an application in the Nero Multimedia Suite and is automatically installed during the main installation procedure. Nero CoverDesigner is used to create and print labels and booklets for burned discs. Please see the separate Nero CoverDesigner user manual for full instructions on how to make professional-looking covers and labels.</td>
</tr>
</tbody>
</table>

See also

- Extended Area → 12
- Application Settings Window → 118
- Recording Format Options Window → 120
2.2.2 Creating Covers and Labels

With Nero you can create covers and a label for your disc project.

Nero CoverDesigner is an application in the Nero Multimedia Suite and is automatically installed during the main installation procedure. Nero CoverDesigner is used to create and print labels and booklets for burned CDs, DVDs and Blu-ray Discs. Please see the separate Nero CoverDesigner user manual for full instructions on how to make professional looking covers and labels.

To start Nero CoverDesigner via Nero Vision, proceed as follows:

1. Click the More button.
   → The extended area is displayed.

2. Click the Make covers and labels button.
   → Nero CoverDesigner is opened.

2.3 Content Screen

In the Content screen you can create a project according to your requirements and arrange titles of a compilation.

A "project" refers to the process that begins when the video is first opened and ends when the movie is finished or exported. A project can be saved in a project file that will include all the performed changes. It can be reopened at a later time. The project file has the extension *.nvc (Nero Vision Compilation).

You can play back every title in the preview area in the upper left. The added titles are listed in the content area right next to the preview area. Each video title is shown with a thumbnail and information on the file name, length of the video, and number of chapters. In addition all existing chapters can be displayed or rendered invisible as desired with the aid of the buttons. The beginning of each chapter is indicated by the chapter mark on the scroll bar in the preview area; an exception to this is the first chapter because its beginning is also the beginning of the video title.

Chapters are sections in a video title that you can access on your player using the Back and Next buttons without having to fast forward or rewind. Initially, each video title contains only one chapter. You can add new chapters manually or automatically.

The advantage that chapters have is that they allow the user to jump directly to individual chapters within a video without having to fast forward or rewind.
If you have selected the **Create chapters automatically** check box in the extended area, chapter marks are automatically created during the burn process for quicker navigation with the remote control. However, these chapter entries do not have menu entries.

You can change the disc type next to the capacity bar of the overall memory used in the lower area of the screen. The indication of available space is adjusted accordingly. The total available space depends on which project you are editing. If the disc you are using is a DVD-1 or DVD-9 (with 7.95 GB capacity) instead of a DVD with 4.38 GB storage capacity, select the correct disc type in the drop-down menu. If the disc you are using is a CD, select either the 74 or 80 minutes capacity in the menu.

A large variety of titles can be created depending on the type of disc (VCD/SVCD - up to 98 titles; DVD-Video/miniDVD, DVD-VFR - up to 99 titles). No titles are created in DVD+VR projects.

With the aid of the buttons in the right-hand area of the screen it is possible to insert and arrange titles into your project. The following selection entries are available in the **Import** selection list:

<table>
<thead>
<tr>
<th>Import Files</th>
<th>Adds video files that are saved on the hard drive (e.g. your vacation video) to the project. A window is opened.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import Disc</td>
<td>Imports items from an existing disc.</td>
</tr>
</tbody>
</table>
### Project Creation and Management

<table>
<thead>
<tr>
<th><strong>Capture</strong></th>
<th>Captures a video. The <strong>Capture Video</strong> screen is displayed.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Import AVCHD From Disc</strong></td>
<td>Imports videos that are saved in an AVCHD project (on DVD).</td>
</tr>
<tr>
<td><strong>Import AVCHD From Hard Drive</strong></td>
<td>Imports videos that are saved in an AVCHD project (on memory card or hard drive).</td>
</tr>
<tr>
<td><strong>Import From Web</strong></td>
<td>Imports files from Internet communities and adds them to the project as new titles.</td>
</tr>
<tr>
<td><strong>Import PowerPoint® Files</strong></td>
<td>Imports PowerPoint files and adds them to the project as new titles. A window is opened in which you can specify the duration of the single slides.</td>
</tr>
</tbody>
</table>

In addition, the following buttons are available:

| **Make** | Creates a movie or a slide show. The **Video Editing** screen is displayed. |
| **Edit** | Opens the **Movie Options** window that shows recording format information. Afterwards, the **Video Editing** screen is displayed. Editing a video can include, for example, creating transitions, cutting scenes or creating a sound track. |
| **Delete** | Deletes selected media titles. |
| **Move Up** | Moves selected media titles up. |
| **Move Down** | Moves selected media titles down. |
| **Join** | Combines several video titles to form a single title. |

In the preview area you can use the position marker on the scroll bar to move to a certain position within the video title. You can also use the **Position** buttons next to the time code display. Furthermore, the following setting options are available when a video has been marked in the content area:

<p>| <strong>Button</strong> | Starts playback. |
| <strong>Button</strong> | Stops playback. |
| <strong>Button</strong> | Jumps to the previous/next frame. |</p>
<table>
<thead>
<tr>
<th>Button</th>
<th>Jumps to the start/end of the file.</th>
</tr>
</thead>
</table>
| Drop-down menu | **Add chapter** - Inserts a chapter mark at the position of the position marker on the scroll bar.  
**Add chapter for each video** - Inserts a chapter mark with the title at the start of each video.  
**Auto-detect chapter** - Starts the automatic chapter recognition through which the program places a chapter mark automatically for each scene.  
**Remove chapter** - Deletes selected chapter marks.  
**Remove all chapters** - Deletes all previously created chapter marks of the title.  
Individual entries are only available when you have placed the position mark on the scroll bar. |
| Button | Cuts a video title at the position of the position marker. Both parts are listed in the content area.  
Only available when you have placed the position marker on the scroll bar. |
| Button | Shortens a video by removing the part between the start and the position marking or the position and end marking.  
Only available when you have placed the position marker on the scroll bar. |

Select the **Never use black thumbnails** check box in the extended area if you do not want the application to use black thumbnails in menus. Instead, the first non-black thumbnail is found and displayed.

**See also**
- Creating and Editing a Disc Project → 17
- Capture Video Screen → 24
- Video Editing Screen → 37

### 2.4 Creating and Editing a Disc Project

If your burner supports an editable disc format, the **Editable DVD** format is also displayed in the **Make DVD** option.


There may be differences when editing titles and movies due to the differences in the DVD-VFR (video mode) and DVD+VR specifications. However, the process is essentially identical to the process described in this chapter.
To create and edit a disc project, proceed as follows:

1. In the Start screen, select the Make DVD, Make Blu-ray Disc or Make CD selection entry and the required disc type (e.g. DVD-Video, Blu-ray Video or Video CD).
   → The Content screen is displayed.

2. To capture a video for your project:
   1. Click the Import > Capture button.
      → The Capture Video screen is displayed.
   2. Proceed as described in the Capture Video to Hard Drive chapter.

3. If you have already captured a video or want to add a video saved on the hard drive:
   1. Click the Import > Import Files button.
      → A window is opened.
   2. Select the files you want and click the Open button.
      → The video titles are added to the project.

4. If you want to add videos that are stored on a disc:
   1. Insert the disc in a drive on your computer.
   2. Click the Import > Import Disc button.
   3. If more than one drive has been installed, select the drive in which the disc is inserted from the drop-down menu.
      → The Import Title from Disc window is opened.
   4. Select the desired videos and click the OK button.
      → The video titles are added to the project.

5. If you want to add titles from an AVCHD folder located on the internal hard drive or memory card of your AVCHD camera:
   1. Click the Import > Import AVCHD From Hard Drive button.
      → The Import AVCHD from folder window is opened.
   2. Mark the required folder or titles and click OK.
      → The video titles are added to the project.

6. If you want to add titles from an AVCHD folder located on the DVD of your AVCHD camera:
   1. Click the Import > Import AVCHD from Disc button.
      → The Import AVCHD from folder window is opened.
   2. Mark the required folder or titles and click OK.
      → The video titles are added to the project.

AVCHD cameras compress captured files directly into MPEG-4 transport data that is written to a DVD, memory card or internal hard drive. Data that you want to transfer from your camera to the hard drive is imported and thus not transferred by means of capturing.

For AVCHD cameras that capture to DVD, insert the camera DVD in the DVD drive of your computer to import. For AVCHD cameras that capture to hard drive, connect the camera to your computer. Connect memory cards with the computer by using the appropriate slot.
7. If files are to be imported from an Internet community, proceed as described in the **Import from the Web** chapter.

8. If you want to make a movie or slide show:
   1. Click the **Make Movie or Slide Show** button.
      → The **Video Editing** screen is displayed.
   2. Proceed as described in the **Editing Videos** chapter and subchapters.

9. If you want to edit a media title:
   1. Highlight the title in the content area.
   2. Click the **Edit** button.
      → The **Video Editing** screen is displayed.
   3. Edit your movie or slide show as described in the **Editing Videos** chapter and subchapters.

10. If you have already added several titles to your project and want to move a media title, select the media title and click the **Move Up** or **Move Down** button.
    → The media title is moved to the required position.

11. If you want to add chapters to a video title in your compilation, proceed as described in the **Creating Chapters** chapters.

12. If you want to reposition or remove existing chapters of a video title, proceed as described in the **Editing Chapters** chapter.

13. If you want to cut a title:
    1. Move the slider on the scroll bar in the preview area to the position where you want to cut.
    2. Click the × button.
    3. The video title is cut and the new titles are listed as single new titles.

14. If you want to combine several video titles to form a single title:
    1. Highlight the video titles in the content area.
    2. Click the **Join** button.
      → A window is opened.
    3. Click the **Yes** button.
      → The selected video titles are combined to form a single new title.

15. If you want to remove a media title from the project, select the media title and click the **Delete** button.
    → The media title is removed from the project.
    → You have created and edited a disc project and can now arrange a menu for your project in the **Edit Menu** screen.

See also
- Content Screen → 14
- Creating Chapters Manually → 20
2.4.1 Creating Chapters Manually

You can manually add chapters to a video title of your compilation.
The following requirement has to be fulfilled:

► The Content screen is displayed.
To create a chapter manually, proceed as follows:

1. Highlight the required video title in the content area.
2. Move the slider on the scroll bar in the preview area to the position where the new chapter should begin.
3. Click the > Add chapter button.
   ➤ The chapter is created, a chapter mark is set on the scroll bar in the preview area and the chapter is added to the chapter list in the content area. In addition all existing chapters can be displayed or rendered invisible as desired with the aid of the buttons.
4. Repeat the last two steps to add more chapters.
   ➤ You have manually created new chapters.

See also
Creating and Editing a Disc Project → 17

2.4.2 Creating Chapters Automatically

Chapters can be automatically created for a video title in your compilation.
The following requirement has to be fulfilled:

► The Content screen is displayed.
To create chapters automatically, proceed as follows:

1. Highlight the required video title in the content area.
2. Click the > Auto-detect chapters button.
   ➤ The Chapter Detection window is opened. Automatic chapter recognition is performed. This may take some time. The window shows how many chapters were detected using these settings.
3. If you want to reduce or increase the minimum length of a chapter, move the Minimum chapter length slider accordingly.
4. If you want to look for chapter marks with high sensitivity, move the Sensitivity slider to the right.
   Move the Sensitivity slider to the left if you want to use less sensitivity when looking for chapter marks.
   ➤ The window shows how many chapters were detected with these settings.
5. If you want to keep existing chapters, select the **Keep previous chapter marks** check box.

6. Click the **Apply** button.
   - The chapters are created, chapter marks are set on the scroll bar in the preview area and the chapters are added to the chapter list. In addition all existing chapters can be displayed ▼ or rendered invisible ▲ with the aid of the buttons.
   - You have created chapters automatically.

**See also**

- Creating and Editing a Disc Project → 17

### 2.4.3 Editing Chapters

You can edit and rename chapters, reposition or remove individual chapter markings, as well as delete all existing chapter marks. You can move the position of the individual chapter marks within the start and end positions of the video title up to the next chapter mark.

The following requirement has to be fulfilled:

- The **Content** screen is displayed.

To edit a chapter, proceed as follows:

1. Highlight the required video title in the content area.
   - All existing chapter marks of the respective title are displayed on the scroll bar in the preview area.

2. If you want to move an existing chapter mark, click the respective mark on the scroll bar in the preview area and drag it to the required position.

3. If you want to delete a chapter, mark it in the content area and click the ▬ ▶ **Remove chapter** button.
   - The chapter is deleted.

4. If you want to delete all chapters of a title, mark the video title and click the ▬ ▶ **Remove all chapters** button.
   - All chapter marks are deleted.
   - You have edited the chapters.

**See also**

- Creating and Editing a Disc Project → 17
2.5 Saving a Project

Once you have started working with your project, occasionally you may want to interrupt your work, resume it at a later time, or burn it.

A project file (*.nvc) saves the project data – information about file paths and layout – after you have started work on your project. This means that you can interrupt your work at any time and resume the project at a later point or burn it on disc. The contents of a project file can only be opened with Nero Vision. The file size of a saved compilation is significantly smaller than a disc image.

A Disc image (image file) is the precise picture of the project data to be burned. You can burn the finished image as often as you like at a later stage, but it requires just as much space on the hard drive as the compilation to be burned. As well as being burned to disc or as a disc image, some projects can also be captured to hard disc folders, memory stick or SD card, provided there is enough space.

To save a project, proceed as follows:
1. Click the Save button in the lower task bar of the main window.
   ➔ The Save As window is opened.
2. Enter the desired file name in the File name input field and click the Save button.
   ➔ You have saved the project and can open it again later to continue working on it or burn it.

2.6 Opening a Project

To open a saved project, proceed as follows:
1. In the Start screen, select the Open Saved Project or Disc Image option.
   ➔ A window is opened.
2. In the Files of type drop-down menu, select the Nero Vision Projects (*.nvc) entry.
3. Highlight the project file of the required video project and click the Open button.
   ➔ The project is opened in the Content screen.
   ➔ You have opened an existing project and can now continue to edit it or burn it.

2.7 Opening a Disc Image

To open a disc image, proceed as follows:
1. In the Start screen, select the Open Saved Project or Disc Image option.
   ➔ A window is opened.
2. In the Files of type drop-down menu, select the Nero Image Files (*.nrg) option.
3. Highlight the desired image file and click the Open button.
   ➔ The image opens in the Burn Options screen.
   ➔ You have opened a disc image and can now burn it.
Capturing Videos from Cameras and Other External Capture Devices

3 Capturing Videos from Cameras and Other External Capture Devices

3.1 Capturing

Capturing is a way of taking the video from a DV video camera or another video capture device connected to the video capture card and placing it on your computer. The capture device is the device that transmits the video signals to be captured (e.g. from a DV video camera, video capture card, or TV card).

You will find a list of supported devices on our Web site at www.nero.com.

If you want to transfer the video from an external capture device to your computer to use it in a project at a later time, proceed as described in Capture Video to Hard Drive.

If you want to create a disc and capture a video for this specific project, you should select the relevant option Make DVD (or VCD, SVCD, miniDVD) in the Start screen, and then click the Import > Capture button in the Content screen. This way, you can capture the video and work on your project simultaneously.

AVCHD cameras are an exception. These compress captured files directly into MPEG-4 transport data that is written to a DVD, memory card or internal hard drive. Data that you want to transfer from your camera to the hard drive is imported and thus not transferred by means of capturing.

For AVCHD cameras that capture to DVD, insert the camera DVD into your computer's DVD drive and import the captured files with the Import > Import Disc feature in the Content screen directly into the project.

For AVCHD cameras that capture to hard drive, connect the camera to your PC and import the captured files directly into your project with the Import > AVCHD From Hard Disc feature in the Content screen.

For AVCHD cameras that capture to memory card, connect the memory card to your computer via the corresponding interface and then import the captured files also with the Import > Import AVCHD From Hard Disc feature in the Content screen.

3.2 DV/HDV Cameras, Digital and Analog Videos

There are three types of capture devices: digital, analog and DV/HDV cameras. All three have different hardware requirements.

DV/HDV cameras: In the case of a DV or HDV camera, the video signal is sent to the PC in digital format. All you need to transfer video to your PC is a connecting cable and a corresponding socket on your PC.

Analog Video: Video signals from an analog source need to be converted to a digital format for your PC to be able to work with them. Examples of analog capture devices include VHS video recorders, TV, VHS-C, 8 mm, and Hi-8 video cameras. Unlike DV capture devices
where the device itself delivers digital video signals to your PC, you need to have a video capture card installed in the PC in the case of analog video signals. The analog signals are converted into digital signals by the video capture card.

**Digital Video** (ATSC, DVB-T/S/C): Video signals from digital capture devices are sent to the PC in digital format and exist in MPEG-2 format after transfer. TV cards are typical examples of digital devices. In order to transfer digital video, a corresponding device must be connected to your PC.

### 3.3 Capture Video Screen

On the **Capture Video** screen all the connected devices are shown on the **Capture device** selection menu. Besides the desired capture device the capture template can be selected here.

For detail settings and the capture procedure, the screen is divided into two areas, the preview area on the left and the information area that shows the most important settings of the target file.

Clicking the **Configure** button opens the window for adjusting the detail settings of the video options.

Clicking the respective button on the right screen margin opens the **Video Device Properties** or **Audio Device Properties** window. You can change the detail settings in both windows, if the connected capture device offers configuration options.
Capturing Videos from Cameras and Other External Capture Devices

The following option buttons are available for the selection of the capturing template:

<table>
<thead>
<tr>
<th>Option Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Native capturing</strong></td>
<td>Optimizes all parameters based on the selected capture device and captures the video in the format specified by the capture device. The <strong>Native capturing</strong> option button is selected in the default settings. Capturing in the default settings is recommended.</td>
</tr>
<tr>
<td><strong>Custom capture template</strong></td>
<td>Adjusts the detail settings of the parameters. You can select the desired target format.</td>
</tr>
</tbody>
</table>

In the preview area you can use the **Position** buttons next to the time code display to move to a certain position within the video title. Furthermore, the following setting options are available:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>▶️</td>
<td>Starts playback.</td>
</tr>
<tr>
<td>▷️</td>
<td>Stops playback.</td>
</tr>
<tr>
<td>○</td>
<td>Starts capture.</td>
</tr>
<tr>
<td>◀️ / ▶️</td>
<td>Rewinds/Fast forwards the video.</td>
</tr>
<tr>
<td>⌚️</td>
<td>Switches to full screen mode. You can return to window mode by pressing the Esc key.</td>
</tr>
<tr>
<td>⏰</td>
<td>Set the timer that enables specifying the capturing start time, end time and capturing time.</td>
</tr>
<tr>
<td>📽️</td>
<td>Scans the tape and shows a thumbnail in the scene gallery for each recognized scene. Here the desired scene for capturing can be selected. Only available for DV-/HDV cameras in the VCR mode.</td>
</tr>
<tr>
<td>▲ / ▼</td>
<td>Switches to the next/previous channel. Only available for TV cards.</td>
</tr>
<tr>
<td>📦</td>
<td>Increases or decreases the speed in the playback of the preview of DV-/HDV camera by up to 6 times. As soon as the slider is released it automatically jumps back to the central position and plays the tape back at the normal speed. Only available for DV-/HDV cameras in the VCR mode.</td>
</tr>
</tbody>
</table>
Capturing Videos from Cameras and Other External Capture Devices

| Jog dial | Navigates through the capture on a frame-by-frame basis. Only available for DV-/HDV cameras in the VCR mode. |

Activate the **Enable capture device audio playback** check box in the extended area if you want to enable playback on the capture device. This setting does not affect playback of captured video files.

**See also**
- Preview Scan Window → 26
- Video Device Properties Window → 27
- Audio Device Properties Window → 27
- Capturing Video to Hard Drive → 30
- Capturing to Disc On-the-Fly → 33
- Importing from the Web → 34

### 3.3.1 Preview Scan Window

In the **Capture Pre-scan** window it is possible to pre-scan the tape of your DV-/HDV camera.

The window is divided into a preview area on the left and the scene gallery on the right in which a thumbnail is shown for each recognized scene. Here the desired scenes for capture can be chosen.

In the case that you have not customized the setting for the capture in the **Capture Video** screen or if you wish to change the settings, all the options for the choice of the capture template are also available here.

The **Native Capturing** option button is selected in the default settings. Capturing in the default settings is recommended.

The following buttons are available:

<table>
<thead>
<tr>
<th>Start Scan</th>
<th>Starts the scan process and shows a thumbnail of each recognized scene in the scene gallery.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete</td>
<td>Removes the marked scenes from the scene gallery.</td>
</tr>
<tr>
<td>Merge</td>
<td>Connects marked scenes.</td>
</tr>
<tr>
<td>Capture</td>
<td>Begins the transmission of the chosen scenes to the hard drive.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Cancels the procedure and closes the window.</td>
</tr>
</tbody>
</table>

**See also**
- Capture Video Screen → 24
- Pre-Scanning Video Captures → 32
3.3.2 Video Device Properties Window

The following tabs are available in the Video Device Properties window:

<table>
<thead>
<tr>
<th>Format</th>
<th>Sets the frame rate, color compression process and output format to correspond to the way the video is to be burned onto the disc. In the case of analog capture devices, clicking the Configure button starts the device test. You can select the video source here (video, composite or S-video).</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>Sets values such as brightness, sharpness or contrast using the sliders.</td>
</tr>
<tr>
<td>Channels</td>
<td>Displays all available channels of the selected device. Here you can select the required channel for your capture. Clicking the Manage TV Channel Groups button displays the last screen of the TV wizard again, and you can edit, add or remove groups and assigned channels. The TV wizard screen displays the available channels and groups of all installed capture devices. If you click the Channel Setting button, you can once again configure a TV card on a step-by-step basis using the TV wizard.</td>
</tr>
</tbody>
</table>

See also
- Capture Video Screen → 24
- Setting a TV Card → 27

3.3.3 Audio Device Properties Window

The following areas are available in the Audio Device Properties window.

<table>
<thead>
<tr>
<th>Device settings</th>
<th>Defines the required audio source.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio input</td>
<td>Defines the required audio inputs (e.g. CD player, line, microphone). Click the icon to display the available options.</td>
</tr>
</tbody>
</table>

See also
- Capture Video Screen → 24

3.4 Setting a TV Card

To set up a capture device for digital and analog video, a recording card that meets the requirements of the manufacturer must be installed or must be already integrated in the PC at the factory.
Nero Vision provides simultaneous support for multiple TV cards, TV cards with dual tuner, and/or hybrid tuner cards. You will find a list of supported TV cards on our web page under www.nero.com.

If you have connected a TV card to your PC and open the Capture Video screen for the first time, all connected devices are displayed in the Capture device drop-down menu.

The following requirement has to be fulfilled:

► A TV card is connected to your PC and switched on.

To configure a TV card using the TV wizard, proceed as follows:

1. Select the Capture Video to Hard Drive option from the Start screen.
   ➔ The Capture Video screen is displayed.

2. If you have several devices connected to your PC, select the required device in the Capture device drop-down menu.

3. Click the button.
   ➔ The Video Device Properties window opens.

4. Click the Channels tab.

5. Click the Channel Setting button.
   ➔ The first screen of the TV wizard, Analog TV Channel Search, is displayed. This wizard prompts you to make all the necessary entries step by step.

6. Select your country in the Select country drop-down menu.

   When configuring DVB-S TV cards, you must select the satellite instead of the country in the Select your satellite configuration field.
   When configuring DVB-C TV cards, you must select the appropriate frequency range instead of the country.

7. Choose between Antenna and Cable as the signal source in the Select source type drop-down menu.

   The Select source type drop-down menu is not available when configuring digital TV cards (DVB-T, DVB-S, DVB-C).

8. Click the Start Search button to start the search.
   ➔ The search starts. You are kept informed about the search progress and the number of channels found in the Search Status area.

9. Click the Next button.
   ➔ The second screen of the TV wizard, TV Channel Edit, is displayed. You can order, rename or remove the channels as required.

10. Click the Up and/or Down buttons.
    ➔ The order of the available channels is changed.
11. Highlight the channels you do not want and click the Remove button.
   → The channels are deleted.

12. If you want to coordinate the channels of a number of TV cards with each other:
   1. Highlight a desired channel and click the Rename button.
      → The Rename Channel window is opened.
   2. Enter the name you want in the Rename Channel text field and click the OK button.
      → The channel is renamed.

   Nero Vision regards TV channels with the same name – so-called "physical" channels – on different tuner cards as the same "logical" channel. This means that a logical channel can contain one or more physical channels. The channels are automatically coordinated with each other during the channel search. Only the logical channels will be displayed in Nero Vision following configuration in the TV wizard.

13. Click the Next button.
   → The third screen of the TV wizard, Manage TV Channel Groups, is displayed. You can sort the channels in existing topic groups or in groups according to your requirements.

14. Click the Add button on the TV Channel Groups tab.
   → The Add Group window is opened.

15. Enter the desired name of the group in the Add Group text field and click the OK button.
   → The group is created.

16. Click the TV Channels to Groups tab.

17. Select the group you want to edit in the Modify your groups drop-down menu.

18. Highlight the channels you want to assign to this group in the Available Channels area and click the >> button.
   → The highlighted channels are shown in the Modify your groups area.

19. Click the Down and/or Up buttons.
   → The order of the channels within the group is adjusted.

20. Click the Finish button.
   → The TV wizard is closed and the Capture Video screen is displayed.
   → You have configured the TV card.

See also
   → Video Device Properties Window → 27
3.5 Capturing Video to Hard Drive

To set up a capture device for digital and analog video, a recording card that meets the requirements of the manufacturer must be installed or must be already integrated in the PC at the factory.

You need a lot of free space on your hard drive to capture a video. Make sure that there is enough space available to capture the entire video. Capturing video from a capture card requires about 3-30MB of hard disk space per second depending on the resolution and the data format of your video. A DV capture via a FireWire card (IEEE 1394) uses up to 3.6 MB of hard drive space per second.

The following requirements have to be fulfilled:
- No applications are running that place a high demand on the processor.
- There are no applications running in full-screen mode.
- The workstation is not blocked during the entire capture process.
- There is sufficient space on your hard drive.

To capture a video on the hard drive, proceed as follows:

1. Connect the digital or analog capture device to the PC using the corresponding cables and switch it on.

2. Select the Capture Video to Hard Drive option from the Start screen.
   - The Capture Video screen and a window is displayed. The window recommends the Native capturing choice.

3. Select the capture device in the Capture device drop-down menu.

   The capture device may be in Camera mode or in VCR mode.
   - In Camera mode, the video signals are continuously transferred from the capture device to the PC, and you can view the current video signal in the preview area. In the case of a DV video camera, everything in the picture area frame of the video camera is displayed in the preview dialog box. A TV card is always in Camera mode as there is a constant video signal coming in and there is no way of pausing, rewinding/fast forwarding or restarting the video signal.
   - In VCR mode, the video already exists on tape (or another medium). To capture that video you need to insert the tape into your video device and play it back. You can also rewind/fast forward through the whole tape to play back specific scenes. Digital video cameras can be set to either Camera mode or VCR mode. Please check the manufacturer's instructions on how to do this.
   Analog video cameras are automatically in VCR mode. Depending on whether the capture device is in Camera or VCR mode, some buttons are not available.

4. Choose between the Native capturing and Custom capture template option buttons in the upper right section of the window.
Capturing Videos from Cameras and Other External Capture Devices

Native capturing transfers the video without losing information during conversion in the format specified by the capture device. The Native capturing option button is selected in the default settings. Capturing with Native capturing is recommended.

5. If the Custom capture template option button is selected:
   1. Select the required format in the drop-down menu.
      → The Profile drop-down menu appears in the Details area.
   2. Select the desired Profile.
      → The output file settings are displayed in the Details area under Output File.
   3. If you want to adjust the detail settings, click the Configure button.
      → A window is opened.
   4. Make the required detail settings and click the OK button.
      → The output file settings are adjusted.

6. If you use an analog capture device, start the playback on the capture device.
   If you are using a digital capture device and it is in VCR mode, control the tape using the buttons.
   → You will see the current scene in the preview area.

   You can scan the tape of your DV/HDV camera in advance. A thumbnail of each scene is displayed. Here you can select the required scene for your capture. Clicking the Pre-scan capture button opens the Pre-scan capture window.

7. Check playback from the capture device in the preview area.

8. If you want to change the video settings:
   1. Click the button.
      → The Video Device Properties window is opened.
   2. Make the required settings and close the window.
      → The video settings are adjusted.

9. If you want to select an external audio source for capture:
   1. Click the button.
      → The Audio Device Properties window is opened.
   2. Make the required settings and close the window.
      → The audio settings are adjusted.

10. If you would like to save the video file to a folder other than My Documents/NeroVision/CapturedVideo:
    1. Click the More button.
       → The extended area is displayed.
2. Enter the path and the file name in the **Capture to File** input field.

11. Click the **Capture to File** button.
   - Capturing starts and the picture that was recently captured appears.

12. Click the same button again to stop capturing.
   - A selection list is displayed. It contains captured files that have not yet been assigned to a project.

13. If you want to capture other videos from the same source, repeat the previous two steps.

14. If you want to view the captured video:
   1. Select the required video in the selection list.
   2. Click the **Play** button.
      - The captured video is displayed in the preview area.

15. Click the **Next** button.
   - The screen with the menu *What would you like to do next?* is displayed.
   - You have captured a video on the hard drive and can now edit it.

**See also**
- Capture Video Screen → 24
- Pre-Scanning Video Captures → 32

### 3.5.1 Pre-Scanning Video Captures

Scans the tape of your DV/HDV camera and shows a thumbnail of each recognized scene in the scene gallery. Here the desired scene for the capture can be selected.

> To set up a capture device for digital and analog video, a recording card that meets the requirements of the manufacturer must be installed or must be already integrated in the PC at the factory.

> You need a lot of free space on your hard drive to capture a video. Make sure that there is enough space available to capture the entire video. Capturing video from a capture card requires about 3-30MB of hard disk space per second depending on the resolution and the data format of your video. A DV capture via a FireWire card (IEEE 1394) uses up to 3.6 MB of hard drive space per second.

The following requirements have to be fulfilled:

► No applications are running that place a high demand on the processor.
► There are no applications running in full-screen mode.
► The workstation is not blocked during the entire capture process.
► There is sufficient space on your hard drive.
► A DV/HDV camera is connected to the PC by means of the corresponding cables and is in the VCR mode.
► The **Capture Video** screen is displayed.
To scan a video before capture and to take over selected scenes to the hard drive, proceed as follows:

1. Click the Pre-Scan button.
   ➔ The Pre-Scan window is opened.

2. Click the Start Pre-Scan button.
   ➔ The tape is scanned. Progress can be followed in the window. A thumbnail is shown for every scene in the scene gallery in the Pre-Scan window.

3. If individual scenes are not to be taken over on the hard drive, select the desired scenes in the scene gallery and click the Delete button.
   ➔ The scenes are removed from the scene gallery.

4. If individual scenes are to be combined into one, mark the desired scenes in the scene gallery and click the Combine button.
   ➔ The scenes are combined into one.

5. In the case that you have not customized the settings for the capture in the Capture Video screen or if you wish to change the settings, carry out your wishes now.

6. Click the Capture button.
   ➔ The capture is started and the desired scenes are transmitted.
   ➔ A selection list is displayed in the Capture Video screen. The list box shows captured files that are not assigned to a project.
   ➔ You have scanned a video before capture and taken over selected scenes from the hard drive.

See also

- Capturing Video to Hard Drive → 30
- Preview Scan Window → 26

### 3.6 Capturing to Disc On-the-Fly

If you create an editable DVD by means of a capture device, you can transfer the required data (e.g. camera captures) directly to disc, i.e. without buffering.

Some of the functions mentioned here are restricted or not available in the Essentials version. You can always upgrade your Essentials version at www.nero.com to get the full version with all the functions.

To set up a capture device for digital and analog video, a recording card that meets the requirements of the manufacturer must be installed or must be already integrated in the PC at the factory.
Capturing Videos from Cameras and Other External Capture Devices

If you have installed a DVD-RW/+RW burner and insert a DVD-RW or DVD+RW disc, you can use Nero Vision to create editable DVD disc formats and DVD-Video: DVD-VFR (video mode) and DVD+VR.

In comparison to DVD-Video, the advantage of these disc formats is that the content can be changed later on. This means that you can edit the movies, insert new passages, delete scenes that you do not want to see, or overwrite the disc. However, a disadvantage is that you cannot create individual menus.

The DVD-VFR (video mode) and DVD+VR disc formats are compatible with DVD-Video and can be played on nearly any commercial DVD player.

The following requirements have to be fulfilled:

► A capture device for digital or analog video is installed and connected to the PC.
► No applications are running that place a high demand on the processor.
► There are no applications running in full-screen mode.
► The workstation is not blocked during the entire capture process.

To create an editable DVD directly via a capture device, proceed as follows:

1. Insert a rewritable disc into the recorder.
2. Turn the capture device on and launch Nero Vision.
3. Select the Record Directly to Disc option in the Start screen.
4. If more than one burner is installed on your PC, select the burner in the drop-down menu, in which you have inserted the rewritable disc.
   ➔ The Capture Video screen is displayed.
5. If the TV card has not yet been configured, proceed as described in the Configuring TV Card chapter.
6. Proceed as described in the Capturing Video to Hard Drive chapter.
   ➔ You have created an editable disc directly via a capture device.

See also

Capture Video Screen → 24

3.7 Importing from the Web

You can download a video or picture file from the Internet or Internet communities and add it to your project as a title or as a component in the timeline (content area of your compilation).

You can import files in all capture formats supported by Nero Vision. Only one file can be downloaded at a time.

The following requirement has to be fulfilled:

► The Content screen is displayed.

To download a file from the Internet, proceed as follows:

1. In the Content screen, click the Import > Import from Web button.
Capturing Videos from Cameras and Other External Capture Devices

When first importing to or exporting from the internet, the My Nero Login window opens. Here you can enter your access data for the My Nero Internet community once and then stay logged in for all subsequent visits via Nero Vision.

2. Enter your Login Name and Password for the My Nero Internet community in the input fields.

3. Select the Save account data check box and click the OK button.

4. If you do not have a user account for the My Nero community, click the Cancel button.
   - When starting the import feature, Nero checks whether new configuration files are available. A window informs you if there are any recommended or required updates.
   - The Import from the Web window is displayed. The Internet communities that are available for loading from the media files are displayed in the selection menu at the top left. The navigation tree of the selected community appears below it. You always have the option of accessing the freely-accessible folders of the community. If you are registered you can also access your own videos there.

5. If you want to download another community displayed in the drop-down menu, select the desired community.
   - A window for entering your user data appears.

6. If you possess an account at the selected community:
   1. Enter your Login Name and Password in the input fields.
   2. Select the Save Account Data check box.
      - Your access data will be stored for future visits.
   3. Click the OK button.

7. If you do not have a user account for the selected community, click the Cancel button.
   - The navigation tree of the selected community appears.

8. Look for and highlight the desired media file on the right side of the window.
   - You can enter a search word in the input field at the top right of the window and click the Search button to look through the community for keywords. Any files found are listed in the area below.
   - If a selected file type does not fit the current project, e.g. you try to import a video into a slide show, a window appears with the appropriate message.

9. Click the Download button.
   - The import is started, the file is downloaded in its original format. Progress while importing is displayed in a separate window.
   - The Copy Files to Hard Drive window is opened.

10. Select the destination folder on your hard drive to which you want to save the file.

11. Click the OK button.
The file is saved and Nero Vision lists it as a new title in the project. If you have imported the file directly into the Video Editing screen, Nero Vision lists the file in the media area.

You have imported a file from the Internet and can now work it into your project.

See also

Capture Video Screen → 24
4 Editing Videos

4.1 Video Editing Screen

In the Video Editing screen you can compile media files into a movie or slide show, cut videos that you have added and/or work with effects and transitions according to your requirements. You can add comments and audio files for background music.

Some of the functions mentioned here are only available in the Nero Creative CollectionPack 1 which is part of the Nero Multimedia Suite Platinum HD and Nero Video Premium HD.
You can always obtain the Nero Creative CollectionPack 1, the Nero Multimedia Suite Platinum HD, and Nero Video Premium HD at www.nero.com.

Some of the functions mentioned here are restricted or not available in the Essentials version. You can always upgrade your Essentials version at www.nero.com to get the full version with all the functions.

The three palettes My Media, Effect Palette and Properties are available in the upper right of the screen. Clicking the ▼ button at the left side of the respective palette’s headline will expand it.

In the lower area of the screen is the content area. All files that you add to the compilation are displayed in the Storyboard or Timeline view. The Timeline tab is displayed by default when you select the Make > Movie entry in the Content screen and it is opened automatically when you add a video clip or audio track or when you select a theme-based template. The Storyboard tab is displayed by default when you select the Make > Slide Show entry in the Content screen.
The following setting options are available in the upper right of the content area:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nero PiP</td>
<td>Opens the <strong>Nero PiP Effects</strong> window in which you can choose between various <strong>Nero Picture in Picture Effect templates</strong>. These templates allow you to create multitrack overlay projects in just a few steps. The templates are sorted by the number of elements, i.e. placeholders, available per template. Each template has a certain number of placeholders which you can replace with the desired video or picture files after inserting the template. You can also change the duration and insert setting options in this window.</td>
</tr>
<tr>
<td>Themes</td>
<td>Opens the <strong>Themes</strong> window in which you can choose files and set up basic editing options for your movie. You will find templates for various themes such as birthday or wedding. Each template amends your project by a theme-based intro and outro video and automatically inserts various suitable (text) effects, transmissions, as well as background music into the content area.</td>
</tr>
<tr>
<td>Movie Detection</td>
<td><strong>Scene Detection</strong> - Starts a scene detection of a selected clip in the content area. The detected subclips are inserted back into the track, thereby replacing the source clip. They can be edited separately. <strong>Ad Spotter</strong> - Opens the <strong>Ad Spotter</strong> window in which all settings can be defined so that Nero Vision can search for and delete advertising sequences in your captured files from your compilation. <strong>Music Grabber</strong> - Opens the <strong>Music Grabber</strong> window in which all the settings can be defined to search for music clips in movies. Only available if a single clip is selected in the content area.</td>
</tr>
<tr>
<td>Record Audio</td>
<td>Opens the <strong>Audio Recording Settings</strong> window in which you can record your report for single clips in the content area. By default, the narration is recorded to the <strong>Narration</strong> track at the position of the timeline slider but it can be moved to any free audio track position.</td>
</tr>
<tr>
<td>Duration</td>
<td>Opens the <strong>Duration</strong> window in which you can choose between three <strong>Insert mode</strong> options and the corresponding duration. The <strong>Shift</strong> entry is selected by default. The <strong>Auto fill gap</strong> radio button is only available when a gap is left between a single selected clip and the following item on the timeline.</td>
</tr>
<tr>
<td>Movie Options</td>
<td>Opens the <strong>Movie Options</strong> window in which you can define all settings for the timeline.</td>
</tr>
</tbody>
</table>

**See also**
- Preview Area → 39
- Media Area → 40
4.1.1 Preview Area

You can preview your compilation and edit (scale, rotate) clips in the preview area in the upper left of the Video Editing screen. Shift the current position by dragging the timeline slider on the time scale.

The following setting options are available in the preview area:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Switch to full screen mode" /></td>
<td>Switches to full screen mode. A control panel is displayed in the lower area of the full screen. To return to window mode, press the Esc key on your keyboard.</td>
</tr>
<tr>
<td><img src="image" alt="Show" /></td>
<td>Displays the selected editing tools: You can choose to display rulers, guide lines, as well as a safe area which marks the outer 10 percent of the total menu width and height as protected from title editing and the outer 5 percent of the total menu width and height as generally protected. The Snap to guide tool sets the clip to the guide if you come near a guide. The Snap to object tool sets clips to each other if you come at 10 pixels to the snap line of an object with another one. Snap lines are left, right, bottom, top, horizontal center, and vertical center of both clips.</td>
</tr>
<tr>
<td><img src="image" alt="Create snapshot" /></td>
<td>Creates a snapshot of the displayed position in the video title.</td>
</tr>
<tr>
<td><img src="image" alt="Jump to next or previous edit" /></td>
<td>Jumps to the next or previous edit (from all tracks).</td>
</tr>
<tr>
<td><img src="image" alt="Jump to next or previous frame" /></td>
<td>Jumps to the next or previous frame.</td>
</tr>
<tr>
<td><img src="image" alt="Stop playback" /></td>
<td>Stops the playback of the movie.</td>
</tr>
<tr>
<td><img src="image" alt="Begin/pause playback" /></td>
<td>Begins/pauses the playback of the movie.</td>
</tr>
</tbody>
</table>
4.1.2 Media Area

On the My Media palette in the upper right of the Video Editing screen you can search for the required media files. Here, you can also import files that can then be added to the compilation. Click the Import drop-down menu on the right to import more files from various sources, even from e.g. the Internet into Nero Vision. Click the Capture entry to display the Capturing screen.

Different media types are automatically arranged on single tabs. You can choose to see your media listed in thumbnail view or list view; thumbnail view is activated by default. The following tabs are available on the My Media palette:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Videos</td>
<td>Provides imported video clips and subclips. You can create subclips from your videos via the Scene Detection entry in the context menu. The whole source clip stays available on the tab after pre-trimming, the resulting subclips are listed below.</td>
</tr>
<tr>
<td>Pictures</td>
<td>Provides imported photos.</td>
</tr>
<tr>
<td>Audio</td>
<td>Provides imported audio files.</td>
</tr>
<tr>
<td>Clip art</td>
<td>Shows a list of graphics sorted into categories. Clip art graphics behave the same as any other picture file in the timeline. Each graphic has a default size or length when you drag it into the timeline. You can add effects or trim the graphic. The only exception is the handling of the source resolution.</td>
</tr>
<tr>
<td>Music</td>
<td>Provides audio files in various topics. Each audio file has a default duration when you drag it into the timeline, but it can be shortened to the desired duration.</td>
</tr>
</tbody>
</table>

Double-click any file to open a Preview window in which you can pre-trim the item into subclips and view metadata information such as the storage path.

See also

Video Editing Screen → 37
4.1.3 Effect Palette

Some of the functions mentioned here are restricted or not available in the Essentials version. You can always upgrade your Essentials version at www.nero.com to get the full version with all the functions.

The Nero Video TransitionPack 1 is available as a single add-on or with the Nero Creative CollectionPack 1 which is included in the Nero Multimedia Suite Platinum HD and Nero Video Premium HD. If you have Nero Vision Xtra or the standard Nero Multimedia Suite installed, the Nero Creative CollectionPack 1 including the Nero Video TransitionPack 1 is not part of Nero Vision. You can always obtain the Nero Multimedia Suite Platinum HD, Nero Video Premium HD, the Nero Video TransitionPack 1 or the Nero Creative CollectionPack 1 at www.nero.com.

All transitions, as well as audio, video and text effects are available on tabs of the Effect Palette in the upper right area of the Video Editing screen. The categories of transitions and effects are listed on the left of each tab.

See also

Video Editing Screen → 37

4.1.4 Properties Palette

The Properties palette in the upper right of the screen shows the properties of selected or highlighted objects you dragged and dropped to the content area of your project from the My Media palette or Effect Palette. The specific properties of the single transitions and effects are displayed here and the basic effects of pictures, audio clips, and video clips are listed by default.

Some of the functions mentioned here are restricted or not available in the Essentials version. You can always upgrade your Essentials version at www.nero.com to get the full version with all the functions.

If you want to edit an object you dragged and dropped to the content area, it has to be selected and the timeline slider has to be positioned on the clip. Otherwise, all setting options on the Properties palette remain gray.

The following basic effects are available:

| Audio Level | Standard audio effect that allows you to adjust the audio volume of a respective clip. Available for audio and video clips only. |
### Anchor Point
Sets the position of the anchor point of the clip. You can either choose a predefined position by activating one of the Corner buttons on the right or select your own position in the input fields on the left. The center point is selected by default.
Available for video clips and pictures only.

### Position
Positions the clip at the desired position or sets it horizontally or vertically centered. You can also position a selected clip in the preview area in the upper left of the screen.
Available for video clips and pictures only.

### Scale
Scales (enlarges or downsizes) either the whole track or selected key frames by entering the desired percentage into the input fields. The Fit to screen button is enabled by default; you can disable it for scaling.
The lock is closed by default, horizontal and vertical scale can only be adapted proportionally. Click the icon to unlock and give different values.
You can also scale a selected clip in the preview area in the upper left of the screen.
Available for video clips and pictures only.

### Rotation
Selects the level of rotation by the number entered in the Rotation input field: positive for clockwise and negative for counter-clockwise.
You can also rotate a selected clip in the preview area in the upper left of the screen. Click the lower left corner of the preview frame and keep the mouse key pressed while you drag it to the required level.
Available for video clips and pictures only.

### Opacity
Adapts the transparency either of the whole clip or - with the help of key frames - of defined positions.
Available for video clips and pictures only.

Additionally, you can easily drag and drop more or optional effects from the Effect Palette to a clip. All additional effects are listed below the basic effects in the lower area of the Properties palette. If multiple clips are selected in the content area of your project, the same effect is assigned to each of the selected clips and listed in each clip's respective list of effects on the Properties palette. Effects are rendered top to bottom. You can modify the order of optional effects per drag-and-drop function.

Clicking the ▼ button at the left side of any effect's headline expands an extended area which shows the respective effect's setting options. You can adjust these individual properties. The following setting options are always available:

| Button | Enables or disables additional effects temporarily. If you activate the button for one of the basic effects, it will be performed in its default setting (e.g. Opacity = 100%). |
Check box and controls

Use key frames

Select the check box to add a key frames track for the respective effect below the respective main clip on the Timeline tab in the content area.

As long as you haven't chosen individual key frame positions on a track, the effect settings are valid for the whole clip. Once you created single key frames, effect settings are valid for chosen positions. A single key frame at the start and at the end of the clip is always added by default.

You can add, select and/or delete single key frames with help of the controls. (Only available when the Use key frames check box is selected.)

Click the Create key frame button to add a key frame to the chosen timeline slider position. Click the Go to the next key frame/Go to the previous key frame buttons to select the key frames on the timeline. If you click the main button again, a highlighted key frame is deleted (Delete key frame).

Additionally, you can choose from three interpolation methods. The Linear interpolation method sets a constant alteration rate from single key frame to key frame; this method is set by default. The Bezier interpolation method sets a smooth step-up from key frame to key frame that softly fades away. The Hold interpolation method abruptly changes to a chosen value without gradual transition.

Button Delete

Removes the effect from the item in your compilation.
Not available for basic effects.

Only one transition can be applied to a video clip or picture at once. If you drop a second transition, the first transition is replaced. Clicking the ▼ button at the left side of any transition's headline expands an extended area which shows the respective transition's setting options. You can adjust these individual properties. The following setting options are always available:

Button [ ▼ ] Enables / disables a transition temporarily.

Input field Duration Displays and defines the duration of the transition.
The duration is set to one second by default.

Buttons Alignment Defines if a transition is aligned more to the left (end at cut), more to the right (start at cut), or if it stays centered between two clips.
A transition is centered between two clips by default.

Button Delete Removes the transition.
You can also press the Del key on your keyboard to delete a selected transition from your compilation.

See also

■ Video Editing Screen → 37
4.1.5 General Handling on Timeline Tab

The Timeline tab in the content area of the Video Editing screen is displayed by default when you select the Make > Movie entry in the Content screen. It is opened automatically when you add a video clip or audio track or when you select a theme-based template.

⚠️ Some of the functions mentioned here are restricted or not available in the Essentials version. You can always upgrade your Essentials version at www.nero.com to get the full version with all the functions.

A time cursor can be dragged or moved by scrubbing the mouse cursor on the time scale to display respective frames in the preview window in the upper left of the screen. The time cursor sticks to its position when you insert clips.

If you want to edit an object you dragged and dropped to the content area, it has to be selected and the time cursor has to be positioned on the clip. Otherwise, all setting options on the Properties drawer remain gray.

A time display in the upper left of the tab shows the time position in the time format hh:mm:ss:ff. It corresponds to the current position of the time cursor. Clicking the display changes the view into an input field. Enter a respective time and press the Enter key on your keyboard to jump to the given position. You can also enter a time difference. (For example + 500 - equal to + 5:00 - jumps to the current position plus five seconds.)

If you want to adapt the area of your compilation that will actually be transcoded or exported into a video, you can activate the Enable WorkSpace entry in the context menu of the time scale and move the Workspace Mark In and Workspace Mark Out markers to shorten the active (white) workspace. However, files to the left and right of the markers (gray space) stay fully available for editing.
The following setting options are available in the left columns of the timeline tab:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Hide Track / Show Track</strong></td>
<td>Allows you to deactivate the preview of whole tracks. A cleared check box in Video tracks deactivates the preview of video tracks. A disabled loudspeaker in Audio tracks deactivates the preview of audio tracks.</td>
</tr>
<tr>
<td><strong>Lock Track / Unlock Track</strong></td>
<td>Locks the entire track so that further editing is prevented. For example, when you add or move clips by pressing the Shift button, clips in a locked tracks are not shifted to the right.</td>
</tr>
</tbody>
</table>

The following setting options are available on the lower task bar of the tab:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Switch to minimal timeline view</strong></td>
<td>Allows you to adjust the height view of the different tracks. All tracks are displayed in small height. In addition, you can adjust the height of the tracks manually by dragging the separator to the respective position.</td>
</tr>
<tr>
<td><strong>Switch to mixed timeline view</strong></td>
<td>Allows you to adjust the height view of the different tracks. The video tracks are displayed in extended height and all audio tracks are displayed in smaller height. In addition, you can adjust the height of the tracks manually by dragging the separator to the respective position. The tracks are displayed in timeline view by default.</td>
</tr>
</tbody>
</table>
Editing Videos

<table>
<thead>
<tr>
<th>Button</th>
<th>Switch to extended timeline view</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Allows you to adjust the height view of the different tracks. All tracks are displayed in extended height. In addition, you can adjust the height of the tracks manually by dragging the separator to the respective position.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Drop-down menu</th>
<th>New Track</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Creates a new track on the timeline. Timelines are rendered from bottom to top. You can choose if you want to add a pure video track, a pure audio track or a video track with audio. You can also create a new track by moving selected clips beyond the top video or audio track. Drop the clips when a white insert line appears.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Button</th>
<th>Show all objects in the timeline</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Adjusts the timeline view to display the full range of the clips in the project.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Slider</th>
<th>Zoom</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Zooms into the timeline view or zooms out to give an overview.</td>
</tr>
</tbody>
</table>

You can choose from several tools that change the mouse cursor to suit your respective editing needs on the timeline. The following setting options are available in the right border area of the tab:

<table>
<thead>
<tr>
<th>Create Chapter Marker</th>
<th>Allows you to create a new chapter marker at a selected time cursor position on the time scale. A position marker for each created chapter is displayed on the time scale. If you add chapters between existing ones, the consecutive numbering is adapted. Renaming single chapters is possible via the Rename Chapter Marker entry in the context menu. You can jump from position marker to position marker with a click on the &lt; Go to next chapter marker / Go to previous chapter marker &gt; arrows. Selected chapters can be deleted by clicking the Delete Chapter Marker button. An additional Delete all Chapter Markers entry is available via the context menu.</th>
</tr>
</thead>
</table>

| Standard Tool | Allows you to select clips in the timeline. Press the Shift key on your keyboard to select multiple clips. Selected clips are highlighted. Associated clips are selected and highlighted automatically. |

<p>| Rectangular Marquee | Selects multiple clips by dragging the mouse on the timeline. This has the same effect as clicking single clips while pressing the Shift key on your keyboard. Keep the button pressed to display the Select track tool, Select track backward tool, and Select track forward tool entries. The appearance of the cursor is changing according to the selected tool. |</p>
<table>
<thead>
<tr>
<th>Tool Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select track forward tool</td>
<td>Selects all clips to the right of the point you click in a track. Keep the button pressed to display the Select track tool, Select track backward tool and Rectangular Marquee entries.</td>
</tr>
<tr>
<td>Select track backward tool</td>
<td>Selects all clips to the left of the point you click in a track. Keep the button pressed to display the Select track tool, Rectangular Marquee, and Select track forward tool entries.</td>
</tr>
<tr>
<td>Select track tool</td>
<td>Selects all clips in the track you click. Keep the button pressed to display the Rectangular Marquee, Select track backward tool, and Select track forward tool entries.</td>
</tr>
<tr>
<td>Cutter</td>
<td>Cuts a clip in two parts. If a video contains an associated audio clip, the audio clip is also cut. Keep the button pressed to display the Roll Tool and Slip Tool entries.</td>
</tr>
<tr>
<td>Roll Tool</td>
<td>Adjusts the out point and the in point of two adjacent clips simultaneously. Only the touch or edit point between the two clips moves while the total display duration of both objects on the timeline is retained. Click in an area of 10 dots to the left or right of the touch point of two adjacent clips to select both clips and change into the &quot;roll mode&quot;. By scrubbing the mouse, the edit point is rolled. Of course, an edit point cannot be rolled outside the total duration of a respective file. The roll tool might be useful if you want to fit two clips into a shorter timeline gap and still need to find the perfect cutout combination to use. Keep the button pressed to display the Slip Tool and Cutter entries. Available for video clips only.</td>
</tr>
<tr>
<td>Slip Tool</td>
<td>Changes the in and out point of a cut clip on the timeline. When scrubbing the clip, the total duration of the file is shown. Surrounding clips are not affected. Adjusting the visible segment of a clip by scrubbing to the left and right does not change its position or duration on the timeline. Instead, scrubbing changes what cutout appears in the timeline. Of course, if the total duration of the file is the same as the duration of the clip in the timeline, slipping will not have an effect. The slip tool might be useful if you want to fit a clip into a timeline gap and still need to decide which outcut of the source file is the best to fill the space. Keep the button pressed to display the Cutter and Roll Tool entries. Available for video clips only.</td>
</tr>
</tbody>
</table>
Magnet

Aligns a dragged clip to another in the timeline if its border hovers an area within 10 dots left or right to the border of the other clip. You can also align dragged clips to clips in other tracks.

A catch marker is displayed if the clips are aligned to each other. Catch markers are only displayed if the Magnet is activated.

The Magnet is activated by default.

Colored markers can be applied to single clips (Label) as well as single positions within a clip (Nero Clip Marker). They are available via the Label and Nero Clip Marker entry in the context menu. These markers in various colors serve only as an orientation guide for labeling single clips or positions.

When you no longer need a certain label, select the transparent label via the Label entry in the context menu. To remove a clip marker, select it in the timeline and press the DEL key to delete it.

See also

- Video Editing Screen → 37
- Track Handling in Timeline → 48
- Clip Handling in Timeline → 49
- Preview and Trim Window → 62

4.1.6 Track Handling in Timeline

The timeline contains a number of tracks which are rendered from bottom to top. New pure video tracks and combination tracks are added above the current top track. New pure audio tracks are added below the recent bottom track. Double-clicking a track’s title column selects the name so that you can rename it.

You can delete empty tracks via the respective entry in the context menu. The function automatically deletes all empty tracks in a timeline. In any event, the default tracks always remains.

The following tracks are available by default:

<table>
<thead>
<tr>
<th>Track</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Master Effects</td>
<td>Contains the master effects. Effects applied to this track are always rendered to the resulting video output of all tracks. The Master Effects track is always on top of a timeline. It cannot be renamed or deleted.</td>
</tr>
<tr>
<td>Video 2</td>
<td>Contains the video clips and pictures of the second track. Video 2 and Audio 2 are associated or linked by default.</td>
</tr>
<tr>
<td>Audio 2</td>
<td>Contains the audio files of the second track. Video 2 and Audio 2 are associated or linked by default.</td>
</tr>
<tr>
<td>Video 1</td>
<td>Contains the video clips and pictures of the first track. Video 1 and Audio 1 are associated or linked by default.</td>
</tr>
</tbody>
</table>
Audio 1 | Contains the audio files of the first track. Video 2 and Audio 2 are associated or linked by default.
Narration | Contains pure audio files (e.g. for the use of narration clips).
Music | Contains pure audio files (e.g. for the use of background music).

See also

General Handling on Timeline Tab → 44

4.1.7 Clip Handling in Timeline

When you drag a clip from the media area to a track in the timeline, the clip's duration is displayed. The duration is determined by the timescale setting - the opacity setting is set to 50% so that the objects underneath are visible. The preview area in the upper left of the Video Editing screen temporarily shows the frame at the position of the insert marker instead of the frame at the position of the timeline slider.

You can drag multiple video clips or pictures from the media area to a timeline track. The dropped items are then arranged successively and aligned to each other.

If other clips are linked to a selected one in the timeline (like a video clip with audio), the linked clip is also highlighted. You can detach the link via the Unlink Audio & Video entry in the context menu. Vice versa, if one independent video and one audio clip are selected, you can apply a link via the Link Audio & Video entry in the context menu. Both clips in a link are affected when you trim, move, or copy. It is not possible to link multiple audio tracks to one video.

You can insert clips to the timeline in various combinations. The following basic rules or consequences apply for dragged objects:

| Video with audio | When dropped in a combination track, video and audio are added. When dropped in a video track, video is added and audio is ignored. When dropped in an audio track, audio is added and video is ignored. |
| Video without audio | When dropped in a combination track, video is added and audio stays empty. When dropped in a video track, video is added. When dragged over an audio track, a Forbidden cursor is shown. |
| Audio without video | When dropped in a combination track, audio is added and video stays empty. When dropped in an audio track, audio is added. When dragged over a video track, a Forbidden cursor is shown. |

You can insert clips to and edit clips in the timeline in various ways. The following basic rules or consequences apply for clip handling:

| Selecting clips | Clicking a clip selects and highlights the respective clip in the timeline. |
## Editing Videos

### Linking and unlinking clips

If clips are linked to a selected one in the timeline (like a video clip with audio), the linked clip is also highlighted. Both clips in a link are affected when you trim, move, or copy.

You can detach the link via the **Unlink Audio & Video** entry in the context menu. Vice versa, if one independent video and one audio clip are selected, you can apply a link via the **Link Audio & Video** entry in the context menu. It is not possible to link multiple audio tracks to one video.

### Fitting clips into gaps (Shifting)

If necessary, the width of a dragged clip is adjusted to fit into the gap it is dropped to. In this case, the end of the clip is truncated.

To fit a clip into a gap without cutting it, keep the **Shift** key on your keyboard pressed while dropping the clip. All objects in all tracks to the right of the insert marker’s position are shifted to the right. The offset is according to the duration of the dropped clip.

This way it is also possible to divide a timeline clip by dropping a new clip in the middle of the existing clip. The right part is shifted to the right together with all other track objects to the right of the insert marker.

### Moving clips (Copy and paste)

A selected clip can be moved on the timeline track or between tracks. Basically the same rules apply for moving as for inserting per drag-and-drop function.

Selected clips can be copied to the clipboard (press the **Ctrl** key on your keyboard) and pasted to another timeline position (press **Ctrl** key on your keyboard). The clips are inserted at the position of the timeline slider. If you preselect no other track, the copy is placed into the same track as the original.

### Trimming clips

A clip is added in full length (or in its pre-trimming length if you have trimmed it before).

The default length of a picture is 4 seconds. You can trim a clip down to a minimum of 1 frame and to the maximum of the respective media file. To display left or right trim cursors, hover your standard mouse cursor over the sides of a selected clip. A preview of the potentially first or last frame is shown in the preview area. Double-click any file to open a **Trim** window in which you can trim the item on an exact frame by frame basis.

If two clips (audio and video) are associated with each other, both objects are trimmed.

### Deleting clips

Selected clips can be deleted by pressing the **Del** key on your keyboard. Press the **Shift + Del** keys on your keyboard to remove selected clips and to also shift all remaining clips to the left.

---

**See also**

- General Handling on Timeline Tab → 44
4.1.8 Storyboard Tab

The Storyboard tab in the content area of the Video Editing screen is displayed by default when you select the Make > Slide Show entry in the Content screen. The Storyboard tab displays the Video 1 track for video clips, pictures, and transitions as well as the default Narration and Music tracks.

On the Video 1 track, video clips are always indicated by filmstrips to distinguish them from pictures. Every first frame is displayed as a thumbnail. If the first frame is black, the thumbnail is displayed in black. Below each thumbnail the duration and title of the clip are displayed. A input field for descriptions can be activated by double-clicking in the area between thumbnail and duration/title display. These notes will not appear in the preview or in your final video.

You can drag and drop new clips or photos from the My Media palette to the placeholders at the end of the track as well as transitions from the Effect Palette. To change the position of a clip or photo, simply drag the respective item to the new position and drop it between two others. Transitions can be placed between any two clips.

You can move, trim or delete narrations and soundtracks; all other items in the track keep their position. If a video clip includes sound, an additional wave icon is displayed in the top right corner of the thumbnail. To open the Trim window of any picture or video clip, double-click the thumbnail or the respective icon in its top right corner.

See also
- Video Editing Screen → 37
- Preview and Trim Window → 62
4.1.9  Nero Picture in Picture (PiP) Effects

The Nero Picture in Picture Effects feature allows you to easily create multitrack overlay projects with animated picture-in-picture effects in just a few steps. You can choose between many different templates in the Nero PiP Effects window. Each template has a certain number of placeholders and is specifically animated; some of them also have different backgrounds to choose from.

The templates are sorted by their number of placeholders. After you have selected a template and inserted it in the timeline, each placeholder occupies one video track. You can then replace the placeholders with the desired video and picture files.

See also
- Inserting Nero Picture in Picture Templates → 71
- Nero PiP Effects Window → 52

4.1.9.1  Nero PiP Effects Window

The Nero PiP Effects window is opened after clicking the Nero PiP button, with the Template tab being displayed. It allows you to choose between various Nero Picture in Picture Effect templates and to watch an animated preview of them.
The following setting options are available on the **Template** tab of the **Nero PiP Effects** window:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Template selection</strong></td>
<td>Displays the available <strong>Nero Picture in Picture Effect templates</strong> and allows you to choose one. The templates are divided according to the number of elements, i.e. placeholders, within the respective template.</td>
</tr>
<tr>
<td><strong>Preview</strong></td>
<td>Displays an animated preview of the <strong>Nero Picture in Picture Effect template</strong> you have selected in the template selection area.</td>
</tr>
<tr>
<td><strong>Choose background</strong></td>
<td>Displays the available backgrounds for the <strong>Nero Picture in Picture Effect template</strong> you have selected in the template selection area and allows you to choose one. Only available if backgrounds are available for the selected <strong>Nero Picture in Picture Effect template</strong>.</td>
</tr>
</tbody>
</table>
On the **Settings** tab of the *Nero PiP Effects* window, you can define the insert setting options for the *Nero Picture in Picture Effect templates*.

![Nero PiP Effects window](image)

The following option buttons are available on the **Settings** tab:

<table>
<thead>
<tr>
<th>Duration/Insert mode</th>
<th>Includes the <strong>Duration</strong> input field and the <strong>Insert mode</strong> drop-down menu. The <strong>Duration</strong> input field allows you to define the duration of the selected <em>Nero Picture in Picture Effect template</em>. Every <em>Nero Picture in Picture Effect template</em> has a default and a minimum duration. The <strong>Insert mode</strong> drop-down menu allows you to choose between three insert setting options. They determine how the <em>Nero Picture in Picture Effect template</em> is inserted into the timeline. <strong>Use gap</strong>: This is the default setting. Inserts the template into the gap to the right of the time cursor. Only available if the gap has at least the length of the template you want to insert. <strong>Overwrite</strong>: Inserts the template according to the duration you have selected, without adjusting its length to the gap. If the template is longer than the gap to the right of the time cursor, the video/audio/picture files or parts of the video/audio/picture files to the right of the template are overwritten by the template. <strong>Shift</strong>: Shifts the video/audio/picture files to the right of the time cursor and positions it after the template.</th>
</tr>
</thead>
</table>
4.1.10 Movie Wizard

In the Themes window you can choose files and set up basic editing options for your movie. The window is opened when you click the Themes button in the upper right of the content area in the Video Editing screen.

Some of the functions mentioned here are restricted or not available in the Essentials version. You can always upgrade your Essentials version at www.nero.com to get the full version with all the functions.

For each Movie ThemePack, a separate installer is provided on the Nero Web site as an additional and separate download. If your application does not already include all available MovieThemePacks, these packs can be easily added to your installation. Simply click the More Themes button to be redirected to the Nero Web site which allows you to download the additional Movie ThemePack installers.

The Nero Movie ThemePack 3 and the Nero Movie ThemePack 4 are available as single add-ons or with the Nero Creative CollectionPack 1 which is included in the Nero Multimedia Suite Platinum HD and Nero Video Premium HD. If you have Nero Vision Xtra or the standard Nero Multimedia Suite installed, the Nero Creative CollectionPack 1 including the Nero Movie ThemePack 3 and the Nero Movie ThemePack 4 is not part of Nero Vision. You can always obtain the Nero Multimedia Suite Platinum HD, Nero Video Premium HD, the Nero Movie ThemePack 3, the Nero Movie ThemePack 4 or the Nero Creative CollectionPack 1 at www.nero.com.
A list of categories and respective templates is available on the left. The category palettes can be expanded to display the templates in a thumbnail view. By default, the wizard chooses the first template of the first category which is not listed in the Basic category. Of course, if Basic is your only template category, the first basic template is set by default.

Additionally, the following setting options are available in the Titles area on the right:

<table>
<thead>
<tr>
<th>Input field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Opening title</strong></td>
<td>Shows the default text for the intro title of the selected template. You can modify the text. Other text attributes such as font and alignment are defined by the template and cannot be modified. In case the selected template does not contain an intro section, the input field is grayed.</td>
</tr>
<tr>
<td><strong>Closing title</strong></td>
<td>Shows the default text for the outro text of the selected template. You can modify the text. In contrast to the intro text, line breaks are allowed. Other text attributes such as font and alignment are defined by the template and cannot be modified. In case the selected template does not contain an outro section, the input field is grayed.</td>
</tr>
</tbody>
</table>
The following setting options are available in the **Modify Original Movie** area on the right:

<table>
<thead>
<tr>
<th>Check box</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Apply Pan &amp; Zoom effects to still pictures</strong></td>
<td>Enables Pan &amp; Zoom effects for slides. If disabled, the wizard ignores Pan &amp; Zoom effects. If the selected template does not contain an <strong>Pan &amp; Zoom</strong> effect group or a <strong>Pan &amp; Zoom</strong> effect for still pictures, the check box remains gray.</td>
</tr>
<tr>
<td><strong>Apply scene detection to video clips</strong></td>
<td>Runs a scene detection before applying the selected theme. If disabled, no scene detection is performed. The check box is cleared by default.</td>
</tr>
</tbody>
</table>

The following setting options are available in the **Music** area on the right:

<table>
<thead>
<tr>
<th>Check box</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Apply theme music</strong></td>
<td>If the check box is selected, the music files defined in the template are added to the content area. If the check box is cleared, the Movie Wizard does not add the template music to your project. If the selected template does not contain theme music, this check box as well as the balance slider underneath are grayed. The check box is cleared by default.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Slider</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Balance</strong></td>
<td>Specifies the volume level of the audio added by the template (such as intro and outro sounds) in contrast to the volume level of all other audio tracks which are already available in the timeline. If you do not move the slider, both <strong>Music</strong> and <strong>My Clips</strong> have the same audio level.</td>
</tr>
</tbody>
</table>

### 4.1.11 Ad Spotter Window

In the **Ad Spotter** window all settings can be defined for Nero Vision to be able to search for advertising spots in your captured files and to remove them directly from the compilation.

Carry out the desired settings in the left top **Settings** area. The **Sensitivity** slider defines the sensitivity of the auto recognition. A higher sensitivity has the result that also small indications to advertising sequences in the video are also recognized as hits and are then shown in the results. The found movie and advertising sequences are shown on a film strip. The advertising sequences have a red border.
At the top right of the window, sequences that are found can be tentatively played back in the preview area and detailed corrections can be undertaken.

In the preview area, with the aid of the position marker on the scroll bar, you can move to a specific position within the video title. You can also use the **Position** buttons next to the time code display. Start and end markings appear for the found advertising and movie sequences. Furthermore, the following buttons are available:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>[ ]</td>
<td>Starts playback.</td>
</tr>
<tr>
<td>[ ]</td>
<td>Pauses playback.</td>
</tr>
<tr>
<td>[ ]</td>
<td>Stops playback.</td>
</tr>
<tr>
<td>[ ]</td>
<td>Shortens the video sequence by removing the part between the start and the position marking or the position and the end marking. You can also customize the video sequence by moving the start and end markings on the scroll bar. This item is only displayed if you have placed the position mark on the scroll bar. Otherwise a gray button is shown.</td>
</tr>
</tbody>
</table>
In addition, the following setting options are available in the window:

<table>
<thead>
<tr>
<th>Button</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Start</strong></td>
<td>Starts the search in the selected video.</td>
</tr>
<tr>
<td><strong>Combine</strong></td>
<td>If the check box is selected, then all the found advertising sequences are compiled into one sequence. This also applies to the movie sequences.</td>
</tr>
<tr>
<td><strong>Generate</strong></td>
<td>Inserts the video without the advertising sequences back into its desired place in the compilation.</td>
</tr>
<tr>
<td><strong>Cancel</strong></td>
<td>Cancels the procedure and closes the window.</td>
</tr>
</tbody>
</table>

See also

Video Editing Screen → 37

### 4.1.12 Music Grabber Window

In the **Music Grabber** window all settings for identifying music clips in movies can be selected. Recognized clips can be inserted into the compilation or can be saved as a pure audio file that is separate from the video. In the saving, Nero Vision supports the WAV and MP3 formats.

Define your desired settings in the **Settings** area in the top left area. The **Sensitivity** slider defines the sensitivity of the auto recognition. A higher sensitivity has the result that also small indications to music clips will be recognized as hits and shown as results. The found music sequences are shown on a film strip. At the top right in the preview area, found sequences can be played back and, if necessary, detailed corrections can be carried out.
In the preview area with the aid of the position marker on the scroll bar you can move to a specific position within the video title. You can also use the **Position** buttons next to the time code display. A start and end marking is shown on the picture list of the preview area for each found music clip. Furthermore, the following buttons are available:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="start-icon.png" alt="Start" /></td>
<td>Starts playback.</td>
</tr>
<tr>
<td><img src="pause-icon.png" alt="Pause" /></td>
<td>Pauses playback.</td>
</tr>
<tr>
<td><img src="stop-icon.png" alt="Stop" /></td>
<td>Stops playback.</td>
</tr>
<tr>
<td><img src="shorten-icon.png" alt="Shorten" /></td>
<td>Shortens the music clip between the start and position markings or the position and the end markings. The music clip can also be customized by moving the start and end markings on the scroll bar. This item is only displayed if the position marking is placed on the picture scroll bar. Otherwise a gray button is shown.</td>
</tr>
</tbody>
</table>

Additionally, the following buttons are available in the window:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Start</strong></td>
<td>Starts the search in the selected video.</td>
</tr>
<tr>
<td><strong>Add to project</strong></td>
<td>Cuts out found sequences from the whole movie and inserts the desired music clips into the compilation.</td>
</tr>
</tbody>
</table>
## Save to file(s)
Saves desired music clips as pure audio files. In the saving, Nero Vision supports WAV, MP3, WMA, and Ogg formats.

| Cancel | Cancels the procedure and closes the window. |

**See also**
- Video Editing Screen → 37

### 4.1.13 Movie Options Window

In the Movie Options window you can set up all settings for the timeline. When you click the Make > Movie or Slide Show button in the Content screen, the Movie Options window is opened automatically before the Video Editing screen is displayed according to the chosen settings.

In the Video Editing screen, you can reopen the Movie Options window to change the current setting options by clicking the Timeline Options button in the upper right of the content area. Please consider that the timeline is adapted to your changes.
Various setting options are provided on the left. A summary of the selected settings is shown in an Information display on the right. The following setting options are available:

<table>
<thead>
<tr>
<th>Input field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Movie name</td>
<td>Defines or changes the name of the movie which is used as the title name in the Content screen and which is visible on buttons in the menu when burning the movie to a disc.</td>
</tr>
<tr>
<td>Video format</td>
<td>Shows the status of the video mode. With help of the video mode, the color transmission system is specifically defined. This guarantees that videos can be displayed on the existing playback devices. The setting is always selected according to the current setting of the video format in the Recording Format Options window (General tab). You cannot change it here.</td>
</tr>
<tr>
<td>Resolution</td>
<td>Selects the resolution from a list of possible resolutions and defines the resolution of the resulting video.</td>
</tr>
<tr>
<td>Audio</td>
<td>Chooses which audio format is used. The Stereo (2 Channel) option button is selected by default.</td>
</tr>
</tbody>
</table>

Clicking the Advanced Settings button in the lower left of the screen opens the Advanced Timeline Settings window. You should only change the expert settings if you are sufficiently familiar with this area of video encoding. The Advanced Settings button is only available for changes; it is not available for the initial timeline set up.

4.1.14 Preview and Trim Window

Double-clicking any item in the media area or in the content area opens the Preview or Trim window. Two tabs are available in both windows. You can use the setting options in these windows to pre-trim or trim audio tracks and video clips as well as pictures in your timeline. On the Metadata tab information like file name, file size, or the storage path is displayed. Depending on the media file type you selected, the setting options on the second tab are adapted accordingly. A preview or waveform view is available on all three item tabs. Click the OK button in the lower right to save the changes and close the window.
On the **Video** and **Audio** tab, you can shift the current position by dragging the timeline slider on the time scale. Clicking the buttons in the left-most and right-most position of the time scale moves the scale. You can set desired **Mark In** and **Mark Out** points by moving the respective buttons directly on the time scale or with help of the input fields below. Keep the button pressed and move the currently chosen length on the time scale to find the best cut from the full video or track.

The following setting options are available on the **Video** and **Audio** tab:

<table>
<thead>
<tr>
<th>Slider</th>
<th>Zoom</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Zooms into the time scale view or zooms out to give an overview.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Button</th>
<th>Jumps to the <strong>Mark In/Mark Out</strong> position on the time scale.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Button</td>
<td>Jumps to the next or previous frame.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
4.2 Making Movie

Some of the functions mentioned here are restricted or not available in the Essentials version. You can always upgrade your Essentials version at www.nero.com to get the full version with all the functions.

To make a movie or slide show, proceed as follows:

1. In the Start screen, select the Make Movie or Slide Show option.

   → The Movie Options window is opened.
If you are in the Content screen and want to create a movie or slide show for your project, click the Make > Movie or Slide Show button.

2. Enter a video title in the Movie name input field.
   - The name is used as the title name in the Content screen and visible on buttons in the menu when burning the movie to a disc.

3. Choose the adequate settings options for the timeline and click the OK button.
   - The Video Editing screen is displayed according to the chosen settings. If media files are already available, they are displayed on the My Media palette in the media area at the top right.

4. If you want to add media files that are on your computer, click the Import > Import Files entry in the upper right of the My Media palette.
   - A window is opened.

5. Select the required media files and click the Open button.
   - The files are added to the media area. For a better overview, different media types are automatically arranged in single tabs.

6. Select video files that you want to add to your movie and drag them from the Videos tab to required positions on the timeline.

7. Select photos that you want to add to your movie or slide show and drag them from the Pictures tab to the required positions on the timeline.
   - Video files and photos are added to the content area.

8. If you want to add background music to your movie or slide show, drag audio files from the Audio tab on the My Media palette to the required position on the timeline.

   With two pure sound tracks, you can also place several audio files on top of one another in Nero Vision. For example, a commentary can be provided on the Narration track while music plays simultaneously on the Music track.

   If you want to add transitions between individual media files or add narrations, effects, or text effects to your compilation, follow the detailed descriptions in the respective subchapters.

9. If you are satisfied with the movie or slide show, click the Next button in the lower right corner of the main window. You can examine the status of your composition in the preview area at any time.
   - The Content screen is displayed.
   - You have made a movie or slide show and can now add additional titles to your project or create a menu.

See also
- Video Editing Screen → 37
- Detecting Commercials → 66
- Searching for Music Clips → 67
4.2.1 Detecting Commercials

In Nero Vision it is possible to search for Web sequences in a captured file and to remove them directly from your compilation.

The following requirement has to be fulfilled:

► The desired video title is displayed in the Video Editing screen.

To search for Web sequences and to remove them from your movie, proceed as follows:

1. Select the respective title in the timeline.

2. Click the Movie Detection > Ad Spotter button.
   ➔ The Ad Spotter window is opened.

3. If you wish to increase the sensitivity of your auto-recognition (High) or reduce it (Low), customize the slider.

4. Click the Start button.
   ➔ The video file is searched for Web sequences.
   ➔ The number of found Web sequences is shown above the film strip. The individual film and Web sequences are highlighted on the film strip. The Web sequences have a red border. On the scroll bar in the preview area the individual sequence start and end markings are also shown. Here, detailed corrections can be carried out if necessary.

5. Click the Generate button.
   ➔ The video title is inserted without the Web sequences again in the desired position in the compilation.
   ➔ You have removed the Web sequences from your movie.

See also

► Making Movie → 64
► Ad Spotter Window → 57
4.2.2 Searching for Music Clips

In Nero Vision you can search for music clips in a captured file. Recognized clips can be added to your compilation or saved separately from the video as a pure audio file. In the saving, Nero Vision supports the WAV and MP3 formats.

The following requirement has to be fulfilled:

► The desired video title is displayed in the Video Editing screen.

To search for music clips in a captured file, proceed as follows:

1. Click the Movie Detection > Music Grabber button.
   ➔ The Music Grabber window is opened.

2. If you wish to increase the sensitivity of your auto-recognition (High) or reduce it (Low), customize the slider.

3. Click the Start button.
   ➔ The video file is searched for music clips.
   ➔ The number of music clips is shown above the film strip. The individual music clips are highlighted on the film strip. On the scroll bar in the preview area the individual sequence start and end markings are also shown. Here, detailed corrections can be carried out if necessary.

4. If you wish to incorporate the found music clips into your compilation, click the Add to project button.
   ➔ The found sequences will be cut out and inserted into your compilation.

5. If you wish to save the music clips as pure audio files:
   1. Click the Save to file(s) button and select the desired format.
      ➔ A browser window is opened.
   2. In the displayed directory tree select the desired storage location and click the OK button.
      ➔ The audio file is exported and saved.
      ➔ You have searched for music clips in a capture file.

See also

Making Movie → 64
Movie Options Window → 61

4.2.3 Detecting Video Scenes

The following requirement has to be fulfilled:

► The desired video title is displayed in the Video Editing screen.

To detect scenes in a video clip, proceed as follows:

1. Select the desired video file in the timeline.

2. Click the Movie Detection > Scene Detection button.
   ➔ The Scene Detection window is opened. The chosen video file is analyzed. The number of detected scenes is displayed in the Results area of the window.
3. If you want to change the sensitivity settings of the analysis:
   1. Move the Sensitivity slider to a higher or lower percentage.
   2. Move the Minimum Scene Length slider to a shorter or longer scene length setting.
      → The number of detected scenes is adapted to your settings.

4. Click the Apply button.
   → The clip in the timeline is cut into single scenes.
   → You have detected scenes in a video clip and can now edit the independent scenes.

See also
Making Movie → 64

4.2.4 Moving and Positioning Files

Some of the functions mentioned here are restricted or not available in the Essentials version. You can always upgrade your Essentials version at www.nero.com to get the full version with all the functions.

The following requirements must be fulfilled:
▶ The desired files are displayed in the Video Editing screen.

To move and reposition single video clips, pictures, narration or background music files in the content area, proceed as follows:

1. If you want to reposition a video clip or picture on the Storyboard tab:
   1. Drag the selected file on the timeline.
      → While dragging, a slim time cursor shows where the file will be positioned when you drop it. The timeline on the Storyboard tab moves back or forth when you drag the file to the border area.
   2. Drop the file to the desired position.
      → The file is repositioned.

2. If you want to move a narration or background music file on the Storyboard tab:
   1. Drag the selected file on the timeline.
      → The timeline on the Storyboard tab moves back or forth when you drag the file to the border area. You can also move the file from the Narration down to a position on the Music track and vice versa.
   2. Drop the file to the desired position.
      → The file is repositioned.

You cannot move transitions or effects on the Storyboard tab. Please use the Timeline tab for a more detailed view and editing mode.
3. If you want to reposition a video clip, picture, narration or background music file on the Timeline tab:

1. Drag the selected file on the timeline.
   ➔ When you drag a clip from the media area to a track in the timeline, the clip’s duration is displayed. The duration is determined by the timescale setting - the opacity setting is set to 50% so that the objects underneath are visible. The preview area in the upper left of the Video Editing screen temporarily shows the frame at the position of the insert marker instead of the frame of the timeline slider.
   ➔ The catch marker aligns a dragged clip to another in the timeline if the clip’s border hovers an area within 10 dots left or right to the border of the other. You can align dragged clips to clips in other tracks, too.
   ➔ The timeline on the Timeline tab moves back or forth when you drag the file to the border area. You can also move the file from one track to another.

2. Drop the file to the desired position.
   ➔ The file is repositioned.
   
   If necessary, the width of a dragged clip is adjusted according to fit into the gap in which it is dropped to. In this case, the end of the clip is truncated.

   To fit a clip into a gap without cutting it, keep the Shift key on your keyboard pressed while dropping the clip. All objects in all tracks right to the position of the insert marker are shifted to the right. The offset is according to the duration of the dropped clip.

   This way it is also possible to divide a timeline clip by dropping a new clip in the middle of the existing clip. The right part is shifted to the right together with all other track objects to the right of the insert marker.

   If you want to detach the link of a video clip to its audio file to edit or move them independently, click the Unlink Audio & Video entry in the context menu.

   ➔ You have arranged all video clips, pictures, narration, or background music files in your compilation. You can now also customize the specific properties of selected effects or add a theme based template.

See also

Making Movie → 64

4.2.5 Cutting and Trimming Audio and Video Clips

When cutting or trimming audio or video files in Nero Vision, the original is not changed; instead the cut information is stored in the project.

The following requirement has to be fulfilled:

► The desired files are displayed in the Video Editing screen.

To cut or trim an audio or video title, proceed as follows:

1. If you want to cut a clip:

   1. Select the respective file on the Timeline tab in the content area.
2. Click the button in the right border area of the Timeline tab.
   ➔ The standard mouse cursor changes into a cutter.
3. Move the mouse cursor or cutter to the desired cutting position on the timeline.
   ➔ In case of video clips, the exact cutting position is displayed in the preview area.
4. Click the left mouse button.
   ➔ The file is cut at the desired position. Both parts are listed in the content area.
5. Click the Standard tool button in the right border area of the Timeline tab to change back to the standard mouse cursor.

2. If you want to trim a clip at the start or end:
   1. Select the respective file on the Timeline tab in the content area.
   2. Move the mouse cursor over the left (start) or right (end) border area of the file.
      ➔ The icon is displayed.
   3. Keep the left mouse button pressed and shorten the file by dragging the mouse.
      ➔ In case of video clips, the exact trimming position is displayed in the preview area.
   4. Release the mouse button at the desired position.
      ➔ The file is trimmed according to your requirements.

Trimmed parts in your clips are temporarily disabled. If you want to enable a trimmed part again, simply drag back the file to its full size.

Double-click any file to open a Trim window in which you can trim the item on an exact frame by frame basis.

➔ You have cut or trimmed an audio or video title.

See also

Making Movie → 64
Preview and Trim Window → 62

4.2.6 Fitting the Display Duration of Pictures

You can adjust the display time for the pictures of a compilation or slide show as desired. You can specify a default display time for still pictures, effects, and transitions that you add to the compilation in the Default Duration Values area of the Application Settings window. In addition, you can adjust the display time of the pictures already added to the contents area to this new default value.

The following requirement must be fulfilled:

➤ The desired files are displayed in the Video Editing screen.

To adjust the display duration of single or multiple pictures in a compilation, proceed as follows:

1. If you want to adjust the display duration of a single picture, select the respective item in the timeline.
2. If you want to adjust the display duration of selected pictures, keep pressing the Ctrl key on your keyboard pressed and select all respective items in the timeline.

3. If you want to adjust the display duration of your slide show compilation in a timeline track:
   1. Click the Select track tool in the right border area of the Timeline tab.
      ➔ All clips in the track are selected.

4. Click the Duration button.
   ➔ The Duration window is opened.

   Additionally to the duration itself, you can choose between three insert settings options. The Shift entry is selected by default. All items to the right of your selected picture are shifted to the right. The Overwrite entry adapts the display duration without moving the following items in the timeline. (If no items are available to the right, the entry remains gray.) The Use Gap entry adapts the duration by filling the gap between the selected and the following item in the timeline. (As long as no gap is left, the entry remains gray.)

5. Enter the required display duration in the Duration input field.

6. Click the OK button.
   ➔ The display duration is adapted in the timeline.
   ➔ You have adjusted the display duration of single or multiple pictures in a compilation.

See also
   ◄ Making Movie → 64

4.2.7 Inserting Nero Picture in Picture Templates

With the Nero Picture in Picture Effects feature, you can insert Nero Picture in Picture Effect templates into the timeline.

The Nero PiP EffectPack 1 is available as a single add-on or with the Nero Creative CollectionPack 1 which is included in the Nero Multimedia Suite Platinum HD and Nero Video Premium HD. If you have Nero Vision Xtra or the standard Nero Multimedia Suite installed, the Nero Creative CollectionPack 1 including the Nero PiP EffectPack 1 is not part of Nero Vision. You can always obtain the Nero Multimedia Suite Platinum HD, Nero Video Premium HD, the Nero PiP EffectPack 1 or the Nero Creative CollectionPack 1 at www.nero.com.

The following requirement has to be fulfilled:

► The Video Editing screen is displayed.

To insert a Nero Picture in Picture Effect template into the timeline, proceed as follows:

1. Click the Nero PiP button.
   ➔ The Nero PiP Effects window is opened with the Template tab being displayed.

2. Select the desired template in the template selection area on the left side of the window.
Editing Videos

→ An animated preview of the selected template is displayed on the right side of the window.

3. If backgrounds are available for the selected template, select the desired background in the Background drop-down menu.

4. To change the duration or the insert settings for the selected template, click the Settings tab.
   1. If you want to change the duration and insert settings manually, select the Duration / Insert mode option button.
   2. Enter the desired duration value in the Duration input field and select the desired insert setting option in the Insert mode drop-down menu.
   3. If you want Nero Vision to automatically calculate the duration of the template, select the Auto fill gap option button.

5. Click the OK button.
   → The Nero Picture in Picture Effect template is inserted in the timeline. You can now replace the placeholders with the desired video and picture files by dragging them from the My Media palette and dropping them onto the respective placeholders.

See also
   ‡ Nero Picture in Picture (PiP) Effects → 52
   ‡ Nero PiP Effects Window → 52

4.2.8 Choosing a Movie Template

In the Themes window you can choose files and set up basic editing options for your movie. You will find templates for various themes such as birthday or wedding. Each template amends your project with a theme-based intro and outro video and automatically inserts various suitable (text) effects, transitions and background music into the content area.

Some of the functions mentioned here are restricted or not available in the Essentials version. You can always upgrade your Essentials version at www.nero.com to get the full version with all the functions.

The following requirements have to be fulfilled:

► The Video Editing screen is displayed.
► You have inserted at least one video title into the content area.

To use a theme-based template, proceed as follows:

1. Click the Themes button.
   → The Themes window is opened. A list of categories and respective templates is available on the left. The category palettes can be expanded to display the templates in a thumbnail view.

2. Select the desired theme on the left.

3. Add your desired intro title in the Opening title input field on the left. Other text attributes such as font and alignment are defined by the template and cannot be modified.
4. Add your desired outro title in the **Closing title** input field on the left. In case the selected template does not contain an intro or outro section, the input fields are grayed.

5. If you want to add music files that are defined in the template to the content area, select the **Apply theme music** check box in the **Music** area.

6. Move the **Balance** slider to adjust the volume level of the audio tracks added by the template in contrast to all other audio tracks available in the timeline.

7. Click the **OK** button.
   - The items of the theme-based template as well as the intro and outro video are inserted into the content area.
   - You have selected a theme-based template.

**See also**

- Making Movie → 64
- Movie Wizard → 55

4.2.9 Inserting Transitions

Transitions can be used to link the individual video clips or pictures that were added to a compilation.

Some of the functions mentioned here are only available in the Nero Creative CollectionPack 1 which is part of the Nero Multimedia Suite Platinum HD and Nero Video Premium HD.

You can always obtain the Nero Creative CollectionPack 1, the Nero Multimedia Suite Platinum HD, and Nero Video Premium HD at [www.nero.com](http://www.nero.com).

Some of the functions mentioned here are restricted or not available in the Essentials version. You can always upgrade your Essentials version at [www.nero.com](http://www.nero.com) to get the full version with all the functions.

The following requirement has to be fulfilled:

- The desired files are displayed in the **Video Editing** screen.

To insert a transition, proceed as follows:

1. Click the **Transition** tab on the **Effect Palette**.
   - The categories of transitions are listed on the left of the tab.

2. Choose a desired category of transitions on the left of the tab.
   - The transition types of the selected group are displayed.

3. If you edit your compilation in the **Storyboard** view of the content area, drag the desired transition from the **Effect Palette** to the respective placeholder between two clips.
   - Media files with transitions are identified in the content area by a colored icon. Media files without a transition are indicated in the content area by a gray icon.
4. If you edit your compilation in the **Timeline** view of the content area, drag the desired transition from the **Effect Palette** onto the respective clip.

- The transition is added in front of the selected file in the content area.
- You have inserted a transition.

**See also**

Making Movie → 64

### 4.2.10 Editing Transitions

Transitions can be used to link the individual video clips or pictures that were added to a compilation.

Some of the functions mentioned here are restricted or not available in the Essentials version. You can always upgrade your Essentials version at [www.nero.com](http://www.nero.com) to get the full version with all the functions.

The following requirement must be fulfilled:

- The desired transition is added in front of a selected file in the content area of the **Video Editing** screen.

To edit the properties of a transition in a project, proceed as follows:

1. Select the transition in the content area.

   ![Light Bulb Icon]
   
   If you want to simply remove a selected transition, press the **Del** key on your keyboard.

2. Click the **Properties** palette.

3. Click the button at the left side of the transition's headline.

   - An extended area is expanded which shows the respective transition's setting options. The duration is set to one second by default but it can be adapted to your specific needs.

4. If you want to adapt the duration of the transition, insert the desired length into the **Duration** input field.

   - A transition is centered between two clips by default but it is possible to move it.

5. If you want to change the alignment more to the left (end at cut) or right (start at cut), click the respective button in the transition's headline.

6. Adapt the respective transition's settings in the expanded area to your requirements.

   - The changes are adjusted in the content area.
   - You have edited the properties of a transition in your project.

**See also**

Making Movie → 64
4.2.11 Adding an Effect

You can overlay the added video titles or pictures of a compilation with effects. Depending on the selected effect, you can customize properties such as intensity and speed.

Some of the functions mentioned here are restricted or not available in the Essentials version. You can always upgrade your Essentials version at www.nero.com to get the full version with all the functions.

The following requirement has to be fulfilled:

► The desired files are displayed in the Video Editing screen.

To add effects to your compilation, proceed as follows:

1. Click the Effects tab on the Effect Palette.
   - The categories of effects are listed on the left of the tab.

2. Choose a desired category of effects on the left of the tab.
   - The effect types of the selected group are displayed.

3. If you edit your compilation in the Storyboard view of the content area, drag the desired effect from the Effect Palette to the respective video clip or picture on the timeline.
   - The effect is added to the selected file in the content area. Media files with effects are indicated by a FX icon on the Storyboard tab.
   - All additional effects of a clip are listed below the basic effects in the lower area of the Properties palette. You can customize the specific properties of the effects here.

4. If you edit your compilation in the Timeline view of the content area, drag the desired effect from the Effect Palette to the respective video clip or picture on the timeline.
   - The effect is added to the selected file in the content area.
   - All additional effects of a clip are listed below the basic effects in the lower area of the Properties palette. You can customize the specific properties of the effects here.

A Master Effects track is also available on the Timeline tab. Effects applied to this track are always rendered to the resulting video output of all tracks.

To add a master effect, simply position a desired effect on the Master Effects track (like you would add any video clip to the timeline) and customize it like other effects.

► You have added effects to your compilation.

See also

► Making Movie → 64
4.2.12 Editing Effects

Some of the functions mentioned here are restricted or not available in the Essentials version. You can always upgrade your Essentials version at www.nero.com to get the full version with all the functions.

The basic effects of video clips, pictures or audio files and the additional effects you added are customized the same way.

The following requirement must be fulfilled:

► The desired files are displayed in the Video Editing screen.

To customize the properties of single effects, proceed as follows:

1. Select the file with the respective effect you want to edit in the content area.

2. Click the Properties palette.
   - The list of basic effects and all additional effects added to the file displayed. Effects are rendered top to bottom, you can modify the order of optional effects per the drag-and-drop function.
   - As long as you have not chosen individual key frame positions on a track, the effect settings are valid for the whole clip.

3. If you want to create single key frames that will only enable the effect settings for those positions that were chosen:
   1. Select the Use key frames check box in the effect's headline.
      - A key frames track is displayed below the respective main clip on the Timeline tab in the content area. Additional controls are displayed next to the check box on the Properties tab in the media area.
   2. Position the timeline slider on the timeline and click the Create key frame button to add a single key frame.
      - The key frame is displayed on the key frames track.
   3. Repeat the previous step to add more key frames.

   If you want to delete an existing key frame, select the respective key frame and click the Delete key frame button. Use the buttons to the left and right (Go to the previous key frame / Go to the next key frame) to navigate from key frame to key frame.

4. If you want to (temporarily) disable an additional effect in your compilation, disable the option button left of the effect's name in the headline. Enable the option button once more to activate the effect again.

5. Click the button at the left side of any effect's headline.
   - An extended area is expanded which shows the effect's individual setting options.

6. Adapt the respective effect's settings in the expanded area to your requirements.
   - The changes are adjusted in the content area.
4.2.13 Adding a Text Effect

You can overlay the added video titles or pictures of a compilation with text effects. Depending on the text effect selected, you can customize the various detail settings.

Some of the functions mentioned here are restricted or not available in the Essentials version. You can always upgrade your Essentials version at www.nero.com to get the full version with all the functions.

A Master Effects track is also available on the Timeline tab. Effects applied to this track are always rendered to the resulting video output of all tracks. To add a master effect, simply position a desired effect on the Master Effects track (like you would add any video clip to the timeline) and customize it like other effects.

The following requirement has to be fulfilled:

- The Video Editing screen is displayed.

To add a text effect to your compilation, proceed as follows:

1. Click the Text tab on the Effect Palette.
   - The categories of text effects are listed on the left of the tab.

2. Choose a desired category of text effects on the left of the tab.
   - The text effect types of the selected group are displayed.

3. Drag the desired text effect from the Effect Palette to a video track on the timeline. You can position the effect in the content area to run parallel with a specific clip.
   - The text effect is added to the content area.

4. Click the button at the left side of the Text headline on the Properties palette.
   - An extended area is expanded which shows the setting options for the respective text effect.

5. Enter the required text in the Text input field.

6. Make any additional settings as required depending on the selected effect.
   - The text effect is adjusted to your requirements.

7. If you want to change the duration or position of your text effect, proceed as described in the Moving clips chapter.
   - You have added a text effect to your compilation.

See also

Making Movie → 64
4.2.14 Recording a Narration File

You can record your report for single clips in the content area. By default, the narration is recorded to the Narration track at the position of the timeline slider, but it can be moved to any free audio track position.

The following requirement must be fulfilled:

▶ The Video Editing screen is displayed.

To record an audio comment and add it to your project, proceed as follows:

1. Move the timeline slider to the desired position on the timeline.
2. Click the Record Audio button.
   ▶ The Audio Recording Settings window is opened.
3. If you want to change the storage location or need to change the device settings for the audio input, make all preparations for the recording now.
4. Click the OK button.
   ▶ The recording starts.
5. Record your speech.
   ▶ You can see the recording time in the lower right of the progress window.
6. Click the button to stop recording.
   ▶ A window informs you about the successful creation and saving of the audio file.
7. Click the OK button.
   ▶ The record is added to the timeline.
   ▶ You have recorded an audio comment and added it to your project.

See also

‡ Making Movie → 64

4.2.15 Creating Chapters in Timeline

You can manually add chapters to the content area of your compilation. You can edit and rename chapters as well as reposition or remove individual chapter markings.

The following requirement has to be fulfilled:

▶ The Video Editing screen is displayed.

To create and edit chapters, proceed as follows:

1. Position the timeline slider on the timeline and click the Create Chapter Marker button in the right border area of the Timeline tab.
   ▶ A position marker for a new chapter is displayed above the time scale on the Timeline tab.
2. Repeat the previous step to add more chapters.
   ▶ A position marker is added for each chapter. If you add chapters between existing ones, the consecutive numbering is adapted.
3. If you want to move an existing chapter, select the respective position marker and drag it to the required position. Use the buttons to the left and right (Go to the previous chapter marker / Go to the next chapter marker) to navigate from chapter to chapter.
   ➞ The chapter is moved to the required position. You can move the position of the individual chapter markers within the compilation up to the next chapter mark.

4. If you want to rename an existing chapter:
   1. Double-click the respective position marker on the timeline.
      ➞ The chapter name display is changed into an input field.
   2. Enter the desired chapter name.
      ➞ The chapter is renamed.

   An additional Rename Chapter Marker entry is available via the context menu.

5. If you want to delete a chapter, select the respective position marker and click the Delete Chapter Marker button. Use the buttons to the left and right (Go to the previous chapter marker / Go to the next chapter marker) to navigate from chapter to chapter.
   ➞ The chapter is deleted.

   An additional Delete all Chapter Markers entry is available via the context menu.

   ➞ You have created and edited the chapters.

See also
   ▼ Making Movie → 64
5 Exporting Videos

5.1 Export Video Screen

The Export Video screen is displayed when you click the Export button in the lower task bar of the main window. It can be divided into three areas: the preview area for playing the movie back, a selection area to the right of that, which lists the export options, and the Format and Profile drop-down menus in the area below that.

All data that results for the output file is displayed in the Output file area. You can click the Browse button to select the storage location for the output file. Adapted format and profile drop-down menus are available for each export option. Click the Configure button to open a window to adjust the detail settings.

Depending on the export template chosen, the output format, aspect ratio, quality settings, bit rate, resolution, encoding mode and/or audio quality will change.

The following export options are available in the selection area:

<table>
<thead>
<tr>
<th>Export video to file</th>
<th>Exports a movie to a video file.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export audio to file</td>
<td>Exports the audio track from a video to an audio file. The WMA, WAV, and Ogg formats are available. The exported audio file can be edited externally and re-imported into Nero Vision.</td>
</tr>
</tbody>
</table>
### Exporting Videos

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export video to camera</td>
<td>Exports a movie to a tape in the camera. Nero Vision automatically sets all parameters according to the attached camera and the <strong>Format</strong> and <strong>Profile</strong> drop-down menus are not available. Only available if a camera is connected to your PC and is on.</td>
</tr>
<tr>
<td>Export to Web</td>
<td>Exports a movie to the Internet in a file size adjusted accordingly. Communities normally limit the maximum length of a video file to 10 minutes with a maximum file size of 100 MB. If the movie is too long, an error message is displayed and Nero Vision cancels the procedure.</td>
</tr>
<tr>
<td>Export video and send it as an e-mail attachment</td>
<td>Exports a movie, adjusted to an appropriate file size, to send as an e-mail attachment. The <strong>MPEG-1</strong> and <strong>MP4</strong> formats are available. You can choose between <strong>1 MB</strong>, <strong>2 MB</strong>, <strong>5 MB</strong> or <strong>Custom</strong>. The export file can be attached to a new e-mail from the default e-mail application or saved to the hard drive.</td>
</tr>
</tbody>
</table>

If you have selected the **Export video to file** export option, the following export templates are available:

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AVI</td>
<td>Contains all codecs provided by your operating system.</td>
</tr>
<tr>
<td>AVI (DV)</td>
<td><strong>AVI-DV type 1</strong> and <strong>2</strong></td>
</tr>
<tr>
<td>WMV</td>
<td><strong>Pocket PC</strong>; <strong>Broadband</strong>; <strong>Portable Device</strong>; <strong>DVD Quality</strong>; <strong>HD 720p</strong>; <strong>HD 1080p</strong> and <strong>HD 1080i</strong>&lt;br&gt;<strong>Custom</strong> - All parameters are set to a medium value but can be customized within the scope of the WMV play.</td>
</tr>
<tr>
<td>Flash Video</td>
<td>Flash Video (FLV)</td>
</tr>
<tr>
<td>MPEG-1</td>
<td><strong>VCD compatible</strong> - All parameters in the video options are predefined and cannot be changed, with the exception of the frame rate.&lt;br&gt;<strong>Custom</strong> - All parameters are predefined in accordance with VCD, but can be customized within the capabilities of the MPEG-1 format.</td>
</tr>
<tr>
<td>MPEG-2</td>
<td><strong>DVD-Video compatible</strong> and <strong>SVCD compatible</strong>&lt;br&gt;<strong>HDV HD1</strong>; <strong>HDV HD2 (1080i)</strong>; <strong>HDTV 1080i</strong>, <strong>Editable Blu-ray Disc compatible</strong>&lt;br&gt;<strong>Custom</strong> - All parameters are predefined in accordance with DVD-Video.&lt;br&gt;The parameters of all profiles are predefined and can be customized within the capabilities of the MPEG-2 format.</td>
</tr>
</tbody>
</table>
5.2 Exporting Video to File

In the Export Video screen, you have various options for exporting a movie that you created in Nero Vision in addition to burning it to disc.

The following requirement has to be fulfilled:

► The Content or Video Editing screen is displayed.

To export a movie as a file to the hard drive, proceed as follows:

1. Click the Export button in the lower task bar of the main window.
   → The Export Video screen is displayed.

   In the What would you like to do next? selection, choose the Export Movie option.

See also

- Exporting Video to File → 82
- Exporting Video to Camera → 83
- Exporting Video and Send as E-Mail → 84
- Exporting Audio to File → 85
- Exporting to Web → 86
2. Select the **Export video to file** export option in the selection area.
   ➔ The drop-down menus for output format and profile are displayed accordingly.

3. Select the required format in the **Format** drop-down menu and the required profile in the **Profile** drop-down menu.
   ➔ The selected export template primarily specifies the output type and playback quality.

4. If you want to make changes to the export settings:
   1. Click the **Configure** button.
      ➔ A window is opened.
   2. Make the required changes and click the **OK** button.

5. If you want to save the video to another folder and/or under a name other than the name displayed in the **Output File** display panel:
   1. Click the **Browse** button.
      ➔ The **Select a location for the video file** window is opened.
   2. Select the desired folder in the **Location** drop-down menu.
   3. Enter the desired file name in the **File Name** input field and click the **Save** button.

6. Click the **Export** button.
   ➔ The export starts. Progress while exporting is displayed in the same window. Once the export is complete, a window is opened.

7. Click the **OK** button.
   ➔ Nero Vision automatically returns to the screen that was displayed before the export.
   ➔ You have exported a movie to the hard drive.

**See also**

Export Video Screen → 80

### 5.3 Exporting Video to Camera

In the **Export Video** screen, you have various options for exporting a movie that you created in Nero Vision in addition to burning it to disc.

This feature is only available if a camera is connected to your PC and is on. The camera must be in VCR mode.

The following requirements have to be fulfilled:

- The **Content** or **Video Editing** screen is displayed.

To export a movie to camera, proceed as follows:

1. Click the **Export** button.
   ➔ The **Export Video** screen is displayed.
In the What would you like to do next? selection, choose the Export Movie option.

2. Select the Export video to camera export option in the selection area.
   → The format is automatically adjusted to the camera connected.

3. Click the Export button.
   → The export starts. Progress while exporting is displayed in the same window. Once the export is complete, a window is opened.

4. Click the OK button.
   → Nero Vision automatically returns to the screen that was displayed before the export.
   → You have exported a movie to the camera.

See also

Export Video Screen → 80

5.4 Exporting Video and Send as E-Mail

In the Export Video screen, you have various options for exporting a movie that you created in Nero Vision in addition to burning it to disc.

The following requirement has to be fulfilled:

► The Content or Video Editing screen is displayed.

To export a movie to send via e-mail, proceed as follows:

1. Click the Export button.
   → The Export Video screen is displayed.

2. Select the Export video and send it as an e-mail attachment export option in the selection area.
   → The drop-down menus are displayed accordingly.

3. In the upper drop-down menu, select the required format.

4. In the bottom drop-down menu, select the required maximum file size.

5. If you want to make changes to the export settings:
   1. Click the Configure button.
      → A window is opened.
   2. Make the required changes and click the OK button.

6. If you want to save the video to another folder and/or under a name other than the name displayed in the Output File display panel:
   1. Click the Browse button.
      → The Select a storage location for the video file window is opened.
   2. Select the desired folder in the Location drop-down menu.
   3. Enter the desired file name in the File Name input field and click the Save button.
7. **Click the Export button.**

   → The export starts. Progress while exporting is displayed in the same window. Once the export is complete, a window is opened.

8. **Click the OK button.**

   → Nero Vision automatically returns to the screen that was displayed before the export.
   
   → You have exported a movie to send via e-mail.

**See also**

- Export Video Screen → 80

### 5.5 Exporting Audio to File

In the Export Video screen, you have various options for exporting a movie that you created in Nero Vision in addition to burning it to disc.

   The following requirement has to be fulfilled:

   - The **Content** or **Video Editing** screen is displayed.

To export a movie's audio track, proceed as follows:

1. **Click the Export button.**

   → The Export Video screen is displayed.

2. **Select the Export audio to file export option in the selection list.**

   → The drop-down menus for output format and profile are displayed accordingly.

3. **If you want to make changes to the export settings:**

   1. **Click the Configure button.**

      → A window is opened.

   2. Make the required changes and click the **OK** button.

4. **If you want to save the video to another folder and/or under a name other than the name displayed in the Output file display panel:**

   1. **Click the Browse button.**

      → The Select a storage location for the video file window is opened.

   2. Select the desired folder in the **Location** drop-down menu.

   3. Enter the desired file name in the **File Name** input field and click the **Save** button.

5. **Click the Export button.**

   → The export starts. Progress while exporting is displayed in the same window. Once the export is complete, a window is opened.

6. **Click the OK button.**

   → Nero Vision automatically returns to the screen that was displayed before the export.

   → You have exported a movie's audio track. The exported audio file can be edited externally and re-imported into Nero Vision.

**See also**

- Export Video Screen → 80
5.6 Exporting to Web

In the Export Video screen, you have various options for exporting a movie that you created in Nero Vision in addition to burning it to disc.

The following requirement has to be fulfilled:

► The Content or Video Editing screen is displayed.

To export a movie to the Internet, proceed as follows:

1. Click the Export button.
   → The Export Video screen is displayed.

2. Select the Export to Web export option in the selection area and click the Export button.
   → A window informs you that your video must now be converted to an export file.

   Communities normally limit the maximum length of a video file to 10 minutes with a maximum file size of 100 MB. If the movie is too long, an error message is displayed and Nero Vision cancels the procedure.

3. Click the Yes button.
   → The video is exported to a file. Progress is displayed in the same window.
   → When first importing to or exporting from the Internet, the My Nero Login window is opened. Here you can enter your access data for the My Nero Internet community once and then stay logged in for all subsequent visits via Nero Vision.

4. If, for the export to the Internet you wish to make use of the My Nero community:
   1. Enter your Login Name and Password for the My Nero Internet community in the input fields.
   2. Enable the Save account data check box and click the OK button.

5. If you do not want to make use of the My Nero community, click the Cancel button.
   → The Export to Internet window is opened. You can specify all information about the export file. The selected community appears in the drop-down menu at the bottom right.

   When starting the export feature, Nero checks whether new configuration files are available. A window informs you if there are any recommended or required updates.

6. If you want to upload to a community other than that displayed in the drop-down menu, select the required community in the Select Another Community drop-down menu.
   → The input fields of the selected community are displayed accordingly.

7. Enter a title and brief description of your video in the Title and Description input fields, as well as any other information depending on the selected community.

8. You must agree to the terms of use for the communities in order to upload files to My Nero and other communities. Select the appropriate check boxes at the bottom of the window.
The Upload button is enabled once you have made all the required entries.

9. Click the Upload button.
   → If you have not selected the My Nero community, the login window of the respective community opens.

10. Enter your Login Name and Password in the input fields and click the OK button.
    → The export starts. Progress while exporting is displayed in the same window. Nero Vision automatically returns to the screen that was displayed before the export.
    → You have exported a movie to the Internet.

See also
- Export Video Screen → 80
6 Menü

6.1 Levels

A menu can have up to two levels in addition to the intro video. The main or title menu consists of all the video titles in the project. Each video title is represented by a button consisting of a thumbnail and a button text. If a video title has more than one chapter, a video title submenu is generated. Each chapter of the respective video title is represented by a button in the chapter menu.

When making changes, you can adjust the levels of the menu independently. You can select the layout of each menu from existing menu templates. Menu templates are subdivided into individual menu template groups for a better overview.

6.2 Edit Menu Screen

You can select menu templates and/or templates that meet your requirements in the Edit Menu screen. In the normal editing mode, editing remains limited to the most important features. Additional customization options are available in Advanced Editing.

You can choose the individual form and design of the menu in the advanced editing mode. You can place and edit your own graphical items and text on the menu, modify, delete and create various button options, as well as create links between any buttons, menus and videos.

Some of the functions mentioned here are restricted or not available in the Essentials version. You can always upgrade your Essentials version at www.nero.com to get the full version with all the functions.

In the preview and compilation area of the screen on the left, the menu items of the title or chapter menus are displayed according to the selected template. If the intro video is selected, the preview shows a still of the video. Here, you can directly edit the individual items of the template. Selected objects are identified by a frame and can then for example be adjusted for size, rotated or moved.

The Templates and Customize tabs are available on the right. You can also make changes to objects on the respective palettes.

A capacity bar below the compilation area shows how much space your project occupies on the selected medium.
The following buttons are available on the navigation scroll bar in the compilation area:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Create New Menu</strong></td>
<td>Creates an empty menu without links in the layout of the template that was last selected. Only available in <strong>Advanced Editing</strong>. Not available for Smart3D templates.</td>
</tr>
<tr>
<td><strong>Delete menu</strong></td>
<td>Deletes a style item from the template. All items except the background can be deleted. Only available in <strong>Advanced Editing</strong>.</td>
</tr>
<tr>
<td><strong>Save As Template</strong></td>
<td>Saves a template with all changes made. The <strong>Save As Template</strong> window is opened. If you want to save your own menu template, you have to specify and save the title and chapter menu separately, even if both are based on the same template. Not available for Smart3D templates.</td>
</tr>
<tr>
<td><strong>Previous / Next Menu Page</strong></td>
<td>Goes to the next or previous page of the title or chapter menu that was selected in the menu view. If a title or chapter menu consists of several pages, the thumbnails are displayed one above the other. Only available in normal editing if a menu has several pages.</td>
</tr>
</tbody>
</table>
### Menu

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toggle Move Cursor</td>
<td>If the button is activated, it is possible to move desired areas of an enlarged menu page in the visible range of the compilation window with the hand cursor. Only available when the visible compilation area is enlarged.</td>
</tr>
<tr>
<td>Zoom In</td>
<td>Enlarges the visible compilation area up to 500%.</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>Reduces the visible compilation area to 100%.</td>
</tr>
<tr>
<td>View</td>
<td>If the <strong>Show Guidelines</strong> option is activated, Nero Vision fades in a guideline grid in the compilation area.</td>
</tr>
<tr>
<td></td>
<td>If the <strong>Show Safe Area</strong> option is enabled, Nero Vision displays the frame of the safe zone in the compilation area.</td>
</tr>
<tr>
<td></td>
<td>If the <strong>Show Button Numbers</strong> option is enabled, Nero Vision assigns each button in the compilation area a number. This option is only available in <strong>Advanced Editing</strong>.</td>
</tr>
<tr>
<td>Order</td>
<td>Changes the arrangement of graphics and text fields of a template. Marked items can be moved to the back or front by one level. They can also be moved to the very back or very front. The background picture always stays on the back level, buttons stay on the front level. Only available in <strong>Advanced Editing</strong>.</td>
</tr>
<tr>
<td>Snap to Guidelines</td>
<td>If the <strong>Snap to Guidelines</strong> button is activated, items that move in the compilation area automatically line up to the horizontal and vertical guidelines.</td>
</tr>
</tbody>
</table>

**See also**
- Templates Tab → 90
- Customize Tab → 91
- Save Template as Window → 107
- Creating Menu → 107

### 6.2.1 Templates Tab

Select a desired template from the **Standard2D**, **Animated2D** and **Smart3D** categories on the **Templates** tab. In addition, you can save your own templates in the **My Menu Templates** category.

⚠️ Some of the functions mentioned here are restricted or not available in the Essentials version. You can always upgrade your Essentials version at [www.nero.com](http://www.nero.com) to get the full version with all the functions.
If you select a **Smart3D** menu, please note that a graphics card with 3D acceleration must be connected to the computer. The **Advanced Editing** is not available for Smart3D menus.

If problems arise when editing the menu, make sure that you have installed the current version of the graphics driver.

The following drop-down menus are available:

<table>
<thead>
<tr>
<th>Menus to use</th>
<th>Defines whether the menu should be created as a title and chapter menu or simply as a title menu. You can also create no menu.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category</td>
<td>Specifies the category, from which the template should be selected. The <strong>My Menu Templates</strong> option shows saved templates. You can give your videos an appropriate graphic background with a menu template from the <strong>Standard2D</strong> group. The menu contains a layout for the title and chapter menu. You can give your videos predefined background animations with a menu template from the <strong>Animated2D</strong> group - including matching intro video and scoring. The menu contains a layout for the title and chapter menu, as well as background music for the intro video and menu pages. You can give your videos a starting animation and three-dimensional menus with a menu template from the <strong>Smart3D</strong> group. The menu templates are based on dynamic 3D scenes with animated menu transitions and predefined scorings.</td>
</tr>
</tbody>
</table>

**See also**

[Edit Menu Screen](#) → 88

### 6.2.2 Customize Tab

The number of palettes that are displayed on the **Customize** tab depends on the selected mode. Clicking the title bar of the palette closes or opens the palette.

Some of the functions mentioned here are restricted or not available in the **Essentials** version. You can always upgrade your Essentials version at [www.nero.com](http://www.nero.com) to get the full version with all the functions.

Nero Vision automatically starts in normal editing mode with the **Compact Menu View**. A thumbnail is displayed for the intro video and title, as well as for each chapter menu. Unused components remain gray. If a title or chapter menu consists of several pages, the thumbnails are displayed one above the other.

Select the **Advanced Editing** check box to go to **Advanced Editing** with **Extended Menu View**. The intro video and each page of the individual menus are displayed as thumbnails.
Only go to **Advanced Editing** if you have experience editing menus. If you select the box, a window appears that indicates you are about to enter advanced editing mode. Links between menus and buttons are not created dynamically based on project content. Therefore, video titles, menus and buttons that are not added after opening advanced editing mode must be manually linked to each other.

**Advanced Editing** is not available for Smart3D templates.

---

The following palettes are available:

<table>
<thead>
<tr>
<th>Properties</th>
<th>Displays a customized area for each menu item marked in the compilation area. You can make any setting changes here.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content</td>
<td>Lists all titles and chapters of the project in an overview. Not available for Smart3D menus. Only available in <strong>Advanced Editing</strong>.</td>
</tr>
<tr>
<td>Buttons</td>
<td>Offers sets of predefined buttons in the <strong>Thumbnail buttons</strong>, <strong>Text-only buttons</strong> and <strong>Navigation buttons</strong> categories. Not available for Smart3D menus.</td>
</tr>
</tbody>
</table>
### Objects and Clip Arts

The **Standard objects** folder offers a selection of pre-defined graphic objects, drawing items such as circles, rectangles or lines, as well as clip arts. The folder also includes an empty text box. You can import your own graphic files into the **My objects** folder. Not available for Smart3D menus. Only available in **Advanced Editing**.

### Disc / Project

The **Disc Settings** area offers settings that customize the playback of the disc according to your requirements. In addition, you can check the customized navigation of our menus for completeness. In the **Project Settings** area you can simplify the menu editing by individual additional guide lines.

### Template Settings

Offers a number of theme-related versions for Smart3D menus. Only available for Smart3D menus.

### See also

- Edit Menu Screen → 88
- Template Settings Palette → 93
- Properties for Background and Intro Video Palette → 94
- Button Properties → 97
- Properties of Graphic Objects → 99
- Content Palette → 100
- Buttons and Graphic Objects Palettes → 101
- Disc/Project Palette → 101
- Select Start Position Window → 103
- Edit Background Audio Window → 104
- Select Poster Frame Window → 105
- Shadow Settings Window → 106

#### 6.2.2.1 Template Settings Palette

If you have selected a Smart3D template on the **Templates** tab, you can customize the menu transitions according to your requirements in the **Template Settings** palette and, depending on the menu template selected, choose between different theme versions.

Only available for Smart3D menus.

The following setting options are available:

<table>
<thead>
<tr>
<th>Option button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Default transitions</strong></td>
<td>Enables all transitions of the selected template.</td>
</tr>
</tbody>
</table>
### Properties for Background and Intro Video Palette

If the background is enabled in the compilation area, the Properties palette is divided into the Background, Background Audio, Animation and Interaction areas. The Spreading area is only available in normal editing mode.

The Background and Animation areas are not available for Smart3D menus.

If an Intro Video is displayed in the compilation area, the Background and Background Audio areas are also available. The Linkage area is also available in Advanced Editing mode.

The following setting options are available in the Background area:

<table>
<thead>
<tr>
<th>Drop-down menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Background</td>
<td>Specifies whether a picture or video should be imported into the background of the template or whether the background should be a solid color. In the default settings, the Predefined background entry is selected that provides every template with a suitable background.</td>
</tr>
</tbody>
</table>

If you select the Picture file or Video file option, a window opens in which you can select the required file. The path to the selected file is then displayed in the selection area.

The number of drop-down menus that are displayed for detailed settings depends on the option selected.
### Slider/Input field Position

Moves the selected picture or video to the correct position. Detailed settings (e.g. aligning the position of the same picture in the intro video and on the menu pages) can be performed easily with the aid of the input field.

Background pictures are placed on the screen without black borders. Only available for background pictures and videos.

<table>
<thead>
<tr>
<th>Button Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Defines the detail settings of the background video. The <strong>Select Start Position</strong> window opens.</td>
</tr>
<tr>
<td>Only available for background videos.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Drop-down menu Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Defines the desired color as the background color.</td>
</tr>
<tr>
<td>Only available for background color.</td>
</tr>
</tbody>
</table>

The following setting options are available in the **Background Audio** area:

<table>
<thead>
<tr>
<th>Drop-down menu Audio</th>
</tr>
</thead>
<tbody>
<tr>
<td>Defines an audio file as background music or disables the background music.</td>
</tr>
<tr>
<td>If you select the <strong>User-defined</strong> option, a path appears for selecting a required file.</td>
</tr>
<tr>
<td>The <strong>Predefined Audio</strong> option, which is stored for each Animated 2D and Smart3D template with the appropriate scoring, is selected in the default settings.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Button Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Defines the detail settings of the background music. The <strong>Background Audio</strong> window is opened.</td>
</tr>
</tbody>
</table>

The following setting options are available in the **Animation** area:

<table>
<thead>
<tr>
<th>Input field Duration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Defines the duration of animation for the respective menu.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Check box Fit to audio duration</th>
</tr>
</thead>
<tbody>
<tr>
<td>If this check box is selected, the respective menu is displayed over the full playback duration of the selected background audio file.</td>
</tr>
</tbody>
</table>

In the **Interaction** area you can specify whether the menu responds to input when playing back the disc. The following drop-down menus are available:

<table>
<thead>
<tr>
<th>Highlight color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Defines the color used to highlight marked buttons.</td>
</tr>
<tr>
<td>You can also specify the <strong>Opacity</strong> in percent.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Activation color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Defines the color used to highlight enabled buttons.</td>
</tr>
<tr>
<td>You can also specify the <strong>Opacity</strong> in percent.</td>
</tr>
</tbody>
</table>
### Autorun action
If desired, it specifies a video title or chapter to automatically start after a timeout. As an alternative you can also rotate through the pages of the menu.

No automation is selected in the default settings (i.e. the **None** option is enabled).

Not available for Smart3D menus.

### Delay
Defines the timeout duration after which the selected automation begins.

Not available for Smart 3D menus.

---

The following drop-down menu is available in the **Spreading** area:

#### Title/Chapter number per menu
Defines the number of titles or chapters that are shown per menu page.

The number per page is freely selectable as long as the maximum number for the selected menu template is not exceeded.

If the **Evenly** entry is selected, Nero Vision divides the number of titles or chapters equally over the menu page. For instance, a total of eight titles are divided to four on a menu page.

If the **Standard** setting is selected in the default settings, then the titles and chapters are automatically distributed so that the maximum number of selected menu templates per menu page is achieved. For instance, in the case of eight titles, and depending on the capacity, six might be positioned on the first menu page and the other two on another.

---

The following setting options are available in the **Linkage** area:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Link to</td>
<td>Defines to which page of the menu the intro video should link to.</td>
</tr>
<tr>
<td>Transition</td>
<td>Defines a transition for the link, if desired.</td>
</tr>
<tr>
<td>Options</td>
<td>Opens the <strong>Transitions</strong> window. Depending on the selected transition you can specify the detail settings here. You can also specify the duration of the transition; a period of one second is selected in the default settings.</td>
</tr>
</tbody>
</table>

---

**See also**

[Customize Tab → 91](#)
6.2.2.3 Button Properties

If a button is activated in the compilation area the Properties palette is divided into the Linkage, Appearance, Transformation, Font and Text areas.

In Smart3D menus, the Linkage and Transformation areas are not available, the Appearance area is only available for buttons, not for the header or footer.

To edit a required item, enable it in the compilation area. The highlighted area is identified by a red frame and sizing handles. You have three options when editing a Thumbnail button to set the focus. If the focus lies on the entire button, it can be moved or adjusted proportionally in size. If the focus lies on the text item of the button, the length of the text field can be adjusted and moved within the button. If the focus lies on the text in the text item, the input can be edited.

In Smart3D templates, the focus lies on the entire button. Buttons, headers and footers cannot be deleted in Smart3D menus; additional objects cannot be added or moved. They also cannot be adjusted in size. The position marks of the headers and footers are used to simplify editing and are not visible in your menu later on. Even if you do not use headers and/or footers, they need not be deleted.

The Linkage area is only available in Advanced Editing.

The following setting options are available in the Linkage area:

<table>
<thead>
<tr>
<th>Drop-down menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Link to</td>
<td>Defines where the button should link. All available destinations of the project (video title, all chapters and slide shows) are displayed in the drop-down menu.</td>
</tr>
<tr>
<td>Transition</td>
<td>Defines a transition for the link, if desired.</td>
</tr>
<tr>
<td>Options</td>
<td>Opens the Properties window. Depending on the selected transition, you can specify the detail settings here. You can also specify the duration of the transition; a period of two seconds is selected in the default settings.</td>
</tr>
<tr>
<td>Button number</td>
<td>Manually specifies the numbering of the buttons. Nero Vision automatically numbers all the buttons of a template. The number is not displayed in the editable text field of a button. When you edit the menu and reposition buttons, Nero Vision maintains the numbering. Any adjustment to the text (e.g. font) is automatically adopted. If a button is assigned a different number (A), Nero Vision automatically assigns the number that is now available (B) to the button with the number (A) that has been selected for the new assignment.</td>
</tr>
</tbody>
</table>
The following setting options are available in the **Appearance** area:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Drop-down menu</strong>&lt;br&gt;<strong>Display</strong></td>
<td>Specifies what is displayed on the thumbnail of the button: video title, still of a video or picture. If the <strong>Display Title</strong> or <strong>Display Picture</strong> option has been selected, clicking the <strong>Options</strong> button opens the <strong>Select Start Position</strong> or <strong>Select Poster Frame</strong> window. If you select the <strong>Picture file</strong> option, a window automatically opens in which you can select the required picture.</td>
</tr>
<tr>
<td><strong>Drop-down menu</strong>&lt;br&gt;<strong>Text numbering</strong></td>
<td>Specifies the numbering of the buttons displayed on the template. Only the numbering, text on the button, or number and text can be displayed. Nero Vision automatically numbers all the buttons of a template. The number is not displayed in the editable text field of a button. When you edit the menu and reposition buttons, Nero Vision maintains the numbering. Any adjustment to the text (e.g. font) is automatically adopted.</td>
</tr>
<tr>
<td><strong>Check box</strong>&lt;br&gt;<strong>Apply shadow</strong></td>
<td>If the check box is selected, the button is given a shadow. Clicking the <strong>Options</strong> button opens the <strong>Shadow Settings</strong> window. You can customize the shading according to your requirements.</td>
</tr>
</tbody>
</table>

The following setting options are available in the **Transformation** area:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Input field</strong>&lt;br&gt;<strong>Pos. X</strong></td>
<td>Defines the horizontal position of the marked object in the compilation area.</td>
</tr>
<tr>
<td><strong>Input field</strong>&lt;br&gt;<strong>Pos. Y</strong></td>
<td>Defines the vertical position of the marked object in the compilation area.</td>
</tr>
<tr>
<td><strong>Input field</strong>&lt;br&gt;<strong>Scale X</strong></td>
<td>Defines the width in percent. Buttons can only be adjusted in Nero Vision in the lock aspect ratio. If the value is adjusted, <strong>Scale Y</strong> automatically adjusts.</td>
</tr>
<tr>
<td><strong>Input field</strong>&lt;br&gt;<strong>Scale Y</strong></td>
<td>Defines the height in percent. Buttons can only be adjusted in Nero Vision in the lock aspect ratio. If the value is adjusted, <strong>Scale X</strong> automatically adjusts.</td>
</tr>
<tr>
<td><strong>Check box</strong>&lt;br&gt;<strong>Lock aspect ratio</strong></td>
<td>If the check box is selected, the <strong>Scale X</strong> and <strong>Scale Y</strong> values of a graphic object (i.e. width and height in percent) can only be adjusted in the lock aspect ratio. If a value is adjusted, the other value automatically adjusts. Buttons can only be adjusted in Nero Vision in the lock aspect ratio.</td>
</tr>
</tbody>
</table>
You can customize the font and size of the text in the Font area. In Smart3D templates you can enter an individual title for your buttons in the Text area or enter required text in the header and/or footer. In all other template categories, the following drop-down menus are available in the Text area:

<table>
<thead>
<tr>
<th>Input field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Opacity</strong></td>
<td>Defines the opacity of the button.</td>
</tr>
<tr>
<td><strong>Rotation</strong></td>
<td>Rotates the selected item.</td>
</tr>
</tbody>
</table>

You can customize the font and size of the text in the Font area. In Smart3D templates you can enter an individual title for your buttons in the Text area or enter required text in the header and/or footer. In all other template categories, the following drop-down menus are available in the Text area:

<table>
<thead>
<tr>
<th>Input field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Text Color</strong></td>
<td>Defines the color of the text.</td>
</tr>
<tr>
<td><strong>Horizontal alignment</strong></td>
<td>Defines the horizontal alignment of the text: centered, left or right.</td>
</tr>
<tr>
<td><strong>Vertical alignment</strong></td>
<td>Defines the vertical alignment of the text: top, middle or bottom.</td>
</tr>
</tbody>
</table>

6.2.2.4 Properties of Graphic Objects

If a graphic object is activated in the compilation area, the Properties palette is divided into Appearance and Transformation areas.

To edit a required item, activate it in the preview area. The outer highlighted area is identified by red sizing handles. With the aid of the focus the entire surface can be moved or adjusted proportionally in size.

In addition green nodes point on all polygon standard formats (and with lines) mark the corners. All polygons can thereby be edited as well in that individual node points are marked simply by clicking them at which point they can be moved or deleted. New node points can be inserted at any place by a double-click. A surface object must consist of at least three points; a linear object of at least starting and end points.

The following setting options are available in the Appearance area:

<table>
<thead>
<tr>
<th>Input field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Fill color</strong></td>
<td>Defines the fill color of a graphic item. Only available when the focus is positioned on a standard form (drawing item).</td>
</tr>
<tr>
<td><strong>Border color</strong></td>
<td>Defines the color of the margin/frame of a graphic object. Only available when the focus is positioned on a standard form (drawing item).</td>
</tr>
<tr>
<td><strong>Line thickness</strong></td>
<td>Defines the thickness of the margin/frame of a graphic object. Only available when the focus is positioned on a standard form (drawing item).</td>
</tr>
</tbody>
</table>
Check box

Apply shadow

If the check box is selected, the button is given a shadow. Clicking the Options button opens the Shadow Settings window. You can customize the shading according to your requirements.

The following setting options are available in the Transformation area:

<table>
<thead>
<tr>
<th>Input field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pos. X</td>
<td>Defines the horizontal position of the marked object in the compilation area.</td>
</tr>
<tr>
<td>Pos. Y</td>
<td>Defines the vertical position of the marked object in the compilation area.</td>
</tr>
<tr>
<td>Scale X</td>
<td>Defines the width in percent.</td>
</tr>
<tr>
<td>Scale Y</td>
<td>Defines the height in percent.</td>
</tr>
<tr>
<td>Lock aspect ratio</td>
<td>If the check box is selected, the Scale X and Scale Y values of a graphic object (i.e. width and height in percent) can only be adjusted in the lock aspect ratio. If a value is adjusted, the other value automatically adjusts.</td>
</tr>
<tr>
<td>Opacity</td>
<td>Defines the opacity of the graphic object.</td>
</tr>
<tr>
<td>Rotation</td>
<td>Rotates the selected item.</td>
</tr>
</tbody>
</table>

See also

Customize Tab → 91

6.2.2.5 Content Palette

Only available in Advanced Editing.

Not available for Smart3D menus.

On the Content palette, all the titles and chapters of the project that you have compiled in the Content screen are listed in a navigation tree. Using the drag-and-drop function, you can link any title in the list to a desired button and thereby define the target of a link. If the title is dragged into the compilation for the first time or again without a specific button marked, Nero Vision automatically creates a default button and links it to the video.
Note that all menu items on the template remain linked when you make changes! If a new link is assigned to a button, the old link is lost (i.e. it is not automatically assigned to another button). The same menu item can be linked via multiple buttons.

See also

Customize Tab → 91

6.2.2.6 Buttons and Graphic Objects Palettes

The graphic objects are only available in Advanced Editing.

First, you can select the category of the available items in the Buttons or Objects and Clip Arts palettes. The available buttons or graphics from the selected category are listed in the preview area of both palettes. With the Apply button, the view of a button is customized to your menu template or graphics are added.

Available in buttons are the categories Thumbnail buttons, Text-only buttons, and Navigation buttons. The sets of Navigation buttons always consist of three buttons (one each for Back, Next and Back to Main Menu).

Available for the graphic objects are the Standard objects and My objects entries. The default objects include drawing items such as circles, rectangles and lines as well as clip arts. The My objects folder contains all pictures that have been imported into Nero Vision.

You can select and combine individual buttons in Advanced Editing only. You can also customize existing template buttons and add new ones. Links must be manually assigned to buttons that you add.

See also

Customize Tab → 91

6.2.2.7 Disc/Project Palette

The Disc/Project palette is divided into the Disc Settings, Project Settings, and Button Numbering areas.

The following pop-up menus are available in the Disc Settings area.

<table>
<thead>
<tr>
<th>Drop-down menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>First</td>
<td>Defines the title that is played first after inserting the disc into a player. Only available in Advanced Editing. In normal editing mode, the intro video is automatically played or the title menu is displayed.</td>
</tr>
<tr>
<td>Title Menu</td>
<td>Defines the menu that is displayed when the Title button is pressed on the remote control. Only available in Advanced Editing. In normal editing mode, the title menu is automatically displayed.</td>
</tr>
</tbody>
</table>
### Drop-down menu

**End action**  
Defines whether the menu is displayed again after playback of a title is complete (enabled in the default settings) or whether the next title (by number) is played automatically.

### Drop-down menu

**Additional folder**  
- **Nothing** only saves the pictures in the slide show.  
- **Original pictures** saves the pictures in the original format as well. Original pictures are saved on the disc in the ORIGPICS folder.  
- **HTML browsing gallery** creates an HTML version of the slide show that can be displayed on any computer with a browser. You can display the HTML browser gallery by opening the INDEX.HTM file on the disc.  
- **PC slide show** creates an executable file on the disc; this can be opened on any Windows computer. The executable file for the computer slide show has the name slideshow.exe.  
  
Only available if a slide show has been inserted into your project.

### Button

**Check Project**  
Checks the menu for unlinked or overlaying buttons (title and/or chapter), for orphaned menu pages as well as for videos and/or slide shows of the project that are not linked to the menu.  
A detailed overview of problems with a short error description is listed in a window.  
Only available in Advanced Editing.

### Project Settings

**Number of guides**  
Inserts each a further horizontal and vertical guide line into the lattice in the compilation area or removes lines.  
Nero Vision creates an even lattice network. However, the lines can be moved as desired with the mouse and can be positioned as desired in the compilation area.

**Never use black thumbnails**  
If the check box is selected, Nero Vision ensures that the thumbnails of the buttons show the first frame of the linked video title and not merely a black picture.

### Button Numbering

**Restart numbering on each menu page**  
When this check box is selected, the button numbers will start with 1 on each new menu page. When the check box is cleared, the buttons are numbered continuously throughout the menu.  
This box is selected by default in the default setting.  
Only available in normal editing.

**See also**  
[Customize Tab → 91](#)
6.2.2.8 Select Start Position Window

In the Select Start Position window you can define which section of a linked video is displayed in the background of a menu side, in the background of the intro video or in the thumbnail view of the Thumbnail button.

The controller on the navigation strip shows the start position in the video. The duration of the video is automatically customized to the duration of the menu and is displayed graphically by a darker bar on the navigation strip. You can define the desired start position by moving the controller (and bar) on the navigation strip. Or the start position can be defined by entering an exact starting time in the input field below. You can also use the Position buttons next to the time code display.

Additionally, the following setting options are available:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Play" /></td>
<td>Plays the video back in the preview area of the window.</td>
</tr>
<tr>
<td><img src="image" alt="Stop" /></td>
<td>Stops the preview.</td>
</tr>
</tbody>
</table>
6.2.2.9 Edit Background Audio Window

In the **Edit Background Audio** window you can define which section of the selected audio file is played as the menu's background music. For this purpose, the file is depicted in the top area of the window in wave form.

The controller on the navigation strip shows the start position in the audio file. The duration of the background music is automatically customized to the duration of the menu. You can define the desired start position by moving the controller on the navigation strip. Or the start position can be defined by entering the exact starting time in the input field below. You can also use the **Position** buttons next to the time code display.

The following setting options are available:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Play button" /></td>
<td>Plays the audio file.</td>
</tr>
<tr>
<td><img src="image" alt="Stop button" /></td>
<td>Stops playback.</td>
</tr>
</tbody>
</table>
### 6.2.2.10 Select Poster Frame Window

In the **Select Poster Frame** window you can define which picture of a linked video is displayed in the thumbnail view of the **Thumbnail** button.

The controller on the navigation strip shows the position of the picture in the video. You can specify the picture to be used by moving the controller.

See also

- Customize Tab → 91
The following buttons are available:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>▶️</td>
<td>Plays the video back in the preview area of the window.</td>
</tr>
<tr>
<td>▦</td>
<td>Stops the preview.</td>
</tr>
</tbody>
</table>

**See also**

Customize Tab → 91

### 6.2.2.11 Shadow Settings Window

If the **Apply shadow** check box in the **Properties** palette is selected, the selected button or graphic object is given a shadow. Clicking the **Options** button opens the **Shadow Settings** window.

You can adjust the detail settings of the shading at the top of the **Shadow Settings** window. A preview appears at the bottom of the window if you select the **Preview** check box. You can immediately preview what effects a change to the settings will have.

The following setting options are available:

<table>
<thead>
<tr>
<th>Setting Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drop-down menu <strong>Light source</strong></td>
<td>Defines the desired angle of the virtual light source in relation to the object.</td>
</tr>
<tr>
<td>Slider <strong>Opacity</strong></td>
<td>Defines the required shadow transparency in percent. An opacity of 0 means that the shadow is invisible.</td>
</tr>
<tr>
<td>Slider <strong>Distance</strong></td>
<td>Defines the distance between the object and the shadow (in pixels).</td>
</tr>
<tr>
<td>Slider <strong>Spread</strong></td>
<td>Defines the scatter degree of the shadow (in percent). The scatter is added to the size of the shadow.</td>
</tr>
<tr>
<td>Slider <strong>Blur</strong></td>
<td>Defines the blurring degree of the shadow. In the default settings the shadow has an exact contour which gives a blurring degree of 0%.</td>
</tr>
<tr>
<td>Drop-down menu <strong>Color</strong></td>
<td>Defines the desired color of the shadow.</td>
</tr>
</tbody>
</table>

**See also**

Customize Tab → 91
6.2.3 Save Template as Window

The following drop-down menus are available in the Save As Template window:

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intro video</td>
<td>Displays the name of the intro video or No intro video, if no video has been added to the menu template.</td>
</tr>
<tr>
<td>Main menu</td>
<td>Defines which menu from the arranged template is saved as the title menu. All menus that are available in the template are also available in the drop-down menu.</td>
</tr>
<tr>
<td>Chapter menu</td>
<td>Defines which menu from the arranged template is saved as the chapter menu. All menus that are available in the template are also available in the drop-down menu.</td>
</tr>
<tr>
<td>Template name</td>
<td>Defines the name under which you want to save the new template under.</td>
</tr>
<tr>
<td>Add to subcategory</td>
<td>Defines where the template is saved. Nero Vision automatically saves created menu templates in the My Menu Templates folder itself. If you want to sort your templates in topic groups, select an existing group or the Create new subcategory option to create a new category.</td>
</tr>
<tr>
<td>New subcategory name</td>
<td>Defines the name of a new category. Only available if you have selected the Create new subcategory option in the Add to subcategory drop-down menu.</td>
</tr>
</tbody>
</table>

If the Store media files with template check box is selected, Nero Vision saves the media files used in the template with the new template.

See also

Edit Menu Screen → 88

6.3 Creating Menu

Some of the functions mentioned here are restricted or not available in the Essentials version. You can always upgrade your Essentials version at www.nero.com to get the full version with all the functions.

The following requirement has to be fulfilled:

▶ The Edit Menu screen is displayed.

To create the menu for a project, proceed as follows:

1. Choose in the Menu to use drop-down menu on the Templates tab whether your disc should have title and chapter menus, title menus only or no menu at all.

2. If your disc consists of video titles with multiple chapters, i.e. if your menu has title and (multiple) chapter menus, repeat the following steps for each menu you wish to edit.
3. Select the desired menu template group in the **Category** drop-down menu.
   → The menu templates of the selected category appear.

4. Select the required menu template.
   → In the preview and compilation area, the menu items of the selected title or chapter menus are displayed according to the template selected.

5. Click the **Customize** tab.
   → The **Customize** tab is displayed. You can edit the selected menu template here.

6. If you want to go to **Advanced Editing** to make changes:
   1. Select the **Advanced Editing** check box.
      → A window is opened notifying you that you are entering **Advanced Editing**.
   2. Click the **Yes** button.
      → The additional features appear.

   ![Only go to Advanced Editing if you have experience editing menus.](image)
   If you select the box, a window appears that indicates you are about to enter advanced editing mode. Links between menus and buttons are not created dynamically based on project content. Therefore, video titles, menus and buttons that are not added after opening advanced editing mode must be manually linked to each other.

   **Advanced Editing** is not available for Smart3D templates.

7. Highlight the menu you want to edit in the **Menu View**.

8. If you want to make changes:
   1. Mark the style item you want to edit in the preview and compilation window.
      → Additional palettes may appear or disappear on the **Customize** tab. Clicking the title bar of a palette displays all areas.
   2. Adjust the required settings on the palettes.
      → Any changes are displayed in the preview and compilation area.

9. If you want to save the adjusted menu as a menu template:
   1. Click the **Save As Template** button.
      → The **Save As Template** window is opened.
   2. Enter a name in the **Template name** input field.
   3. Select the **Create new subcategory** option in the **Add to subcategory** drop-down menu.
   4. Enter the name for the new menu template group in the **New group name** input field and click the **OK** button.
      → The customized menu is saved as a menu template.
      → You have edited the menu and can now view the entire project in the preview area.

**See also**

Edit Menu Screen → 88
7 Preview

7.1 Preview Screen

In the Preview screen, you can play part of a disc to test it before actually burning it. Using the cursor or the remote control, you can test how the disc behaves when played back on a compatible player. In the menu, all of the buttons can be used normally so that you can view your finished work.

If a menu contains animated items, an additional button also appears. Clicking the button plays the background animations. Otherwise, the standard picture is shown as the video background.

The following setting options are available on the virtual remote control:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Moves the mark up or down, to the left or right. Click the center to confirm the mark at its position and start the marked item.</td>
<td>Title</td>
</tr>
<tr>
<td>Displays the title menu.</td>
<td></td>
</tr>
</tbody>
</table>
### 7.2Showing a Preview

The following requirement has to be fulfilled:

► The **Preview** screen is displayed.

To display the preview for a project, proceed as follows:

1. Click the buttons for the desired actions on the virtual remote control.
   
   ➔ If the menu contains animated items, the **Pre-render** button is displayed.

2. Click the **Pre-render** button.
   
   ➔ The **Menu Animation Preview** window is opened. While the menu animation is being calculated, the current status appears in the progress bar.

3. Click the **Close** button.

4. If you are satisfied with the preview, click the **Next** button.
   
   ➔ The **Burn Options** screen is displayed.
   
   ➔ You have displayed the preview and can now burn your project.

**See also**

❗ Preview Screen → 109
8 Burn Options

8.1 Burn Options Screen

In the Burn Options screen you can burn a project as a disc image or write it to the hard disc drive (or save it to memory stick or SD card) as a folder. Depending on the type of project you are working on and the burner connected to the system, a number of different options are available in the Set the parameters for burning selection list on the right side of the screen. The Project summary area on the left side displays information about the settings and content of the project.

Even if you do not have a drive that is capable of burning DVDs, Blu-ray Discs or CDs, you can still use the Image Recorder to burn a disc image and save it for future use on your hard drive. Once you have connected the appropriate recorder to the system, you can burn disc images on real discs at any time using Nero Vision.

A project file (*.nvc) saves the project data – information about file paths and layout – after you have started work on your project. This means that you can interrupt your work at any time and resume the project at a later point or burn it on disc. The contents of a project file can only be opened with Nero Vision. The file size of a saved compilation is significantly smaller than a disc image.

A disc image (image file) is the precise picture of the project data to be burned. You can burn the finished image as often as you like at a later stage, but it requires just as much space on the hard drive as the compilation to be burned. As well as being burned to disc or as a disc image, some projects can also be captured to hard disc folders, memory stick or SD card, provided there is enough space.
Depending on the type of project you are working on and the burner connected to the system, the following options are available in the Set the parameters for burning selection list:

<table>
<thead>
<tr>
<th>Burn To</th>
<th>Defines the desired recorder. All burners available in the system are displayed. If you want to burn the project as a disc image, select the Image Recorder option. The current destination is shown in the display in the lower right of the screen.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Write to Hard Disk Folder</td>
<td>Opens the Choose a location for the project window. Define the required storage path or folder. It is displayed in the Current destination display in the lower right of the screen.</td>
</tr>
<tr>
<td>Write to Memory Stick</td>
<td>Opens the Choose a location for the project window. Define the required storage path or folder. It is displayed in the Current destination display in the lower right of the screen.</td>
</tr>
<tr>
<td>Write to SD Card</td>
<td>Opens the Choose a location for the project window. Define the required storage path or folder. It is displayed in the Current destination display in the lower right of the screen.</td>
</tr>
<tr>
<td>Volume Name</td>
<td>Displays a dialog box. You can specify a name for the disc.</td>
</tr>
<tr>
<td>---------------------</td>
<td>------------------------------------------------------------</td>
</tr>
<tr>
<td>Recording Settings</td>
<td>Displays a dialog box. You can change the required <strong>Settings for recording</strong> here.</td>
</tr>
</tbody>
</table>

The following setting options are available in the dialog box of the **Recording Settings**:

<table>
<thead>
<tr>
<th>Drop-down menu Speed</th>
<th>Only available when burning to a burner.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check box <strong>Determine maximum speed</strong></td>
<td>Before burning, the program verifies whether the burner is capable of burning the session with the selected write speed.</td>
</tr>
<tr>
<td>Check box <strong>Write</strong></td>
<td>If this check box is selected, Nero Vision carries out burning immediately after a speed test. When writing to an image file, this check box is automatically enabled.</td>
</tr>
<tr>
<td>Drop-down menu <strong>Book Type setting</strong></td>
<td>Defines the book type. The <strong>Automatic</strong> option is selected by default. The drop-down menu is only displayed for supported burners.</td>
</tr>
<tr>
<td>Check box <strong>Use Burn-at-once</strong></td>
<td>If this check box is selected, Nero Vision burns the files directly to the disc without temporarily storing on the hard drive first. This check box is automatically disabled if the burner does not support Burn-at-once.</td>
</tr>
</tbody>
</table>

The following entries are available in the **Book Type setting** drop-down menu:

<table>
<thead>
<tr>
<th><strong>Automatic</strong></th>
<th>Automatically defines the most compatible book type for this disc.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>DVD-ROM</strong></td>
<td>Sets the book type to DVD-ROM.</td>
</tr>
<tr>
<td><strong>Physical disc type</strong></td>
<td>Leaves the book type unchanged as specified on the DVD disc.</td>
</tr>
<tr>
<td><strong>Current recorder setting</strong></td>
<td>Applies the book type setting from the burner.</td>
</tr>
</tbody>
</table>

**See also**

- Burning a Disc → 114
- Burning an Image File → 115
- Writing to Hard Drive Folders → 116
8.2 Burning a Disc

The following requirement has to be fulfilled:

- The **Burn Options** screen is displayed.

To burn a project to a disc, proceed as follows:

1. Insert a writable disc in the desired burner.
2. Select the **Burn To** entry and the desired burner.
   - The **Burn** button appears in the window in the lower right corner.
3. Select the **Volume Name** option.
   - A dialog area is displayed.
4. Enter the desired name for the disc in the input field. Characters that are not permitted in the disc name are automatically converted to underscores ( `_` ).
5. Select the **Recording Settings** option.
   - The **Settings for recording** dialog area appears.
6. In the **Speed** drop-down menu, select the speed that the burner should use to write to the disc.
7. If you want to perform a speed test, select the **Determine maximum speed** check box.
   - Before burning, the program verifies whether the burner is capable of burning the session with the selected writing speed. In addition, it also verifies if all files selected for burning are actually available.
8. If you still want to burn the disc on positive verification, select the **Write** check box.
9. If Nero Vision is capable of changing the book type with your burner and you want to make the changes to the book type, select the required option in the **Book Type setting** drop-down menu.
10. If you want to burn the project directly to the disc without temporarily storing the disc structure on the hard drive first, activate the **Use Burn-at-once** check box.
11. Click the **Burn** button in the lower right of the screen.
   - The **Burning** screen is displayed. The project files are converted into the appropriate format and then burned to the disc. The priority determines how much computing power is assigned to the burn process. Normally, you should not change this setting.
12. If you want to change the priority of the capturing process, select the relevant entry from the **Priority** drop-down menu.
13. If you would like your PC to shut down automatically after successfully burning a disc, select the **Shut down computer when finished** check box.
   - As soon as the burn process has finished, a window is opened.
14. If you do not want to save a log file for the burn process, click the **No** button.
15. If you would like to save a log file:
   1. Click the **Yes** button.
→ A window is opened.
2. Select the desired folder in the **Location** drop-down menu.
3. Enter the desired file name in the **File Name** input field and click the **Save** button.
→ You have burned a disc and can now burn the project again or save it, start a new project or create covers and labels.

**See also**
- Burn Options Screen → 111

### 8.3 Burning an Image File

Even if you do not have a drive that is capable of burning DVDs, Blu-ray Discs or CDs, you can still use the **Image Recorder** to burn a disc image and save it for future use on your hard drive. Once you have connected the appropriate recorder to the system, you can burn disc images on real discs at any time using Nero Vision.

The following requirement has to be fulfilled:
- The **Burn Options** screen is displayed.

To burn a project as a disc image, proceed as follows:

1. Select the **Burn To > Image Recorder** entry.
   → The **Burn** button appears in the window in the lower right corner.
2. Select the **Volume Name** option.
   → A dialog area is displayed.
3. Enter the desired name for the disc in the input field. Characters that are not permitted in the disc name are automatically converted to underscores (_).
4. Select the **Recording Settings** option.
   → The **Settings for recording** dialog area is displayed.
5. If you want to burn the project directly to the disc without temporarily storing the disc structure on the hard drive first, select the **Use Burn-at-once** check box.
6. Click the **Burn** button in the lower right of the screen.
   → A window is opened.
7. Select the desired folder for the image file in the **Location** drop-down menu.
8. Enter the desired file name in the **File Name** input field and click the **Save** button.
   → The **Burning** screen is displayed. The project files are converted into the appropriate format and then burned as a disc image. The priority determines how much computing power is assigned to the burn process. Normally, you should not change this setting.
9. If you want to change the priority of the capturing process, select the relevant entry from the **Priority** drop-down menu.
10. If you would like your PC to shut down automatically after successfully burning a disc, activate the **Shut down computer when finished** check box.
   ➔ As soon as the burn process has finished, a window is opened.

11. If you do not want to save a log file for the burn process, click the **No** button.

12. If you would like to save a log file:
   1. Click the **Yes** button.
      ➔ A window is opened.
   2. Select the desired folder in the **Location** drop-down menu.
   3. Enter the desired file name in the **File Name** input field and click the **Save** button.
      ➔ You have written a disc image and can now burn the project again or save it, start a new project or create covers and labels.

**See also**

[Burn Options Screen → 111](#)

### 8.4 Writing to Hard Drive Folders

The following requirement has to be fulfilled:

► The **Burn Options** screen is displayed.

To write a project as a folder to the hard drive, memory stick or SD card proceed as follows:

1. Select the respective option from the **Set the parameters for burning** selection list, e.g. **Write to Hard Drive Folder**.
   ➔ The **Choose a location for the project** window is opened.

2. In the folder tree, click the folder where the files are to be saved and then click the **OK** button.
   ➔ The **Write** button appears in the window in the lower right corner.

3. Select the **Volume Name** option.
   ➔ A dialog area is displayed.

4. Enter the desired name for the disc in the input field. Characters that are not permitted in the disc name are automatically converted to underscores (_).

5. Click the **Write** button.
   ➔ The **Burning** screen is displayed. The project files are converted into the appropriate format and then written as a folder to the target folder. The priority determines how much computing power is assigned to the process. Normally, you should not change this setting.

6. If you want to change the priority of the write process, select the relevant entry from the **Priority** drop-down menu.

7. If you would like your PC to shut down automatically after successfully writing to the target folder, activate the **Shut down computer when finished** check box.
   ➔ As soon as the write process has finished, a window is opened.
8. If you do not want to save a log file for the write process, click the **No** button.

9. If you would like to save a log file:
   1. Click the **Yes** button.
      → A window is opened.
   2. Select the desired folder in the **Location** drop-down menu.
   3. Enter the desired file name in the **File Name** input field and click the **Save** button.
      → You have written a project into a target folder and can now burn the project again or save it, start a new project or create covers and labels.

**See also**

Burn Options Screen → 111
9 Configuration And Recording Formats

9.1 Application Settings Window

The Application Settings window contains the General, Folders and Editing tabs. You can customize Nero Vision to your own personal requirements here.

You can open the Application Settings window via the Configuration button in the extended area.

See also
- General Tab → 118
- Folders Tab → 119
- Editing Tab → 119
- Buttons → 13

9.1.1 General Tab

The General tab is divided into the Format of saved media files and Options areas.

The Pictures drop-down menu is available in the Format of saved media files area. Here you can define the graphics format in which Nero Vision saves media files from external devices and snapshots of videos. Portable Network Graphics (*.png) is selected in the default setting.

The following setting options are available in the Options area:

<table>
<thead>
<tr>
<th>Drop-down menu Display tool tips</th>
<th>Verbose - When you move the cursor over a pop-up menu, it displays its function and provides a detailed explanation as a tooltip. This entry is selected by default.</th>
<th>Brief - When you move the cursor over a pop-up menu, it displays its function.</th>
<th>None - Does not show anything when the cursor is moved over a pop-up menu.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check box Never show black thumbnails for assets</td>
<td>Does not show any black thumbnails in the content area. Instead, the first non-black thumbnail is found and displayed. This feature can slow down the application. This check box is selected by default.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

See also
- Application Settings Window → 118
9.1.2 Folders Tab

The following input fields are available in the Directories area of the Folders tab:

<table>
<thead>
<tr>
<th>Directory Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temporary files</td>
<td>Defines the folder in which temporary files are stored. The folder should be located on a drive with plenty of free drive space. The temp folder of the user who is logged on is used by default.</td>
</tr>
<tr>
<td>Saved picture files</td>
<td>Defines the folder in which imported picture files and video snapshots are stored. The My Pictures folder of the user who is logged on is used by default.</td>
</tr>
<tr>
<td>Imported video files</td>
<td>Defines the folder in which imported video files are stored. The NeroVision subfolder of My Documents of the user who is logged on is used by default.</td>
</tr>
</tbody>
</table>

The ... button opens a window in which the folder can be selected for the respective files.

See also

Application Settings Window → 118

9.1.3 Editing Tab

The Editing tab is divided into the Default Durations area and the Nero Background Rendering area.

In the Default Durations area, the default duration for still pictures, effects and transitions is listed. For all controls a minimum and maximum value is defined. If you choose a value out of range, the application automatically replaces your input by the next allowed value.

The following input fields are available:

<table>
<thead>
<tr>
<th>Input Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pictures</td>
<td>Sets the default duration of still pictures when you drag them to a track in the timeline in the Video Editing screen. The minimum possible duration is 1 second, the maximum is 60 seconds. Default duration is 4 seconds.</td>
</tr>
<tr>
<td>Text effects</td>
<td>Sets the default duration of text effects when you drag them to a track in the timeline in the Video Editing screen. The minimum possible duration is 1 second, the maximum is 60 seconds. Default duration is 4 seconds.</td>
</tr>
<tr>
<td>Master effects</td>
<td>Sets the default duration of video effects when you drag them to the Master Effects track in the timeline in the Video Editing screen. The minimum possible duration is 1 second, the maximum is 60 seconds. Default duration is 4 seconds.</td>
</tr>
</tbody>
</table>
Configuration And Recording Formats

<table>
<thead>
<tr>
<th>Video Transitions</th>
<th>Sets the default duration of video transitions when you drag them to a track in the timeline in the Video Editing screen. The minimum possible duration is 1 second, the maximum is 10 seconds. Default duration is 1 second.</th>
</tr>
</thead>
</table>

The following check box is available in the Nero Background Rendering area:

<table>
<thead>
<tr>
<th>Enable Nero Background Rendering</th>
<th>If this check box is selected, time-consuming effects are rendered in the background to ensure smooth preview capacity while you edit your project.</th>
</tr>
</thead>
</table>

See also
Application Settings Window → 118

9.2 Recording Format Options Window

You can change the settings that affect the encoding of future projects in the Recording Format Options window. The tabs for all supported formats are displayed until you have selected a disc format. After selecting a disc format, only the respective format appears.

You can call up video options at any time from the extended area. The window is also opened if you select Custom Capturing and customize the video settings when recording a video.

See also
General Tab → 120
[Disc Format] Tab → 121
Buttons → 13

9.2.1 General Tab

The General tab is divided into the Video mode and Nero SmartEncoding areas.

In the Video mode area, the color transmission system is defined specifically. This guarantees that videos can be displayed on the existing playback devices. The following entries are available in the drop-down menu:

<table>
<thead>
<tr>
<th>PAL</th>
<th>Selects the PAL video mode, which is used in Europe, as also in Australia, South America, and many African and Asian countries.</th>
</tr>
</thead>
<tbody>
<tr>
<td>NTSC</td>
<td>Selects the NTSC video mode, which is used in extensive parts of America and some East Asian countries.</td>
</tr>
<tr>
<td>[Country]</td>
<td>Automatically sets the correct video mode for the selected country. If you are unsure about the video mode that is used in your country, select your country from the country list.</td>
</tr>
</tbody>
</table>
The following options are available in the drop-down menu in the **Nero SmartEncoding** area:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable</td>
<td>Deactivates SmartEncoding. Video and audio material which is already compatible with the target format is still re-encoded.</td>
</tr>
<tr>
<td>Automatic</td>
<td>Determines automatically whether video and audio material is re-encoded. Nero Vision checks, among other things, how much space is available for the project and then determines which compatible segments are re-encoded. This entry is selected by default.</td>
</tr>
<tr>
<td>Enable</td>
<td>Activates SmartEncoding. Video and audio material which is compatible with the target format is not re-encoded. This saves a lot of time for large-scale projects, so that you achieve your goal much faster.</td>
</tr>
</tbody>
</table>

**Nero SmartEncoding** is available for video files that use the AVC codec only for encoding the AVCHD-compatible source format into the AVCHD target format.

See also

| Recording Format Options Window → 120 |

### 9.2.2 [Disc Format] Tab

On the tab of a respective disk format the video options can be customized within the scope of the profile play.

A click on the **Save As** button opens the window with the input field. Here the individual profile settings for further projects can be stored under your own name.

The following setting options are available:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Video format</strong></td>
<td>Defines the video mode. This guarantees that videos can be displayed on the existing playback devices.</td>
</tr>
<tr>
<td><strong>Aspect ratio</strong></td>
<td>Defines the desired aspect ratio. The entry <strong>Automatic</strong> that automatically recognizes the aspect ration for every title on the basis of the starting material is selected by default.</td>
</tr>
</tbody>
</table>
| **Sample format**| Please note that only experienced users should change this setting.  
**Progressive** - Uses the progressive or full-screen procedure in which actual full pictures are used for generating the picture.  
**Interlaced (top field first)** - Uses the interlaced or line jump procedure, in which a picture is made up of two separate half pictures, and transmits the top half picture first. |
<table>
<thead>
<tr>
<th>Configuration And Recording Formats</th>
</tr>
</thead>
</table>

### Interlaced (bottom field first)
- Uses the interlaced or line jump procedure in which a picture is made up of two separate fields, and transmits the bottom field first.
- **Automatic** - Encodes the file in the sample format in which the original exists. This entry is selected by default.

### Automatic
- Encodes the file in the sample format in which the original exists. This entry is selected by default.

### Motion-adaptive
- **Deinterlacing**
  - If the check box is selected, then motion adaptive conversion is used in order to improve the picture quality of the videos and slide shows.
  - This check box is cleared by default.

### Motion-adaptive
- **Frame Rate Conversion**
  - If the check box is selected, then motion adaptive conversion is used in order to improve the picture quality of the videos and slide shows.
  - This check box is cleared by default.

### Quality setting
- **Automatic (fit to disc)**
  - Automatically uses the best possible encoding quality in relation to the available storage capacity. Other settings for bit rate and resolution are not available. This entry is selected by default.
  - Sets the respective preset quality profile with defined bit rate and resolution.
- **Custom**
  - Enables user-defined settings. Manual setting of the bit rate and resolution is available only for this entry.

### Bit rate
- Determines the bit rate of the resulting video. The bit rate affects the quality of the video. The bit rate can be determined with the aid of the slider or by customizing the value of the input field.

### Resolution
- Selects the resolution from a list of resolutions possible for the disc type and defines the resolution of the resulting videos. The drop-down menu is only activated if the **Custom** entry has been selected from the **Quality setting** drop-down menu. The **Automatic** entry is selected in the default settings.

### Super resolution
- If the check box is selected, then the Super resolution procedure is used in order to improve the videos and slide shows.
  - This check box is cleared by default.

### Target Size
- Defines the size of the target file. With this quality setting, you can specify the size of the file either directly in MB or by choosing a media type.
- **Video Quality** option field is selected in the default settings.
- The option field is only activated in the case that a user profile is laid down.
**Slider/Input field Encoding quality fine tuning**

Determines the quality level of the encoder to be used. The encoding quality can be determined with the aid of the slider or by customizing the value in the input field.

**Drop-down menu Encoding mode**

- **Fast encoding (1-pass)** - Encodes the video in a single pass. Encoding is faster, but the quality is inferior.
- **High Quality (2-pass VBR)** - Encodes the video in two passes with variable data rate. Encoding takes longer, but the quality is better. VBR stands for Variable Bit Rate and means that individual periods in a video are encoded using different, suitable data rates: Scenes with a lot of movement are encoded with a higher bit rate than scenes with less movement.

**Drop-down menu Audio formats**

Chooses which audio format is used when recording the project. The Automatic entry is selected by default.

- **Dolby Digital (AC-3) 5.1** - Encodes audio data in the Dolby Digital audio format with 6 channel surround sound. (5.1 means: 5 channels with the full frequency range and one bass channel.)
- **Dolby Digital (AC-3) 2.0** - Encodes audio data in the Dolby Digital audio format in stereo.
- **Stereo** - Encodes audio in MPEG-1 (layer 2). This option is only available in PAL video mode.
- **LPCM** - Encodes audio data in LPCM. This option is only available in NTSC video mode.

**Nero SmartEncoding** is available for video files that use the AVC codec only for encoding the AVCHD-compatible source format into the AVCHD target format.

**See also**

- Recording Format Options Window → 120
10 Disc Tools

10.1 Erasing a Rewritable Disc

Using Nero Vision you can erase rewritable discs, i.e. discs with the RW specification, as long as your recorder supports this feature. Two erase methods are available for this purpose:

Quick erasing does not remove the data physically from the disc, but instead only makes it inaccessible by erasing the references to existing content. The data can be restored!

Full erasing removes the data from the disc by overwriting it with zeroes. The contents cannot be restored with conventional methods. Repeated full erasing increases the probability that third parties will not be able to reconstruct the contents.

To erase a rewritable disc, proceed as follows:

1. In the Start screen, select the Disc Tools > Erase Disc selection entry.
   → The Erase Rewritable Disc window is opened.
   
   The Disc Tools options (Erase Disc, Disc Info and Finalize Disc) can also be started from the advanced area of the main window at any time.

2. In the top drop-down menu, select the burner in which the disc has been inserted.

3. Select an erase method in the lower drop-down menu.

   Two erase methods are available:
   
   Quick erasing does not remove the data physically from the disc, but instead only makes it inaccessible by erasing the references to existing content. Please note that the data can be restored.
   
   Full erasing removes the data from the disc by overwriting it with zeroes. The contents cannot be restored with conventional methods. Repeated full erasing increases the probability that third parties will not be able to reconstruct the contents.

   Sometimes it can take a long time to erase a rewritable disc completely.

4. Click the Erase button.
   → The erase procedure starts.
   → You have erased a rewritable disc.

See also

Buttons → 13
10.2 Displaying Disc Info

To display information about a disc that has been inserted, proceed as follows:

1. In the Start screen, select the Disc Tools > Disc Info selection entry.
   ➔ The Disc Info window is opened.

   The Disc Tools options (Erase Disc, Disc Info and Finalize Disc) can also be started from the advanced area of the main window at any time.

2. Select the burner in which the disc has been inserted from the drop-down menu.
   ➔ You have displayed information on the disc that is inserted.

See also

- Buttons → 13

10.3 Finalizing a Disc

Some of the functions mentioned here are restricted or not available in the Essentials version. You can always upgrade your Essentials version at www.nero.com to get the full version with all the functions.

To finalize a DVD-VR/-VFR (video mode)/+VR/+R or DVD+RW disc with videos and to prevent further processing, proceed as follows:

1. In the Start screen, select the Disc Tools > Finalize Disc selection entry.
   ➔ The Finalize Disc window is opened.

   The Disc Tools options (Erase Disc, Disc Info and Finalize Disc) can also be started from the advanced area of the main window at any time.

2. Insert the disc you want to finalize and select the drive where the disc is located in the Select a recorder menu.

3. Click the Refresh button to display information about the disc you have inserted.

4. In the Menus to create on the disc drop-down menu, choose whether you want to create a new menu on your disc, keep an existing menu or not create a menu at all.

5. Click the Start button.
   ➔ You have now finalized a DVD.

See also

- Buttons → 13
11 Technical Information

11.1 System Requirements

Nero Vision is part of the Nero product you have installed. Its system requirements are the same. Detailed system requirements of this and all other Nero products can be found in the Support section on our Web site www.nero.com.

11.2 Disc Formats Supported

Nero Vision supports various disc formats.

For details on which disc format is available on which discs, refer to the compatibility overview disc format - disc. For details on which disc format for editable DVD is available on which discs, refer to the compatibility overview DVD Disc - Editable Disc Format.

Some of the functions mentioned here are restricted or not available in the Essentials version. You can always upgrade your Essentials version at www.nero.com to get the full version with all the functions.

To burn a DVD-Video, DVD+VR/-VFR (video mode) or ACVHD disc, a supported DVD burner must be connected to the PC. To burn VCD/SVCD/miniDVD discs, you need to have a supported CD and/or DVD recorder connected to your system.

You will find a list of supported recorders on our web page under www.nero.com.

You can find more information on Blu-ray support at www.nero.com/link.php?topic_id=416.

Even if you do not have a drive that is capable of burning DVDs, Blu-ray Discs or CDs, you can still use the Image Recorder to burn a disc image and save it for future use on your hard drive. Once you have connected the appropriate recorder to the system, you can burn disc images on real discs at any time using Nero Vision.

See also

- Overview of Compatibility Between Disc Formats and Discs → 127
- Compatibility Overview - DVD Disc - Editable Disc Format → 128
### 11.2.1 Overview of Compatibility Between Disc Formats and Discs

The following table provides details of which disc formats are available for which discs:

<table>
<thead>
<tr>
<th>Disc format</th>
<th>Discs supported</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>DVD-Video</strong></td>
<td>DVD-R</td>
</tr>
<tr>
<td></td>
<td>DVD-R DL</td>
</tr>
<tr>
<td></td>
<td>DVD-RW</td>
</tr>
<tr>
<td></td>
<td>DVD-RAM</td>
</tr>
<tr>
<td></td>
<td>DVD+R</td>
</tr>
<tr>
<td></td>
<td>DVD+R DL</td>
</tr>
<tr>
<td></td>
<td>DVD+RW</td>
</tr>
<tr>
<td><strong>DVD-VFR (video mode)</strong></td>
<td>DVD-R</td>
</tr>
<tr>
<td></td>
<td>DVD-RW</td>
</tr>
<tr>
<td></td>
<td>DVD-RAM</td>
</tr>
<tr>
<td><strong>DVD+VR</strong></td>
<td>DVD+R</td>
</tr>
<tr>
<td></td>
<td>DVD+R DL</td>
</tr>
<tr>
<td></td>
<td>DVD+RW</td>
</tr>
<tr>
<td><strong>Video CD (VCD)</strong></td>
<td>CD-R</td>
</tr>
<tr>
<td></td>
<td>CD-RW</td>
</tr>
<tr>
<td><strong>Super Video CD (SVCD)</strong></td>
<td>CD-R</td>
</tr>
<tr>
<td></td>
<td>CD-RW</td>
</tr>
<tr>
<td><strong>miniDVD</strong></td>
<td>CD-R</td>
</tr>
<tr>
<td></td>
<td>CD-RW</td>
</tr>
<tr>
<td><strong>AVCHD</strong></td>
<td>DVD-R</td>
</tr>
<tr>
<td></td>
<td>DVD-R DL</td>
</tr>
<tr>
<td></td>
<td>DVD-RW</td>
</tr>
<tr>
<td></td>
<td>DVD-RAM</td>
</tr>
<tr>
<td></td>
<td>DVD+R</td>
</tr>
<tr>
<td></td>
<td>DVD+R DL</td>
</tr>
<tr>
<td></td>
<td>DVD+RW</td>
</tr>
<tr>
<td></td>
<td>Memory card</td>
</tr>
<tr>
<td></td>
<td>Hard drive</td>
</tr>
</tbody>
</table>
11.2.2 Compatibility Overview - DVD Disc - Editable Disc Format

The following table gives details of which disc formats are available for editable DVDs for which discs:

<table>
<thead>
<tr>
<th>Disc</th>
<th>Supported disc formats for &quot;editable DVDs&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>DVD-R</td>
<td>DVD-VFR (video mode)</td>
</tr>
<tr>
<td>DVD-RW</td>
<td>DVD-VFR (video mode)</td>
</tr>
<tr>
<td>DVD-RAM</td>
<td>DVD-VFR (video mode)</td>
</tr>
<tr>
<td>DVD+R</td>
<td>DVD+VR</td>
</tr>
<tr>
<td>DVD+R DL</td>
<td>DVD+VR</td>
</tr>
<tr>
<td>DVD+RW</td>
<td>DVD+VR</td>
</tr>
</tbody>
</table>

11.3 Key Combinations

The following shortcuts for entering keyboard commands are available in Nero Vision.

The following General key combinations are available:

<table>
<thead>
<tr>
<th>F1</th>
<th>Help.</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Ctrl+S]</td>
<td>Save project.</td>
</tr>
<tr>
<td>[Ctrl+C]</td>
<td>Copy.</td>
</tr>
<tr>
<td>[Ctrl+X]</td>
<td>Cut.</td>
</tr>
<tr>
<td>[Ctrl+V]</td>
<td>Paste.</td>
</tr>
<tr>
<td>[Ctrl+A]</td>
<td>Select all.</td>
</tr>
<tr>
<td>[Ctrl+Z]</td>
<td>Undo</td>
</tr>
<tr>
<td>[Ctrl+Y]</td>
<td>Redo</td>
</tr>
<tr>
<td>[Alt+K]</td>
<td>Display key definitions.</td>
</tr>
<tr>
<td>[Alt+P]</td>
<td>Edit program preferences.</td>
</tr>
<tr>
<td>[Alt+T]</td>
<td>Display page tip.</td>
</tr>
</tbody>
</table>
The following **General** keyboard combinations are additionally available in the **Video Editing** screen:

<table>
<thead>
<tr>
<th>Keyboard Combination</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+C</td>
<td>Copy</td>
</tr>
<tr>
<td>Ctrl+X</td>
<td>Cut</td>
</tr>
<tr>
<td>Ctrl+V</td>
<td>Paste</td>
</tr>
<tr>
<td>Ctrl+S</td>
<td>Save the active project</td>
</tr>
<tr>
<td>Ctrl+A</td>
<td>Select all</td>
</tr>
<tr>
<td>Shift+Ctrl+A</td>
<td>Select nothing</td>
</tr>
<tr>
<td>Ctrl+Z</td>
<td>Undo</td>
</tr>
<tr>
<td>Ctrl+Y</td>
<td>Redo</td>
</tr>
<tr>
<td>Ctrl+D</td>
<td>Timeline settings</td>
</tr>
<tr>
<td>Ctrl++</td>
<td>Zoom in</td>
</tr>
<tr>
<td>Ctrl--</td>
<td>Zoom out</td>
</tr>
<tr>
<td>Ctrl+0</td>
<td>100% scaling</td>
</tr>
<tr>
<td>F1</td>
<td>Display Help</td>
</tr>
</tbody>
</table>

The following **View** keyboard combinations are additionally available in the **Video Editing** screen:

<table>
<thead>
<tr>
<th>Keyboard Combination</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1</td>
<td>Help</td>
</tr>
<tr>
<td>F2</td>
<td>Rename the selected item</td>
</tr>
<tr>
<td>F5</td>
<td>Open <strong>My Media</strong></td>
</tr>
<tr>
<td>F6</td>
<td>Open <strong>Properties</strong></td>
</tr>
<tr>
<td>F7</td>
<td>Open <strong>Effects</strong></td>
</tr>
<tr>
<td>F4</td>
<td>Switch between <strong>Storyboard</strong> / <strong>Timeline</strong> view</td>
</tr>
<tr>
<td>F8</td>
<td>Switch between <strong>Timeline</strong> view (Minimal / Mixed / Extended)</td>
</tr>
<tr>
<td>F11</td>
<td>Full screen mode on / off</td>
</tr>
<tr>
<td>Del</td>
<td>Delete the object</td>
</tr>
<tr>
<td>Ctrl+I</td>
<td>Import</td>
</tr>
</tbody>
</table>
### Technical Information

<table>
<thead>
<tr>
<th>Keyboard Combination</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Ctrl+M]</td>
<td>Open Movie Wizard.</td>
</tr>
<tr>
<td>Page up</td>
<td>Jump to previous cut.</td>
</tr>
<tr>
<td>Page down</td>
<td>Jump to next cut.</td>
</tr>
<tr>
<td>[Ctrl+T]</td>
<td>Show / hide safe area.</td>
</tr>
<tr>
<td>[Ctrl+R]</td>
<td>Show / hide rulers.</td>
</tr>
<tr>
<td>[Ctrl+P]</td>
<td>Snapshot.</td>
</tr>
<tr>
<td>Enter</td>
<td>Renders work area and start playback.</td>
</tr>
</tbody>
</table>

The following keyboard combinations are additionally available for tools in the preview area of the Video Editing screen:

<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
<td>Cutter.</td>
</tr>
<tr>
<td>S</td>
<td>Slip.</td>
</tr>
<tr>
<td>R</td>
<td>Roll.</td>
</tr>
<tr>
<td>V</td>
<td>Standard tool.</td>
</tr>
<tr>
<td>H</td>
<td>Rectangular marquee.</td>
</tr>
<tr>
<td>Space</td>
<td>Start / Pause playback.</td>
</tr>
<tr>
<td>I</td>
<td>Set Mark In.</td>
</tr>
<tr>
<td>O</td>
<td>Set Mark Out.</td>
</tr>
<tr>
<td>T</td>
<td>Opens text window.</td>
</tr>
<tr>
<td>M</td>
<td>Magnet on / off.</td>
</tr>
<tr>
<td>N</td>
<td>Narration.</td>
</tr>
</tbody>
</table>

The following keyboard combinations are available for timeline navigation in the content area of the Video Editing screen:

<table>
<thead>
<tr>
<th>Key Combination</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left arrow key</td>
<td>Move one frame backward on the timeline.</td>
</tr>
<tr>
<td>Right arrow key</td>
<td>Move one frame forward on the timeline.</td>
</tr>
<tr>
<td>[Ctrl+Left arrow key]</td>
<td>Move 5 frames backward on the timeline.</td>
</tr>
<tr>
<td>[Ctrl+Right arrow key]</td>
<td>Move 5 frames forward on the timeline.</td>
</tr>
</tbody>
</table>
### Technical Information

<table>
<thead>
<tr>
<th>Arrow key up</th>
<th>Moves one track up.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arrow key down</td>
<td>Move one track down.</td>
</tr>
<tr>
<td>[Shift+Left arrow key]</td>
<td>Select all clips to the left of the starting position.</td>
</tr>
<tr>
<td>[Shift+Right arrow key]</td>
<td>Select all clips to the right of the starting position.</td>
</tr>
<tr>
<td>[Shift+Down arrow key]</td>
<td>Select all clips downwards from the starting position.</td>
</tr>
<tr>
<td>[Shift+Arrow key up]</td>
<td>Select all clips upwards from the starting position.</td>
</tr>
<tr>
<td>[Ctrl+Left arrow key]</td>
<td>Move selected clip one frame to the left.</td>
</tr>
<tr>
<td>[Ctrl+Right arrow key]</td>
<td>Move selected clip one frame to the right.</td>
</tr>
</tbody>
</table>

The following keyboard combinations are available in the **Edit Menu** screen:

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt. Gray</td>
<td>Marks a selection of items that can be clicked in the preview and the compilation areas. Items can be deleted from the selection by repeated clicking.</td>
</tr>
<tr>
<td>Ctrl</td>
<td>Marks a selection of items that can be clicked in the preview and the compilation areas. Items can be deleted from the selection by repeated clicking.</td>
</tr>
<tr>
<td>Shift</td>
<td>Displaces a marked item (when moving the mouse) in distances of horizontal or vertical grid positions.</td>
</tr>
<tr>
<td>Mouse wheel</td>
<td>Zooms in or zooms out to the original position in the view of the menu in the preview and compilation areas.</td>
</tr>
<tr>
<td>Space</td>
<td>Changes the mouse pointer into a hand cursor with whose aid desired areas can be moved into an enlarged menu page in the visible area of the compilation area. Only available when the visible compilation area is enlarged (<strong>Zoom in</strong>). No item may be selected at the same time for text processing.</td>
</tr>
<tr>
<td>F2</td>
<td>Changes directly into the text processing of a marked item.</td>
</tr>
</tbody>
</table>
12 Glossary

Bit rate
Bit rate refers to the amount of data (binary digits) that is transmitted within a time unit (generally 1 second), i.e. in bits/s. The higher the bit rate, the better the image quality.

Disc format
Disc format defines the the format in which the data is organized on a disc. For example, the disc format DVD-VR is only supported by and can only be used with DVD-RW and DVD-RAM discs. For example, Video CD (VCD), Super Video CD (SVCD), miniDVD and (if supported) HD-BURN can be burned to CD-R and CD-RW disc formats. The technical options available, such as subtitle or multiple sound tracks, are a factor of the disc format.
Index

(_Default) Video Options window ........ 120
Abbreviation ........................................ 128
Ad Spotter ........................................ 38, 57, 66
Adding a text effect ............................. 75, 77
Adding chapter ..................................... 20
Adding files ............................................ 15, 18
Adjust track .......................................... 45
Advanced editing ................................. 91, 92, 101, 108
Advanced menu editing .................................. 7, 88, 94, 97, 100, 101
Analog video ........................................ 24
Anchor point .......................................... 42
Animated preview ................................. 41
Application settings ............................ 118, 119
Aspect ratio .......................................... 121
Audio device properties ........................ 27, 31
Audio Device Properties .......................... 24
Audio files ............................................. 65
Audio inputs .......................................... 27
Audio level ............................................ 41
Audio recording .................................... 38
Audio settings ....................................... 31
Audio source ....................................... 27
Audio track .......................................... 48, 49
Autorun ................................................. 96
AVCHD .................................................. 15, 23, 121, 123, 127
AVCHD camera ....................................... 23
Background music ............................... 49, 65, 104
Background rendering .......................... 119
Background videos ................................... 95
Basic effects ........................................ 41
Bezier interpolation ............................... 43
Bit rate ................................................. 122, 123
Book type ............................................ 113, 114
Burn image ........................................... 111, 115, 126
Burn label screen ................................... 114, 115, 116
Burn options ........................................... 111, 114, 115, 116
Burn options screen ............................. 22, 111, 114, 115, 116
Burn-at-once ...................................... 113, 114, 115
Burning ................................................. 11
Burning a disc ....................................... 111, 114
Burning speed ....................................... 113, 114
Button numbering .................................. 102
Button numbers .................................... 97
Buttons ............................................... 97, 101
Buttons drawer .................................... 101
Capacity bar ........................................ 15, 88
Capture ............................................... 40
Capture card ......................................... 27, 30, 32, 33
Capture cideo ........................................ 25
Capture device ....................................... 23, 24, 30
Capture settings .................................... 113
Capture to disc on-the-fly ....................... 34
Capture video ........................................ 18, 26, 34
Capture video screen ............................ 24, 28
Capture Video screen ............................. 34
Capture video to hard drive .................... 23
Capturing .............................................. 23
Capturing template ............................... 24
Capturing video .................................... 15, 30
Catch marker ........................................ 48
Channel tuning ...................................... 27, 28
Channels .............................................. 28
Chapter ............................................ 14, 20, 21, 46, 88, 100, 107
Chapter auto-detect ............................. 20
Chapter marks ...................................... 14, 20, 21
Chapter menus .................................. 89, 91, 92, 100, 107
Choose template ................................... 72
Clip arts .............................................. 40, 93, 99, 101
Clip handling ....................................... 49
Clip marker .......................................... 48
Colored marker .................................... 48
Combination track .................................. 48, 49
Combining titles .................................... 19
Index

Nero Vision

Community ..................................... 34, 86
Compatibility overview ...... 126, 127, 128
Compilation ..................................... 14
Compilation area ......................... 88, 97, 99, 108
Configuration ..................................... 13
Configure TV Card .............................. 28
Content area .................................. 14, 37, 41, 44
Content drawer ................................... 100
Content screen 14, 20, 21, 22, 34, 65, 82, 83, 84, 85, 86, 100
Conventions, manual ....................... 6
Converting file .................................. 116
Create chapter .................................. 14
Creating a Blu-ray Disc ...................... 18
Creating a CD .................................. 18
Creating a DVD .................................. 18
Creating a project .............................. 14
Creating chapter ......................... 15, 20, 21, 46
Creating covers .................................. 14
Creating key frame ............................ 43
Creating labels .................................. 14
Creating subclips ................................ 40
Customize tab .................................. 88, 91, 108
Cut .................................................. 69
Cutter ................................................. 47
Cutting a movie .................................. 69
Cutting clip ....................................... 47
Cutting feature .................................. 69
Cutting video titles ............................ 69
Default durations ......................... 119
Default tracks .................................. 48
Default video options ..................... 120, 121
Delete ................................................. 50
Delete rewritable disc ..................... 124
Deleting chapter .............................. 46
Deleting clip ..................................... 50
Deleting effect .................................. 43
Deleting rewritable disc .................. 124
Deleting titles .................................. 19
Deleting track .................................. 48
Deleting transition ........................... 43
Deleting TV channels ..................... 27
Device for recording ..................... 27, 30, 32, 33
Digital video ..................................... 24
Disc format ....................................... 121
Disc image ....................................... 22, 111, 115, 126
Disc info .......................................... 13, 124, 125
Disc settings ..................................... 93, 101
Disc tools ........................................... 124, 125
Disc/Project drawer ....................... 101
dolby Digital ...................................... 123
Drawing items .................................. 93, 99, 101
dV capture ........................................ 30, 32
dV video vamera ................................... 23
DVD+VR ........................................ 9, 17, 34
DVD-VFR ......................................... 9, 17, 34
dV-HDV camera ................................... 23
Edit background audio .................... 104
Edit menu screen .............................. 101, 107
Edit Menu screen 88, 91, 93, 97, 99, 100, 101
Editable DVD ...................................... 17, 34, 128
Editing clip .................................... 39, 49
Editing movie ................................. 15, 19
Editing slide show ........................... 19
Editing the menu ..... 7, 88, 91, 93, 97, 99, 100, 101, 103, 104, 105, 106, 107
Editing video ..................................... 44
Effect palette .................................. 37, 41, 51
Effects ................................ 7, 41, 48, 51, 75, 77
E-mail export ..................................... 84
Enable workspace ............................ 44
Encoding mode .................................. 123
Enlarge ............................................. 90
Erasing a disc ............................... 13, 124, 125, 125
Export audio ..................................... 80, 85
Export formats .................................. 80
Export options .................................. 83
Export templates ............................. 80, 83
Export to Web ................................. 81, 86
Export video ................................. 80, 82, 83, 84, 85, 86
Export video and send as e-mail ........ 84
Export video to camera ........................ 84
Exporting .................................... 82, 83, 84, 85, 86
Exporting the movie ................... 82, 84, 86
Extended area .............................. 12, 13, 14, 26
Extended timeline view .................. 46

File type .......................................... 22
Finalize video .................................. 125
Finalizing ...................................... 125
Finalizing a disc ............................. 13, 124, 125
Fit to screen .................................. 42
Fitting clips into gaps ...................... 50
Focus ............................................. 97, 99
Format of saved media files .............. 118
Formats .......................................... 80
Formats supported .......................... 126, 127, 128
Frame rate ..................................... 27
Full screen mode ............................. 39

General tab ..................................... 120
Graphic format ................................ 118
Graphic objects ............................. 93, 99, 101
Graphic objects drawer .................... 101
Graphics ......................................... 118
Guidelines ..................................... 90, 93, 102

Hand cursor .................................. 90
Help ............................................... 9
Hiding track ................................... 45

Image file ................................. 22, 111, 115, 126
Image Recorder ......................... 111, 115, 126
Import ........................................ 40
Import from the Web .................... 34
Importing disc ............................. 15
Importing files ............................. 40
Importing from the Web .............. 15
Importing video ......................... 18
Insert marker .............................. 49
Inserting transitions .................... 73

Inserting TV channels ..................... 27
Interaction .................................... 95
Interlace process ......................... 121
Interlaced ..................................... 121
Internet ......................................... 34
Internet Community ..................... 34, 86
Internet export ............................. 81, 86
Interpolation method ..................... 43
Intro ............................................ 38, 57
Intro menu .................................... 88, 94, 107

Key combinations ......................... 128
Key frame ..................................... 43

Label ........................................... 48
Lattice ......................................... 90, 93, 102
Levels .......................................... 88
Linear interpolation ....................... 43
Linking ........................................ 96, 100
Linking clips ................................ 50
List of chapters ............................. 14
List view ....................................... 40
Locking track ............................... 45
Log file ...................................... 114, 116, 117

Magnet ......................................... 48
Main menu .................................... 88, 107
Making movie .............................. 15, 19, 44, 64
Making slide show ........................ 15, 19
Managing TV channel groups ......... 27
Manual, conventions ...................... 6
Master effects .............................. 48
Master track ................................ 48
Media area ..................................... 49
Memory stick .................................. 116
Menu .......................................... 88, 91
Menu animation .......................... 110
Menu editing ............................... 88
Menu levels .................................. 88
Menu preview .............................. 88
Menu templates .... 7, 88, 90, 91, 101, 108
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimal timeline view</td>
<td>45</td>
</tr>
<tr>
<td>Mixed timeline view</td>
<td>45</td>
</tr>
<tr>
<td>Motion-adaptive</td>
<td>122</td>
</tr>
<tr>
<td>Motion-adaptive deinterlacing</td>
<td>122</td>
</tr>
<tr>
<td>Movie name</td>
<td>62</td>
</tr>
<tr>
<td>Movie options</td>
<td>38, 61</td>
</tr>
<tr>
<td>Movie screen</td>
<td>65</td>
</tr>
<tr>
<td>Movie theme templates</td>
<td>7</td>
</tr>
<tr>
<td>Movie wizard</td>
<td>38, 55, 72</td>
</tr>
<tr>
<td>Moving clip</td>
<td>50</td>
</tr>
<tr>
<td>Multitrack overlay</td>
<td>52, 52</td>
</tr>
<tr>
<td>Music</td>
<td>51</td>
</tr>
<tr>
<td>Music Grabber</td>
<td>38, 59, 67</td>
</tr>
<tr>
<td>Music track</td>
<td>49, 51</td>
</tr>
<tr>
<td>My Media</td>
<td>65</td>
</tr>
<tr>
<td>My Menu Templates</td>
<td>90</td>
</tr>
<tr>
<td>My Nero</td>
<td>35, 86</td>
</tr>
<tr>
<td>My Nero Login</td>
<td>35, 86</td>
</tr>
<tr>
<td>Narration</td>
<td>38, 49, 51</td>
</tr>
<tr>
<td>Narration track</td>
<td>49</td>
</tr>
<tr>
<td>Native capturing</td>
<td>25, 26, 30, 31</td>
</tr>
<tr>
<td>Navigation buttons</td>
<td>92, 97, 101</td>
</tr>
<tr>
<td>Nero CoverDesigner</td>
<td>12, 14</td>
</tr>
<tr>
<td>Nero Image Files</td>
<td>22</td>
</tr>
<tr>
<td>Nero Picture in Picture Effects.</td>
<td>38, 52, 71</td>
</tr>
<tr>
<td>Nero SmartEncoding</td>
<td>120</td>
</tr>
<tr>
<td>Nero Vision Projects</td>
<td>22</td>
</tr>
<tr>
<td>Never use black thumbnails</td>
<td>102</td>
</tr>
<tr>
<td>New track</td>
<td>46</td>
</tr>
<tr>
<td>NTSC</td>
<td>120</td>
</tr>
<tr>
<td>Numbering</td>
<td>102</td>
</tr>
<tr>
<td>Opacity</td>
<td>42, 49</td>
</tr>
<tr>
<td>Opening a disc image</td>
<td>22</td>
</tr>
<tr>
<td>Opening a project</td>
<td>22</td>
</tr>
<tr>
<td>Opening a project or a disc picture</td>
<td>22</td>
</tr>
<tr>
<td>Opening image file</td>
<td>22</td>
</tr>
<tr>
<td>Options</td>
<td>38</td>
</tr>
<tr>
<td>Movie</td>
<td>61</td>
</tr>
<tr>
<td>Timeline</td>
<td>61</td>
</tr>
<tr>
<td>Video editing</td>
<td>61</td>
</tr>
<tr>
<td>Opacity</td>
<td>42, 49</td>
</tr>
<tr>
<td>Output file</td>
<td>80</td>
</tr>
<tr>
<td>Output format</td>
<td>27</td>
</tr>
<tr>
<td>Outro</td>
<td>38, 57</td>
</tr>
<tr>
<td>PAL</td>
<td>120</td>
</tr>
<tr>
<td>Pan &amp; Zoom</td>
<td>57</td>
</tr>
<tr>
<td>Picture-in-picture effects</td>
<td>38, 52</td>
</tr>
<tr>
<td>Playback</td>
<td>39</td>
</tr>
<tr>
<td>Position marking</td>
<td>97</td>
</tr>
<tr>
<td>Pre-scan</td>
<td>32</td>
</tr>
<tr>
<td>Pre-scan capture</td>
<td>25, 26, 31</td>
</tr>
<tr>
<td>Preview area1</td>
<td>14, 39, 70, 88, 103, 106, 108</td>
</tr>
<tr>
<td>Preview menu animation</td>
<td>110</td>
</tr>
<tr>
<td>Preview screen</td>
<td>109, 110</td>
</tr>
<tr>
<td>Project file</td>
<td>22, 111</td>
</tr>
<tr>
<td>Project settings</td>
<td>93, 102, 102</td>
</tr>
<tr>
<td>Properties</td>
<td>37, 41, 44</td>
</tr>
<tr>
<td>Properties drawer</td>
<td>97, 99</td>
</tr>
<tr>
<td>Quality setting</td>
<td>122</td>
</tr>
<tr>
<td>Quick info</td>
<td>118</td>
</tr>
<tr>
<td>Recognize advertising</td>
<td>57, 66</td>
</tr>
<tr>
<td>Record audio</td>
<td>38</td>
</tr>
<tr>
<td>Recording format</td>
<td>62</td>
</tr>
<tr>
<td>Recording settings</td>
<td>114, 115</td>
</tr>
<tr>
<td>Reduce</td>
<td>90</td>
</tr>
<tr>
<td>Remote control</td>
<td>109, 110</td>
</tr>
<tr>
<td>Renaming chapter</td>
<td>46</td>
</tr>
<tr>
<td>Renaming chapters</td>
<td>21</td>
</tr>
<tr>
<td>Resolution</td>
<td>62, 122</td>
</tr>
<tr>
<td>Rewritable disc</td>
<td>34</td>
</tr>
<tr>
<td>Roll tool</td>
<td>47</td>
</tr>
<tr>
<td>Rotating clip</td>
<td>42</td>
</tr>
<tr>
<td>Rotation</td>
<td>42</td>
</tr>
<tr>
<td>Safe area</td>
<td>39</td>
</tr>
<tr>
<td>Sample format</td>
<td>122</td>
</tr>
<tr>
<td>Satellite configuration</td>
<td>28</td>
</tr>
</tbody>
</table>
Save as template ............................... 107
Save template ...................................... 89
Saving .......................................... 22, 108
Saving project ...................................... 22
Saving template ................................. 107
Scaling ................................................. 42
Scene detection ....................... 38, 40, 57
SD card .............................................. 116
Search for advertising spots. ......... 57, 66
Search for music clips .................... 59, 67
Selecting a task..................................... 9
Selecting clip .................................. 46, 49
Selecting poster frame ................. 105
Selecting start position ............... 103
Selecting track .................................. 46
Selecting track backward ............. 46
Selecting track forward ............... 46
Shadow settings ................................. 106
Shortcuts ........................................ 96, 97
Showing a preview ............................. 110
Slip tool ........................................... 47
Smart3D menus ....................... 93, 94, 97, 100
Smart3D templates .. 92, 93, 94, 100, 108
SmartEncoding................................. 121
Snap to guide ....................................... 39
Snap to object ..................................... 39
Snapshot ............................................. 39
Sound tracks ................................... 49, 65, 80
Speed test ......................................... 114
Spreading .......................................... 96
Standard forms ......................... 93, 99, 101
Standard objects ......................... 101
Standard2D templates ....................... 90
Start screen .................................... 9, 12, 22
Stereo .............................................. 123
Sticky mode ......................................... 13
Storyboard .................................. 37, 51, 65
Subclip ............................................... 40
Sub-menu ........................................... 88
Super resolution ................................. 122
Supported capture devices ........... 23
System requirements ..................... 126
Target file .......................................... 122
Target format .................................. 25
Template ........................................ 38, 56
Template groups .............................. 88
Template settings ......................... 93
Templates ........................................ 88, 90, 107
Nero Picture in Picture Effects ......... 52
Temporary files ............................ 119
Text effects ....................................... 7, 75, 77
Text-only buttons ......................... 92, 101
Theme music ...................................... 57
Themes ............................................. 55, 72
Thumbnail buttons ................. 92, 97, 101, 103
Thumbnail view ............................... 40
Time cursor ....................................... 44
Time display ....................................... 44
Time position ..................................... 44
Time stretch ...................................... 38
Timeline ........................................ 37, 44, 48, 49
Timeline options ............................ 38, 61
Timeline view .................................... 45
Title .................................................. 62
Title menus ............... 88, 89, 91, 92, 100, 107
Tool tips ........................................... 118
Track title ......................................... 48
Transformation ............................. 98, 100
Transitions ...................................... 7, 41, 43, 51, 73, 93, 96
Transparency ...................................... 42
Trimming ........................................... 62
Trimming clip ..................................... 50
TV card ........................................... 23, 27
TV wizard ........................................... 27, 28
User interface ....................... 12, 30
User-defined capture .................. 25
Using key frame .............................. 43
VCR .................................................. 30
VCR mode ........................................... 83
Vector graphics .................... 93, 99, 101
Index

Video camera....................................... 23
Video capture ................................... 23, 30, 32
Video capture screen ......................... 30
Video clip......................................... 40
Video cut........................................... 69
Video device properties ................. 27, 31
Video Device Properties ................ 24, 28
Video editing .... 37, 39, 40, 41, 44, 49, 51
Video format................................. 62, 121
Video mode ....................................... 120
Video options ....................... 13, 120, 121
Video settings................................. 31
Video title ....................................... 62
Video track ..................................... 48, 49
Virtual remote control........ 109, 110
Volume ........................................... 41
Volume level.................................... 57

Wave form...................................... 104
Workspace ...................................... 44
Write speed .................................... 114
Writing .................................. 114, 115, 116
Writing in the hard drive folders ....... 116

Zoom ............................................. 90
14 Contact

Nero Vision is a Nero AG product.

**Nero AG**

Im Stoeckmaedle 18
76307 Karlsbad
Germany

**Internet:** [www.nero.com](http://www.nero.com)

**Help:** [http://support.nero.com](http://support.nero.com)

**Fax:** +49 724 892 8499

**Nero Inc.**

330 N Brand Blvd Suite 800
Glendale, CA 91203-2335
USA

**Internet:** [www.nero.com](http://www.nero.com)

**Help:** [http://support.nero.com](http://support.nero.com)

**Fax:** (818) 956 7094

**E-mail:** US-CustomerSupport@nero.com

**Nero KK**

Rover Center-kita 8F-B, 1-2-2
Nakagawa-chuo Tsuzuki-ku
Yokohama, Kanagawa
Japan 224-0003

**Internet:** [www.nero.com](http://www.nero.com)

**Help:** [http://support.nero.com](http://support.nero.com)

Copyright © 2010 Nero AG and its licensors. All rights reserved.